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Please be sure to read this manual before using this product. 
Keep this manual in a safe place for future use. 
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When you dispose of the machine  

Required Tools 

Phillips screwdriver: M3 to M5 

 

 

Disassembling 

(1) Remove the Cover PANEL SIDE. 

 

 

(2) Remove the Lithium Battery (1) by pulling out the holder in the direction of the arrow. 

 
 

(3) Pickup the Lithium Battery (1) to the direction of the arrow. 

 
 

 

 

(1) (1) 

(1)

Note based on California law (USA) on the use and handling of Perchlorate 

This product contains a CR Coin Lithium Battery which contains Perchlorate Material – special handling may 

apply. 

See http://www.dtsc.ca/gov/hazardouswaste.perchlorate. 

http://www.dtsc.ca/gov/hazardouswaste.perchlorate
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SAFETY INSTRUCTIONS  

Thank you very much for buying a BROTHER printer. 

Before using your new printer, please read the "SAFETY INSTRUCTIONS" and handling instructions carefully. 

 

1. Safety indications and their meanings 

This instruction manual and the indications and symbols that are used on the printer itself are provided in order to ensure 

safe operation of this printer and to prevent accidents and injury to yourself or other people. 

The meanings of these indications and symbols are given below. 

 

Indications 

DANGER 
The instructions which follow this term indicate situations where failure to follow the 

instructions will result in death or serious injury. 

WARNING 
The instructions which follow this term indicate situations where failure to follow the 

instructions could result in death or serious injury. 

CAUTION 
The instructions which follow this term indicate situations where failure to follow the 

instructions may result in minor or moderate injury. 

 

IMPORTANT 
The instructions which follow this term indicate situations where failure to follow the 

instructions may result in damage to property. 

NOTE The instructions which follow this term indicate precautions and restrictions for use. 

 

Symbols 

· · · · ·  
This symbol ( ) indicates something that you should be careful of. 

The picture inside the triangle indicates the nature of the caution that must be taken. (For 

example, the symbol at left means "beware of injury".) 

· · · · ·  This symbol ( ) indicates something that you must not do. 

· · · · ·  
This symbol ( ) indicates something that you must do. 
The picture inside the circle indicates the nature of the thing that must be done. (For example, 

the symbol at left means "you must make a ground connection".) 

 

 

2. Notes on safety 

DANGER 

 
Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5 

minutes later. 
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WARNING 

Basic precautions 

 

 

 

To prevent accidents and problems, do not modify the machine yourself. Brother will not be held responsible 

for any accidents or problems resulting from modifications made to the machine. 

 
Do not handle the power cord with wet hands. Otherwise, it may cause electric shocks. 

Installation 

 

 

 

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric 

shocks or problems with correct operation. 

 
Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a 

serious electric shock, and problems with correct operation may also occur. 

 

 

 

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords. 

Otherwise it may cause fire or electric shocks. 

Printing 

 

 

 

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and 

contact the place of purchase or a qualified technician. If you continue to use the printer while there is a 

foreign object inside, it may result in fire or electric shocks or problems with correct operation. 

 

 

 

 

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or 

problems with correct operation. 

If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact 

the place of purchase or a qualified technician. 

 

 

 

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or 

electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power 

cord, and contact the place of purchase or a qualified technician. 

 
Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in 

injuries. 

Turn off the power when you approach the fan. 
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CAUTION 

Environmental requirements 

 
Use the printer in a place which is adequately ventilated. A slight odor is generated when the printed articles 

are being fixed by heat. 

Installation 

 
Setting up and moving of the printer should only be carried out by a qualified technician. 

 

 

The printer machine weighs 128 kg (282 lb). Transporting and setting up of the printer should be held in the 

proper way. Otherwise it may fall down and cause injury. 

 

 

When the printer falls down, disconnect the power cord and contact the place of purchase or a qualified 

technician. If you continue to use it, it may result in fire or electric shocks or poor printing quality. 

 
Do not place the printer on a shaky table or high shelf or other unstable location. Otherwise it may tip over or 

fall down and cause injury. Furthermore, the table that supports the machine should be at least 35.4 in. (90 

cm) in width and 23.6 in. (60 cm) in depth, and should be able to bear a weight of 150 kg (330 lb) or more. 

 
Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be 

degraded or the printer may fall down, which causes injury or results in failure of the printer. 

 
Do not connect the power cord until installation is complete. The printer may operate if the power is turned on 

by mistake, which could result in injury. 

 
Do not climb onto the printer or place heavy objects on top of it. Otherwise it may become unbalanced and tip 

over or fall down and cause injury. 

 
Be careful not to touch the claws of the mounting portion on the upper side of the rear cover. Otherwise you 

may be injured. 

Printing 

 
This printer should only be used by operators who are appropriately trained in its safe operation. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand 

may get caught between the platen and an object, which may result in injury. 

 
Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and 

the covers, it may be injured. 

 
Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may 

touch against moving parts and this may result in injury. 

 
When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator, 

sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles) 

designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

 
When a problem occurs with the operation of the printer, contact the place of purchase or a qualified 

technician. 
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CAUTION 

Maintenance 

 
Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your 

fingers. 

 
When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may 

be injured. 

 
Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation. 

In case of contact with eyes, do not rub but immediately rinse the eyes with water. 

 
Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They 

may cause diarrhea or vomiting. 

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution, 

pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately 

rinse the eyes with water. 

Keep the liquids out of the reach of children. 

 
Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your 

eyes or onto your skin. 

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting. 

Keep the liquids out of the reach of children. 

 
When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother 

will not be held responsible for any accidents or problems resulting from the use of non-genuine parts. 

 
When replacing parts or installing optional accessories, be sure to follow the procedures described in the 

Instruction Manual. Incorrect procedures could cause injuries or problems. 

 

IMPORTANT 

Printing 

 
Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be 

hit and damaged. 
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NOTE 

 
Use the printer in an area which is free from sources of strong electrical noise such as electrical line noise or 

static electric noise. Sources of strong electrical noise may cause problems with correct operation. 

 
Any fluctuations in the power supply voltage should be within ±10% of the rated voltage for the printer. 

Voltage fluctuations which are greater than this may cause problems with correct operation. 

 
The power supply capacity should be greater than the requirements for the printer's power consumption. 

Insufficient power supply capacity may cause problems with correct operation. 

 
In the event of an electrical storm, turn off the power and disconnect the power cord from the wall outlet. 

Lightning may cause problems with correct operation. 
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3. Warning labels 
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Grease

Pretreatment 

5 kg (11 lb) 

Pretreatment

20 kg (44 lb)

Ink pouch 

Maintenance solution pouch

Cleaning solution

Waste ink tank 
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This printer has the following warning labels displayed on it. 

Follow the precautions given on each warning label for your work. 

When the label is peeled off or illegible, contact the place of purchase. 

1 6 
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Watch your fingers, or you 

may be injured. 

High temperature 

warning display 

China only 
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＜产品中有害物质的名称及含量＞ 

型号 有害物质 

BGTX423H5000032 
BGTX424H5000032 

铅 镉 六价铬 汞 多溴联苯 多溴二苯醚 

部件名称 Pb Cd Cr(VI) Hg PBB PBDE 

框架机制 ○ ○ ○ ○ ○ ○ 

盖板机制 ○ ○ ○ ○ ○ ○ 

台板机制 × ○ ○ ○ ○ ○ 

导轴机制 × ○ ○ ○ ○ ○ 

维护机制 × ○ ○ ○ ○ ○ 

供墨机制 × ○ ○ ○ ○ ○ 

打印头机制 × ○ ○ ○ ○ ○ 

电气部品 × ○ ○ ○ ○ ○ 

操作面板机制 × ○ ○ ○ ○ ○ 

配件 ○ ○ ○ ○ ○ ○ 

使用手册/其他零件 ○ ○ ○ ○ ○ ○ 

包装 × ○ ○ ○ ○ ○ 

框架机制 ○ ○ ○ ○ ○ ○ 

本表格依据SJ/T 11364 的规定编制。 

○：表示该有害物质在该部件所有均质材料中的含量均在GB/T 26572 规定的限量要求以下。 

×：表示该有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572 规定的限量要求。 

（由于技术的原因暂时无法实现替代或减量化） 
 

China only 

 

 

 

 

 



 

11 

Table of contents  

1.  Before Using Your Printer for the First Time 16 

1-1.  Be sure to read the following notes before using the printer ................................................................................................... 16 

1-2.  Components included with printer ............................................................................................................................................ 21 

1-3.  Other items you must make available for use ......................................................................................................................... 22 

2.  Name and function of each component 24 

2-1.  Front part ................................................................................................................................................................................... 24 

2-2.  Right side view .......................................................................................................................................................................... 25 

2-3.  Left side view/Rear side view ................................................................................................................................................... 26 

2-4.  Inner-side view of front cover ................................................................................................................................................... 27 

2-5.  Bottom view of platen ............................................................................................................................................................... 28 

2-6.  Operation panel ........................................................................................................................................................................ 29 

2-6-1.  Liquid crystal panel ....................................................................................................................................................... 31 

3.  Menu list 33 

 

4.  Installation and preparation 37 

4-1.  Installation of printer .................................................................................................................................................................. 38 

4-1-1.  Installation of waste ink tank ......................................................................................................................................... 40 

4-2.  Power supply of printer ............................................................................................................................................................. 41 

4-2-1.  Turning on the power .................................................................................................................................................... 41 

4-2-2.  Turning off the power .................................................................................................................................................... 42 

4-2-3.  When there is no prospect of electric power recovery for a while due to power outage ............................................ 43 

4-3.  Connection between Printer and PC (for Windows) ................................................................................................................ 44 

4-3-1.  Installing printer driver onto your PC ............................................................................................................................ 45 

4-3-2.  Connect with USB2.0 cable: Adding the printer to the PC .......................................................................................... 46 

4-3-3.  When connecting via LAN: Static IP address setting .................................................................................................. 48 

4-3-4.  When connecting via LAN: Adding a printer to PC ...................................................................................................... 52 

4-4.  Connection between Printer and PC (for Macintosh) .............................................................................................................. 60 

4-4-1.  Installing printer driver onto your PC ............................................................................................................................ 60 

4-4-2.  Connecting the printer to your PC via a USB 2.0 cable .............................................................................................. 61 

4-4-3.  Connecting the printer to your PC via a LAN cable ..................................................................................................... 63 

4-5.  Moving the printer ..................................................................................................................................................................... 66 



 

12 

Table of contents

5.  Creating print data 67 

5-1.  Types of applications ................................................................................................................................................................ 67 

5-2.  Sending print data using Brother GTX pro FileOutput (for Macintosh only) ........................................................................... 69 

5-3.  Using other applications ........................................................................................................................................................... 70 

5-3-1.  When using CorelDRAW .............................................................................................................................................. 70 

5-3-2.  When using Adobe Photoshop .................................................................................................................................... 78 

5-3-3.  When using Adobe Illustrator ....................................................................................................................................... 83 

5-4.  Set up the printer driver ............................................................................................................................................................ 89 

5-4-1.  Select the platen size .................................................................................................................................................... 91 

5-4-2.  Select the ink type ........................................................................................................................................................ 92 

5-4-3.  Select the mode ............................................................................................................................................................ 93 

5-4-4.  Set up the white ink ...................................................................................................................................................... 94 

5-4-5.  Specify whether or not to use the background black color .......................................................................................... 97 

5-4-6.  Specify whether or not to perform Multiple Pass Printing ............................................................................................ 98 

5-4-7.  Set up the color ink ....................................................................................................................................................... 99 

5-4-8.  Set up the white ink .................................................................................................................................................... 100 

5-4-9.  Set up the image quality ............................................................................................................................................. 103 

5-4-10.  Set up the color balance ........................................................................................................................................... 104 

5-4-11.  Specify the print direction .......................................................................................................................................... 105 

5-5.  Using Useful Tools .................................................................................................................................................................. 106 

5-5-1.  Use the color palette ................................................................................................................................................... 106 

5-5-2.  Replace RGB=255 with RGB=254 (for Photoshop only) .......................................................................................... 106 

5-5-3.  Check the color sample .............................................................................................................................................. 107 

5-5-4.  Print a grid pattern on the platen sheet ...................................................................................................................... 108 

5-5-5.  Adjust the ink volume ................................................................................................................................................. 109 

5-5-6.  Print out of highlight check pattern/mask check pattern ............................................................................................ 110 

5-5-7.  Check the ejection timing ............................................................................................................................................ 111 

5-5-8.  Check the platen feed setting ...................................................................................................................................... 111 

5-5-9.  Check the print position .............................................................................................................................................. 112 

6.  Basic printing procedures 113 

6-1.  Basic printing process flow ..................................................................................................................................................... 115 

6-2.  Tasks to be performed before starting print operation ........................................................................................................... 116 

6-2-1.  Confirmation and disposal of waste ink ..................................................................................................................... 116 

6-2-2.  Confirmation and refilling of cleaning solution ........................................................................................................... 117 

6-2-3.  Daily agitation of the white ink .................................................................................................................................... 118 

6-3.  Pretreating process for print medium ..................................................................................................................................... 121 

6-3-1.  Provisions for pretreatment ........................................................................................................................................ 121 

6-3-2.  Dilution of pretreatment .............................................................................................................................................. 124 

6-3-3.  Application of pretreatment ........................................................................................................................................ 126 

6-3-4.  Fixation of pretreatment .............................................................................................................................................. 132 



 

13 

Table of contents

6-4.  Platen adjustment ................................................................................................................................................................... 134 

6-4-1.  Replacing the currently used platen with another one .............................................................................................. 134 

6-4-2.  Platen height adjustment ............................................................................................................................................ 137 

6-4-3.  Using the 16X21 platen .............................................................................................................................................. 146 

6-5.  Placing print medium in position............................................................................................................................................. 148 

6-6.  Sending/Loading Print Data ................................................................................................................................................... 151 

6-6-1.  Sending print data from ARXP file preview ................................................................................................................ 151 

6-6-2.  Sending print data from applications .......................................................................................................................... 155 

6-6-3.  Loading print data (ARXP file) from USB flash memory ........................................................................................... 158 

6-7.  Executing a printing job .......................................................................................................................................................... 160 

6-7-1.  Executing a print job once for a single print medium ................................................................................................. 160 

6-7-2.  Executing a print job several times for multiple print media ...................................................................................... 161 

6-7-3.  Performing the printing from receiving history ........................................................................................................... 162 

6-8. Scheduling a print ...................................................................................................................................................................... 163 

6-8-1. When you can schedule printing ................................................................................................................................... 163 

6-8-2. When a scheduled print begins .................................................................................................................................... 163 

6-8-3. When printing does not begin ....................................................................................................................................... 164 

6-8-4. Cancelling scheduled printing ....................................................................................................................................... 164 

6-9.  Removing printed matter from platen..................................................................................................................................... 165 

6-10.  Fixation of ink ........................................................................................................................................................................ 166 

7.  Precautions to keep good printing quality/use printer over the long term 168 

7-1.  Tasks to be performed regularly ............................................................................................................................................. 169 

7-1-1.  Replacement of ink pouch with a new one ................................................................................................................ 169 

7-1-2.  Cleaning and replacement of maintenance parts ...................................................................................................... 173 

7-1-3.  Cleaning the nozzle guard, wiper, exhaust cap, and suction cap ............................................................................. 174 

7-1-4.  Replacing the wiper cleaner ....................................................................................................................................... 186 

7-1-5.  Replacing the flushing foam ....................................................................................................................................... 189 

7-1-6.  Cleaning the internal area of printer ........................................................................................................................... 192 

7-1-7.  Replacing the fan filter ................................................................................................................................................ 197 

7-2.  Tasks to be performed when needed..................................................................................................................................... 199 

7-2-1.  Print out of the nozzle check pattern (checking on the print heads) ......................................................................... 199 

7-2-2.  Head cleaning ............................................................................................................................................................. 201 

7-2-3.  White ink circulation .................................................................................................................................................... 203 

7-2-4.  Cleaning the CR (carriage) plate ................................................................................................................................ 204 

7-2-5.  Replacing the platen sheet ......................................................................................................................................... 207 

7-3.  White Ink Pause Mode ........................................................................................................................................................... 209 

7-3-1.  Disabling white ink ...................................................................................................................................................... 209 

7-3-2.  Reusing White Ink ...................................................................................................................................................... 212 



 

14 

Table of contents

7-4.  Adjustment/setup .................................................................................................................................................................... 216 

7-4-1.  CR (Carriage) speed adjustment ............................................................................................................................... 216 

7-4-2.  Initial settings after head replacement ....................................................................................................................... 217 

7-4-3.  Firing adjustment ........................................................................................................................................................ 218 

7-4-4.  Platen-rolling adjustment ............................................................................................................................................ 219 

7-4-5.  White/color alignment ................................................................................................................................................. 220 

7-4-6.  Setting of the time displayed on the nozzle check pattern ........................................................................................ 221 

7-4-7.  Set the scheduled time for white ink circulation ......................................................................................................... 223 

7-5.  When Not Using for a Long Period of Time ........................................................................................................................... 225 

7-5-1.  When Not Using for a Long Period of Time: within 2 weeks ..................................................................................... 225 

7-5-2.  When Not Using for a Long Period of Time: more than 2 weeks .............................................................................. 225 

7-5-3.  When Not Using for a Long Period of Time: within 2 weeks with white ink pause mode ......................................... 226 

7-5-4.  When Not Using for a Long Period of Time: more than 2 weeks with white ink pause mode ................................. 226 

8.  What to do when needed 227 

8-1.  Setting the print direction ........................................................................................................................................................ 229 

8-2.  Screen back light adjustment ................................................................................................................................................. 229 

8-3.  Setup of Auto Screen Erase Time .......................................................................................................................................... 230 

8-4.  Setting the menu timeout period ............................................................................................................................................ 230 

8-5.  Speaker volume adjustment ................................................................................................................................................... 231 

8-6.  Setup of temperature indication ............................................................................................................................................. 231 

8-7.  Preview display settings ......................................................................................................................................................... 232 

8-8.  File name display setting ........................................................................................................................................................ 232 

8-9. Platen Obstacle sensor ............................................................................................................................................................. 233 

8-10. Platen too low sensor .............................................................................................................................................................. 233 

8-11.  Print Operation Settings Under Low Temperature ............................................................................................................... 234 

8-12.  Auto Cleaning Setting ........................................................................................................................................................... 235 

8-13.  Flushing Interval Setting ....................................................................................................................................................... 236 

8-14.  Flushing Volume Setting ....................................................................................................................................................... 236 

8-15.  Wiping frequency settings .................................................................................................................................................... 237 

8-16.  Automatic deletion of print data ............................................................................................................................................ 237 

8-17.  Static IP address setting ....................................................................................................................................................... 238 

8-18.  Network filtering settings ...................................................................................................................................................... 239 

8-19.  Shortcut button setting .......................................................................................................................................................... 239 

8-20.  Cartridge Attach/Remove Check ......................................................................................................................................... 240 

8-21.  Display of total printed sheets .............................................................................................................................................. 240 

8-22.  Cartridge Attach/Remove Check History ............................................................................................................................. 241 

8-23.  Check circulation schedule................................................................................................................................................... 241 

8-24.  Display of Temperature/Humidity Info .................................................................................................................................. 242 

8-25.  Confirm network setting ........................................................................................................................................................ 243 

8-26.  Language setting .................................................................................................................................................................. 244 

8-27.  Display of version ................................................................................................................................................................. 245 

8-27-1.  Updating of firmware ................................................................................................................................................ 246 



 

15 

Table of contents

9.  Troubleshooting 247 

9-1.  Troubleshooting instructions ................................................................................................................................................... 248 

9-2.  Solutions to print quality problems ......................................................................................................................................... 251 

9-2-1.  Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets ............................................. 257 

9-2-2.  White head cleaning ................................................................................................................................................... 262 

9-2-3.  Cleaning of head nozzle ............................................................................................................................................. 268 

9-2-4.  Cleaning the surrounding area of nozzle surface ...................................................................................................... 271 

9-2-5.  Replacing the color filter ............................................................................................................................................. 274 

9-2-6.  Replacement of print head ......................................................................................................................................... 277 

9-2-7.  Replacing the Wiper ................................................................................................................................................... 303 

9-2-8.  Re-install the ink ......................................................................................................................................................... 308 

9-3.  Acquisition of log file ............................................................................................................................................................... 309 

10.  Error message 311 

 

11.  Specifications 350 

11-1.  Apparatus .............................................................................................................................................................................. 350 

11-2.  Software ................................................................................................................................................................................ 351 

11-3.  Ink, maintenance solution, cleaning solution, pretreatment ................................................................................................ 352 

11-3-1.  Ink .............................................................................................................................................................................. 352 

11-3-2.  Maintenance solution ................................................................................................................................................ 352 

11-3-3.  Cleaning solution ...................................................................................................................................................... 353 

11-3-4.  Pretreatment ............................................................................................................................................................. 353 

11-4.  About consumable supplies, optional items and replacement parts ................................................................................... 354 
 



 

16 

1 Before Using Your Printer for the First Time 

1-1.  Be sure to read the following notes before using the printer 

Keep in mind the following points before using the printer: 

Precautions for proper use 

 Keep the printer powered on the printer for 24 hours a day.  

Even when the printer is placed in standby mode, it performs such maintenance as white ink circulation inside 

the main unit automatically to prevent sedimentation of the white ink. 
 

 Use the printer within the scope covered by its warranty for the best print result (temperature: 18 to 

30°C (64.4 to 86°F) and humidity: 35 to 85%).  

Otherwise, the print heads may be clogged with ink and ink may splash. 
 

 Adjust the height of the platen according to the print medium before using it. 

Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and 

check that the platen is not detected by the obstacle sensor. 

 

 Do not excessively lower the platen. 

Otherwise, ink mist will be scattered inside the printer, which may result in staining of the printing surface, 

blurring of the printed image, and malfunction of the sensor and the main unit.  

☞"6-4-2. Platen height adjustment >>P.137" 
 

 Never power off the printer or open the cover while the printer is in operation. 

Otherwise, the printer may break down or a print job may end up in failure. 
 

 Until the ink is firmly fixed on the surface of a T-shirt, do not touch the T-shirt.  

If a T-shirt is soiled with such ink that has not been firmly fixed on its surface, such ink stain cannot be removed 

even by washing. 
 

About ink cartridge 

 Insert each of the cartridges into the hole of the same color as the printer seal. 
 

 Shake the white ink well once a day immediately before use. (Shake each cartridge approximately 100 

times.) 

Otherwise the white ink may precipitate. 
 

 Never pull out any cartridges while the printer is operating. 

Otherwise, the print quality may deteriorate or the printer may break down. 
 

 Store consumable goods in a place where they are not exposed to direct sunlight.  

 

 Use up the ink pouch and solutions before their shelf life. 

Also, use up each ink pouch within six months after opening their sealed packages. 

Use of an expired ink pouch may make you liable for the cost of repairs even during the guarantee period. 
 

 Do not refill into or disassemble the ink pouch. 

In order to use the printer for a long period and to take full advantage of its capabilities, we recommend to use 

the ink pouches and solutions specified by Brother. 

In cases where the printer malfunctions due to the use of a non-genuine ink pouch, you may be liable for the 

cost of repairs even during the guarantee period. 
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Before Using Your Printer for the First Time

 Do not remove the ink cartridge. 
If the ink cartridge insertion slot is left empty, the inner needle may clog because ink dries up, or the printer may 

be damaged. 
 

 Take care to prevent the ink pouch from being bent, snagged by sharp objects, or dropped. 

Otherwise, it could be damaged. 

 

About pretreatment 

 Avoid application of the pretreatment when no white ink is used. 

If a T-shirt to which the pretreatment is applied is coated with only color inks, its stains may be wiped off by 

washing. 

 

 After a T-shirt is coated with the pretreatment, store pretreatment in a place where it is not exposed to 

direct sunlight, and wash it with clean water at an early stage after ink is applied to it. 

When a white or light-colored T-shirt is coated with the pretreatment, the coated surface color may change, and 

cannot be restored to the original color even if the T-shirt is washed. 

 

 When performing printing for the first time, try pretreatment in an unnoticeable area. 

Some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they 

are washed. 

 

 Wash away any imprint of the pretreatment with water. 

 

 When a color transfer occurs, wipe the color-transferred area clean of dirt with a soft and clean cloth or 

a toothbrush that is moistened with a small amount of mild detergent for home use or alcohol. 

If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer 

may occur. Also, when a color-printed surface is rubbed strongly against a printed surface with only white ink, 

color transfer may occur in the same fashion. 

 

About maintenance 

 In order to keep good printing quality, perform maintenance on a regular basis.  

☞"7. Precautions to keep good printing quality/use printer over the long term >>P.168" 

 

 We recommend to use the genuine cleaning solution that is specified by us when cleaning the head 

section, cap or wiper. 

This allows you to take full advantage of the printer's intrinsic capabilities and use it for a long period. 

Using commercially available alcohol or cleaning solution could cause damage to the print heads. 

 

 Never remove the print heads except when they are replaced with new ones. 

Because they are precision components, the print head may fail. 

 

What to do when not using printer 

 When the printer will not be used for a prolonged period of time, take appropriate procedures before 

storing the printer depending on storage period or condition. 

☞"7-5. When Not Using for a Long Period of Time >>P.225" 
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About waste handling 

 Dispose of the residual wastes and waste ink properly as water-based waste fluid in accordance with 

applicable laws and ordinances. 

 

Others 

 In the event that the printer is relocated elsewhere for layout change, etc., place a level gauge on the 

top surface of the cover and the top surface of the platen to make such an adjustment that the printer 

will be placed horizontally level. 

 : Standby symbol 

 You cannot connect this product directly to the communications lines, including the public wireless LANs, of 

telecommunication carriers like mobile communications companies, fixed communications companies, or 

internet providers. Ensure that the product is connected through a router, if it is to be used over the internet. 
 

<NOTE> Only for the use in the United States 

 This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not 

cause harmful interference, and (2) this device must accept any interference received, including interference that may cause 

undesired operation. 

 

About trademarks 

The names of operating systems described in the main context of this manual are abbreviated. Product names used in 

this manual are, in general, trademarks or registered trademarks of their respective developer or manufacture. However, 

in this manual, the ® marks or TM marks are not used. 

Brother logo is registered trademark of Brother Industries, Ltd. 

Apple, Macintosh, Mac OS, iOS, OS X, macOS, Safari, iPad, iPhone, iPod and iPod touch are the trademarks or 

registered trademarks of Apple Inc. in the United States and other countries. 

The official name of Windows® 8.1 is Microsoft® Windows® 8.1 operating system. (represented as Windows 8.1 in this 

manual) Also, the official name of Windows® 10 is Microsoft® Windows® 10 operating system. (represented as Windows 

10 in this manual) 

Microsoft®, Windows® 8.1, and Windows® 10 are trademarks and registered trademarks of Microsoft Corporation in the 

United States of America and other countries. 

Corel, Corel's logo and CorelDRAW are trademarks and registered trademarks of Corel Corporation. 

Adobe, Adobe's logo, Acrobat, Photoshop, and Illustrator are trademarks of Adobe Systems Incorporated (Adobe 

Systems). 

Other product and company names mentioned herein may be the trademarks or registered trademarks of their 

respective owners. 

Information in this document and the specifications of this product are subject to change without notice. 

 

 

About the CE declarations 

Downloadable from: http://www.brother.com 
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About software 

This printer uses its own software. 

To use this printer, you are required to agree with the End-User License Agreement for Brother Software as mentioned 

below. 
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End-User License Agreement for Brother Software 
IMPORTANT-PLEASE READ CAREFULLY 

This End-User License Agreement ("EULA") is a legal agreement between you and Brother Industries, Ltd. ("Brother"), 

which governs your use of the Brother software that will be installed if you press the "Yes" button on this Dialog Box 

("SOFTWARE"). By pressing "Yes", you agree to be legally bound by the terms of this EULA. If you do not agree to the 

terms of this EULA, you obtain no license to the SOFTWARE. In such case, you may not use the SOFTWARE. 

Terms and Conditions. 

1. Ownership. 

All rights, titles and interest in and to the SOFTWARE and the files associated therewith are owned by Brother or its 

suppliers. The foregoing rights to the SOFTWARE are licensed to you on a limited basis as prescribed in the following 

Article 2. In any event, this provision should not be construed in any way, as an expression to assign or sell any 

copyrights of, or any other intellectual property rights to, the SOFTWARE from Brother to you. 

2. Grant of License. 

2.1   Brother grants you a non-exclusive, non-transferable license to install and use the SOFTWARE on your one or 

more computer hardware(s). 

2.2   Brother further grants you a license to make a copy of the SOFTWARE at all times, solely for archival purposes, 

which such copy shall attach and stipulate all copyright and intellectual property rights notices. 

2.3   Except for expressly stipulated in Sections 2.1 and 2.2 above, Brother does not grant you any license relating to 

the SOFTWARE. Except to the extent expressly permitted by applicable law, you may not, (i) make any copies of the 

SOFTWARE except as expressly permitted in accordance with Sections 2.1 and 2.2 of this EULA, (ii) modify the 

SOFTWARE, (iii) reverse engineer, disassemble, decompile or use the SOFTWARE to create any derivative software, 

(iv) rent or lease the SOFTWARE, (v) make available to download the SOFTWARE to the public, or (vi) transfer the 

SOFTWARE to any third person or parties by wire or any other means. 

3. WARRANTIES DISCLAIMER 

TO THE EXTENT ALLOWED BY LAW, THIS SOFTWARE IS PROVIDED TO YOU "AS IS" WITHOUT WARRANTIES 

OR CONDITIONS OF ANY KIND, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED. BROTHER 

SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, 

SATISFACTORY QUALITY, NON-INFRINGEMENT AND/OR FITNESS FOR A PARTICULAR PURPOSE. 

4. LIMITATION OF LIABILITY 

IN NO EVENT SHALL BROTHER BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS 

OPPORTUNITIES, LOSS OF USE OF DATA, INTERRUPTION OF BUSINESS, OR FOR INDIRECT, SPECIAL, 

INCIDENTAL, PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES OF ANY KIND, ARISING OUT OF THE 

USE, INABILITY TO USE, OR THE RESULTS OF USE OF THE SOFTWARE, WHETHER BASED IN CONTRACT, 

TORT, OR OTHERWISE. YOUR USE OF THE SOFTWARE IS ENTIRELY AT YOUR OWN RISK. SHOULD THE 

SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL SERVICE, REPAIR OR 

CORRECTION AND, TO THE EXTENT PERMITTED BY THE APPLICABLE LAW, YOU AGREE TO 

UNCONDITIONALLY WAIVE ALL STATUTORY OR OTHER RIGHTS THAT MAY BE HELD BY YOU AGAINST 

BROTHER IN RESPECT OF SUCH DEFECT. Notwithstanding the above, these terms do not purport to limit the 

statutory rights of a consumer that cannot be waived under the applicable law. 

5. Term. 

This EULA will become effective upon your acceptance and continue in effect unless you cease to use the SOFTWARE. 

However, Brother may terminate this EULA without notice. 

6. Governing Laws. 

This English language translation of the original Japanese language EULA is governed and controlled under the 

jurisdiction of the laws of Japan. If any of the provisions of this EULA shall be declared void, such provisions shall be 

severable and independent from the other provisions of this EULA, and the validity of the other provisions and of the 

entire EULA shall not be affected. 
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1-2.  Components included with printer 

The components included with the printer are shown below. However, in the event that there is any missing 

component(s), please contact your dealer. 

① ② ③ ④

⑤ ⑥ ⑦ ⑧

⑨ ⑩ ⑭⑪

⑮ ⑲

⑱

⑰⑯

⑫ ⑬

⑳

X0305 
No. Name Quantity No. Name Quantity

1 AC power cord 1 
10  

Flushing receiver 

Flushing foam 

2 

2 2 Cable clamp 1 

3 Grease 1 11 Waste ink tank 1 

4 
Clean stick R 

Clean stick T 

6 

6 

12 Print head (for color printing) 1 

13 Print head (for white) 1 

5 Cleaning cup 1 14 Rear cover installation screws*1 2 

6 Filter cover and Fan filter 2 15 Rear cover 1 

7 

Gloves (for changing the wiper 

cleaner / for cleaning the 

maintenance unit) 

4 

16 Wiper cleaner 2 

17 Adult platen 1 

18 Setup Manual 1 

8 Carriage fixing pin 1 19 Driver 1 

9 Tweezers 1 20 Waste ink tube 1 
*1: Screws are already fixed with the machine. 
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1-3.  Other items you must make available for use 

What you buy from our distributors 

 Ink pouch 

 Maintenance solution pouch *Only if white ink is not used 

 Cleaning solution 

 Pretreatment 

 

Others 

 USB 2.0-compliant device cable (A/B)  

<NOTE> 

 Using other cables than the specified one may cause the printer to be rendered inoperative. Do not use any extension 

cable. 

 

 LAN cable (10BASE-T/100BASE-TX) 

 

 USB flash memory 

Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You 

cannot use a USB memory with security functions such as password lock function or beyond 32 GB. 

 

 Pure water 

It refers to such water as distilled water and purified water, which is used to dilute the pretreatment with it. 

<NOTE> 

 Avoid using such water as tap water in which impurities are contained. 

 
 Heat press 

It must deliver the performance through which the print range of the size of a platen to be used can be 

covered and 180°C (356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be 

sure to use the heat press, but not an oven, to smoothen the surface. 

 

 Peel-off sheet 

Always use this sheet to flatten the fixed surface and enhance the peel property when fixating the 

pretreatment and ink by means of the heat press. ☞"6-3-1. Provisions for pretreatment >>P.121". 

 

 Silicone foam (of open-cell structure) 

It is the foamed mattress which resists heat. Use this at a fixing stage through the use of the heat press. 

 

 Adhesive roller 

Use these to remove lint from a T-shirt or debris from its surface. 
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 T-shirt (printing medium) 

 100% cotton 

 Polyester blended yarn fabric 

 

<TIPS> 

 Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even 

if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on 

it beforehand. 

 Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water. 

 Perform a printing test beforehand. Then, the following phenomena may occur:  

- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.  

- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different 

color.  

- Fabric material may turn yellow after the pretreatment is fixed. 
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2 Name and function of each component 

2-1.  Front part 

X0306

1

13

3

8

9

1011 12

7

6

5

4

3

2

 

No. Name Function 

1 Front cover Open this cover when cleaning the internal area of the printer. 

2 Carriage Holds the print head. 

3 
Obstacle sensor 

Checks the presence of any obstacles by their height (such as wrinkled T-shirt) 

that are within range to collide with the print head. 

Platen too low sensor Make sure that the clearance between the head and platen is not too large. 

4 Platen sheet 
It helps to keep the T-shirt from moving/shifting during printing so that an image 

can be clearly printed. 

5 Platen Set the T-shirt to be printed. 

6 Shoulder bar Align the position of a T-shirt with this bar. 

7 T-shirt tray 
This T-shirt tray holds such portions of T-shirt that droop down on it and feeds 

the entire T-shirt into the printer. 

8 USB flash insertion slot Insert a USB flash memory into this slot. 

9 LAN port Into this port, insert the LAN cable which is to be connected with a PC. 

10 USB port Into this port, insert the USB cable which is to be connected with a PC. 
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No. Name Function 

11 Power button 

Use this button to turn the power on/off to the printer.  

The power-off operation should be performed after completing any required 

operation.  

The standby power cannot be turned off. 

12 Cable clamp 
With this clamp, the LAN and USB cables can be securely fixed to the lower 

part of the main unit of printer. 

13 Operation panel Operate the printer using this panel. 

 

 

2-2.  Right side view 

X0307

321

 

No. Name Function 

1 Ink cartridge slot 

Ink cartridges placed here are, from the left in the top row, black (K) and yellow 

(Y), from the left in the middle row, cyan (C) and magenta (M), and from the left 

in the bottom row, white (W12) and white (W34). Be sure to put each of the ink 

cartridges in their correct places. 

2 Model plate On this plate, a product serial number is inscribed. 

3 Power cord insertion port Insert the power cord into this port. 
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Name and function of each component

2-3.  Left side view/Rear side view 

X0308

4

3

122
1

6 5

 

No. Name Function 

1 Exhaust opening 
This is the exhaust outlet for fan exhaust air. For proper use, keep this opening 

apart from the nearest wall by 7.9 in. (20 cm) or more. 

2 Fan filter It absorbs ink mist which is generated inside the printer on its surface. 

3 Waste ink tube This tube is used to direct the flow of waste ink down into the waste ink tank. 

4 Waste ink tank This tank collects waste ink. 

5 Cleaning liquid tank It is the tank that reserves the cleaning solution used for maintenance. 

6 Rear cover It protects the platen's working range. 
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Name and function of each component

2-4.  Inner-side view of front cover 

Before opening the front cover, be sure to stop all operations, then house the platen in place, and finally turn off the 

power.  

To open the front cover, raise it while holding the center grip and open it until it is oriented almost vertically. 

<IMPORTANT> 

 Be sure to press the power button to turn off the power before opening the front cover. 

If you open the front cover while the power is on, no cleaning will be performed at the end of the print job, which is intended to 

keep the print heads in good condition. 

X0309

21

4

3

6

7

8

9

89

5

12

710
11

 

No. Name Function 

1 Print head (front: on the color side) It ejects the color ink. 

2 Print head (rear: on the white side) It ejects the white ink. 

3 Carriage guide shaft This shaft supports the carriage. 

4 Maintenance unit 

In order to keep good printing quality, this unit performs maintenance 

functions to the print heads on a regular basis. (Example: Auto-Cleaning 

Function) 

5 Cap (rear: on the white side) 
It protects the surface of heads on the white side, and sucks ink during 

head cleaning. 

6 Wiper cleaner (rear: on the white side) It removes waste ink attached to the wiper surface. 

7 Wiper (for CMYK and white) It wipes away ink from the head surface. 

8 Flushing foam 
To keep good printing quality the foam absorbs the ink-jet droplets ejected 

from the print head. 

9 Flushing receiver Set the flushing foam. 

10 Wiper cleaner (front: on the color side) It removes waste ink attached to the wiper surface. 

11 Cap (front: on the color side) 
It protects the surface of heads on the color side, and sucks ink during 

head cleaning. 

12 Carriage fixing pin 
To prevent drying of print heads in an emergency such as a blackout, it 

fixes the carriage to the cap position of the maintenance unit. 
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2-5.  Bottom view of platen 

X0255

2

1

4

5

6

7

3

 

No. Name Function 

1 Platen fixing lever 

Use this lever to secure the platen in place.  

Tighten or loosen it to adjust the height of the platen when attaching/removing 

the platen. Keep it tightened when printing. 

2 Platen positioning plate This is used to secure the platen at the fixed direction and hold it in place. 

3 Platen height adjustment lever This lever should be used to adjust the platen's height. 

4 Knob 
Use this knob to secure the platen bearing in place. This lever should be used 

to change the platen's height. Keep it tightened when printing. 

5 Platen bearing This is used to secure and hold the platen in place. 

6 Collars Used to change the platen's height by changing the number. 

7 Spacer 

Platen height of each machine is finely adjusted by the number of the spacer. 

Never tamper with or remove these spacers even if adjusting the collars or it 

will affect print output. 
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Name and function of each component

2-6.  Operation panel 

X0036

12

11

10

9

2

1

3

4

5

67

8
 

 

No. Name Function 

1 Liquid crystal panel 
It indicates the job name or file name of print data, the active status of the 

printer, and the menu for various settings. 

2 Error LED 
When it remains off:  No error has occurred. 

When it remains on:  One or more errors have been detected. 

3 Up-arrow button  

While the menu screen is being displayed, use this button to select your 

desired menu item. 

In the numeric value setting menu, use this button to increase the target value.

4 Right-arrow button  

While the menu screen is being displayed, use this button to select your 

desired lower-level (right) menu item. 

While the standby mode screen is being displayed, use this button to display a 

warning when any warning message appears. 

5 MENU/OK button  

If this button is pressed when the printer is placed in the standby state, the 

menu screen will appear. 

While the menu screen or the error screen is being displayed, use this button to 

finalize and accept the currently displayed content. 

6 Down-arrow button  

While the menu screen is being displayed, use this button to select your 

desired menu item. 

In the numeric value setting menu, use this button to decrease the target value.

7 
Back button / 

Left-arrow button 
 

 

While the menu screen is being displayed, use this button to return to only one 

upper-level (left) menu screen. 

8 Print button 

There is no print data when this button remains off. This button blinks during 

reception of print data, and it illuminates when such reception is completed. 

Printing will begin if you press this button when it is illuminated. 
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No. Name Function 

9 Stop button 
 

With this button, such actions as printing and platen movement can be 

canceled. 

Printer will come to a stop after necessary actions for keeping the printer's good 

quality, such as retracting operation of print heads and capping operation, are 

completed. 

While the menu screen is being displayed, the screen will exit and return to the 

standby mode screen. 

10 Platen button 
 

It is used to move the platen toward the rear or front of the printer. Use this 

button to ascertain whether the platen is set to a proper height after the platen's 

height is adjusted. 

11 Shortcut button 
 

Performs the action assigned to the shortcut function. 

12 Power LED 
When it remains off:  The power of the printer is turned off. 

When it remains on:  The printer remains turned on (powered on). 
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2-6-1.  Liquid crystal panel 

The picture shown below indicates a state under which the printer has received print data. On this screen, the printer's 

current state and necessary information for printing are displayed. 

 

1 2

3

4

56789

10

X0190 
No. Indications Function 

1 Progress bar display area 
It displays a state of progress during the process of printing and/or print-data 

reception. 

2 
Text string display area on 

basic display screen 

In this area, the print job name or file name, auto cleaning, receiving state, 

standby state, etc. are shown. 

3 Platen Size 
Platen size that is specified by the print driver during file creation is indicated 

here. 

4 Number of printed sheets 
The total number of printed sheets of which printing operation is completed in 

response to the received print data is displayed here. (0 to 999) 

5 Warning mark  

This mark appears when any warning is issued. Pressing  causes the 

current screen to move to the warning screen where the applicable warning 

message is indicated. 

6 Resolution icon The printing resolution of received print data is displayed here. 

7 Print direction icon 
The print direction is displayed here in the form of either bi-directional or 

uni-directional icon. 

8 Ink volume to be used 

The required ink volume (cc) for printing out one sheet of the received print data 

is displayed here. 

(CMYK + White) 
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No. Indications Function 

9 
Remaining ink volume 

indication area 

In this area, current remaining ink volume of each cartridge is displayed. 

In the left-to-right order, the remaining ink volume in the black (K), yellow (Y), 

cyan (C), magenta (M) and two white (W12 and W34) ink cartridges are shown 

here. 

: The remaining ink volume is running low. Make ink available for use in the 

next printing session. *1 

: Ink has been depleted. 

10 Preview image 

The preview display screen of received print data is shown in this window. The 

preview display screen shown here is indicated upside down as opposed to the 

page orientation (the upper side of the preview image is oriented toward the front 

of the printer main unit). 

Furthermore, it is possible to change the direction of the preview display screen 

as well. 

 

<IMPORTANT> 

*1: If you perform printing that requires a large volume of ink when the remaining ink level is low, the ink may be depleted during the 

printing process. As a rough indication, replace the ink pouch before you perform printing that requires 20 cc or more ink. 
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3 Menu list 

On-screen menu manipulation 

What to do How to operate 

Start 
Pressing  in the wait state causes the current screen to move to the menu 

selection screen. 

Select / Acknowledge 

By means of , change a menu item to another menu item to be displayed. 

Pressing  causes the current menu to change to another menu item which is 

one level lower in the menu layer. 

Pressing  causes the currently displayed menu to be acknowledged. 

Return to previous menu in 

upper menu layer 

Pressing  causes the current menu to change to another menu item which is 

one level higher in the menu layer. 

Exit 

 If you press  when a menu in the uppermost menu layer remains 

displayed, the menu will exit and the system will return to the standby state. 

 If you press  when an optional menu remains displayed, the menu will 

exit and the system will return to standby state. 
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Menu list 

1st layer 2nd layer 3rd layer Description 

[Head Cleaning] 

[Normal Cleaning] 

[All Colors] 

In the event that no ink-jet droplets are ejected, 

this menu item enables you to perform cleaning 

of all the nozzles of the color heads. 

[All Whites] 

In the event that no ink-jet droplets are ejected, 

this menu item enables you to perform cleaning 

of all the nozzles of the white heads. 

[All Print Heads] 

In the event that no ink-jet droplets are ejected, 

this menu item enables you to perform cleaning 

of the nozzles of all the print heads. 

[Powerful Cleaning] 

[All Colors] Perform one of the powerful cleaning operations 

when poor ejection of ink-jet droplets is not 

improved by means of the normal cleaning. 

[All Whites] 

[All Print Heads] 

[Super Cleaning] 

[All Colors] Perform one of the super cleaning operations 

when poor ejection of ink-jet droplets is not 

improved by means of the powerful cleaning. 

[All Whites] 

[All Print Heads] 

[Flash Firing] 

[White-1] 

Perform one of the flushing operations when the 

ink-jet droplets are not ejected stably. 

[White-2] 

[White-3] 

[White-4] 

[Black] 

[Yellow] 

[Cyan] 

[Magenta] 

[All Whites] 

[All Colors] 
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1st layer 2nd layer Description 

[Test Print] 

[Nozzle Check CMYK] 
This is the test pattern to check to see if ink-jet droplets are 

ejected from the color heads properly or not. 

[Nozzle Check White] 
This is the test pattern to check to see if ink-jet droplets are 

ejected from the white head(s) properly or not. 

[Print Data Load] 
With this menu item, any print data stored in a USB flash 

memory (ARXP or ARX4 file) is loaded into the system. 

[Receiving History] 

By selecting this menu item, you can display any print data 

received in the order in which they are sorted from the 

newest to the oldest ones, and you can select any one of 

them. 

[Maintenance] 

[Maintenance Part Clean/Replace]

Use when performing printer maintenance. 

[White Ink Circulation] 

[Head Replacement] 

[Install Ink after Replacing Head] 

[Initial Ink Installation] 

[Exchange color filter] 

[Printer transport preparation] 

[Log copy to USB] 

[Printer Setting] 

[Print Direction] 

Use when configuring the printer. 

[Back Light] 

[Auto Screen Erase Time] 

[Menu TimeOut Setting] 

[Speaker Volume] 

[Temperature] 

[Preview display settings] 

[File name display setting] 

[Platen Obstacle sensor] 

[Platen too low sensor] 

[Low Temperature Mode] 

[Auto Cleaning Setting] 

[Auto Cleaning Start Timing] 

[Flushing Interval Setting] 

[Flushing Volume Setting] 

[Wiping frequency] 

[Auto Job Delete] 

[IP Address Set] 

[Network filtering] 

[Shortcut button] 

[Cartridge Attach/Remove Check] 

[CR Speed Adjustment] 
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1st layer 2nd layer Description 

[Total Print] 

Use when needed. 

[CTG Attach/Remove History] 

[Check circulation schedule] 

[Temperature/Humidity Info] 

[Confirm network 

setting] 

[IP Address] 

[Subnet Mask] 

[Default Gateway] 

[Host name] 

[MAC address] 

[Language] 

[Version] 

[Firm Version] 

[Data Info] 

[Serial No.] 

[Head information] 
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4 Installation and preparation 

Be sure to use the printer after making correct setting in accordance with the instructions described in this chapter. 

 

WARNING 

 

 

 

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric 

shocks or problems with correct operation. 
 

 
Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a 

serious electric shock, and problems with correct operation may also occur. 

 

 

 

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords. 

Otherwise it may cause fire or electric shocks.  
 

 

CAUTION 

 
Setting up and moving of the printer should only be carried out by a qualified technician. 

 

 

 

The printer machine weighs 128 kg (282 lb). 
Transporting and setting up of the printer should be held in the proper way. The machine may fall down and 
cause injury. 

 

 

When the printer falls down, disconnect the power cord and contact the place of purchase or a qualified 

technician. If you continue to use it, it may result in fire or electric shocks or poor printing quality. 

 
Do not place the printer on a shaky table or high shelf or other unstable location. Otherwise it may tip over or 

fall down and cause injury. Furthermore, the table that supports the machine should be at least 35.4 in. (90 

cm) in width and 23.6 in. (60 cm) in depth, and should be able to bear a weight of 150 kg (330 lb) or more. 

 
Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be 

degraded or the printer may fall down, which causes injury or results in failure of the printer. 

 
Do not connect the power cord until installation is complete. The printer may operate if the power switch is 

turned on by mistake, which could result in injury. 

 
Do not climb onto the printer or place heavy objects on top of it. Otherwise it may become unbalanced and tip 

over or fall down and cause injury. 

 
Be careful not to touch the claws of the mounting portion on the upper side of the rear cover. Otherwise you 

may be injured. 
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Installation and preparation

4-1.  Installation of printer 

Please refer to the Setup Manual included with the printer, for details of unpacking procedures and installation 

procedures of accessories.  

For an installation site of the printer, please bear the following points in mind: 

 When installing the printer, avoid any place that presents direct sunlight or a large amount of dust. 

 The body size is 55.1 in. (width) x 51.2 in. (depth) x 21.7 in. (height) (140 cm (width) x 130 cm (depth) x 55 cm 

(height)). The main unit weighs 128 kg (282 lb). 

 The right-and-left width of the legs is 34.1 in. (86.7 cm) while the front-to-rear width is 16.7 in. (42.3 cm). The 

diameter of the legs is 1.57 in. (40 mm). 

 The height from the table to the top surface of the platen is approx. 12.6 in. (32 cm). 

 Do not use any extension cable. 

 As workspace in front of and on both sides of the printer, always keep 39.4 in. (100 cm) or wider space around it 

from obstruction. Also, as a space to install the rear cover, keep 15.7 in. (40 cm) or wider clearance at the back 

of the printer. Keep 17.7 in. (45 cm) or wider space free above the unit as well. As the air is exhausted toward 

the rear side, keep 7.9 in. (20 cm) or more space open behind the exhaust opening. If this space is not secured, 

you will have to move peripherals or the printer when making a repair. 

 Be sure to use a table that supports the printer should be at least 35.4 in. (90 cm) in width and 23.6 in. (60 cm) in 

depth, and its top plate should be level and should be able to bear a weight of 150 kg (330 lb) or more without 

rattling the printer when in operation. 

 When installing the printer, place a level gauge on the top surface of the cover and the top surface of the platen 

to make adjustments so that the main unit is set horizontally level. 

 In preparation for a major earthquake or other natural disasters, fix the table and the main unit with a tool like a 

fixing band to prevent the main unit from falling from the table. 

 

X0310  

Exhaust opening 
106.3 in. (270 cm) or more

39.4 in. (100 cm) 
or more 

23.6 in. (60 cm) or more

39.4 in. (100 cm) or more

35.4 in. (90 cm) or more

39.4 in. (100 cm) 
or more 

133.9 in. (340 cm) or more

Printer installation dimensions 
Exhaust

17.7 in. (45 cm) or more

15.7 in. (40 cm) or more
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X0311

 

 

Platen top surface 

Seismic protection example 

Leg dimension 

Platen height dimension surface 

Base 

Leg

34.1 in. (86.7 cm) 16.7 in. (42.3 cm)

1.57 in. (40 mm) 

Approx. 12.6 in. (32 cm)
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4-1-1.  Installation of waste ink tank 

Insert the waste ink tube into the main body. Fasten the waste ink tank to the table leg or the like by using two pieces of 

string, etc. Insert the waste ink tube into the waste ink tank. 

<IMPORTANT> 

 If the tip of the waste ink tube is immersed in the liquid, it will prevent the smooth flow of the waste ink, to disable the ink 

suction operation of the head cleaning function. After the waste ink tank is fastened, the waste ink tube should be cut so 

that the length from the tube connection is 5.9 in. (150 mm). 

 Avoid placing the waste ink tube horizontally as much as possible, and be sure not to let it bend. Otherwise the waste ink 

may have difficulty flowing through the tube. 

<TIPS> 

 Install the waste ink tank in the front, because it must be emptied when the waste ink is full. 

 

X0312
 

5.9 in. (150 mm)
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4-2.  Power supply of printer 

Even when the printer is placed in standby mode, such maintenance as white ink circulation is performed automatically. 

PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY. 

<TIPS> 

 Every time this printer is powered on or off, maintenance operations are performed to keep its print heads in good condition.  

Turning on and off the power frequently causes more ink to be consumed because of the maintenance operations. In order to 

reduce the ink consumption, it is advisable to keep the power turned on for proper use of the printer. 

4-2-1.  Turning on the power 

Please refer to the Setup Manual, after the unpacking procedures and installation procedures are completed. 

Please check the following points, before connecting the power cord to the printer: 

 Check whether or not the cartridge is correctly installed. 

 Check whether or not the wiper cleaner and flushing receiver are correctly installed. 

 Ascertain whether the ink tube is connected to the print head correctly. 

K Y
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 Ascertain whether the waste ink tube is inserted into the waste ink tank which has been made available. 

 Ascertain whether the rear cover is put in position. 

 Ascertain whether there is enough cleaning solvent in the cleaning liquid tank and the tank is mounted correctly 

in place. 

 Ascertain whether the required space (at least approx. 11.8 in. (30 cm)) for the platen to be moved forward is 

kept and the min. clearance (7.9 in. (20 cm)) is maintained at the back side of the printer for exhausting air from 

the exhaust opening. 

Wiper cleaner 

Flushing receiver 

Cartridge
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(1) Connect the power cord included with the printer to the power cord insertion port. 

(2) Insert the power plug into an electric outlet. 

(3) Make sure that the printer's earth terminal is properly grounded. 

(4) With the main unit's cover being closed, turn on the power to the printer. 

<IMPORTANT> 

 Never power off the printer while it is in operation. Otherwise, the printer may be damaged. 

 Do not activate the printer with the ink tube not connected to the print head. Otherwise, the printer may be damaged. 

 Make sure that no flushing foam extends off the outboard end portions of the flushing receiver. If it sticks out of the end 

portions, it may interfere with any nozzles and may result in non-ejection of ink-jet droplets. 

 Do not turn off the power because if you do so, the machine mail fail because necessary maintenance operations are not 

performed. 

<TIPS> 

 If the printer is activated after having been off for a long time, the maintenance operation including white ink circulation will 

be performed for up to 40 minutes. 

 

4-2-2.  Turning off the power 

When you need to turn off the power 

Turn off the power in the following cases. 

 When the front cover needs to be opened for maintenance of the printer, etc. 

 When moving the printer elsewhere. 

 In the event that the power supply interruption is anticipated in advance, including the case where a planned 

power outage is scheduled. 

<IMPORTANT> 

 When you want to move the printer, perform [Printer transport preparation] before doing so. Otherwise, the print head may 

fail to eject ink-jet droplets due to the vibration during transport.☞ "4-5. Moving the printer >>P.66" 

 

How to turn off the power 

(1) Press the power button for a short time (Release your finger when a beep sounds). 

If the printer is operating, wait for it to finish. 

(2) Cleaning will start at the end of the print job. 

Then the power will be turned off. 

<IMPORTANT> 

 No cleaning will be performed at the end of the print job to keep the print heads in good condition, if you open the front 

cover before turning the power off or disconnect the AC power cable. In these cases, the print heads may fail to eject ink-jet 

droplets. For this reason, be sure to activate the printer once again and perform the head cleaning after activation. 
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4-2-3.  When there is no prospect of electric power recovery for a while due to power outage 

(1) Open the front cover and move the carriage to the left, and stop it at the position where the left side of the carriage 

reaches the end. The position of the print head and the cap should match. 

Returning the print heads to the cap position prevents them from drying up. 

(2) Insert the carriage fixing pin into its specified hole, and fix the carriage to the cap position. 

<TIPS> 

 Note that the carriage fixing pin is housed in the area on the left side of maintenance unit. 

 The front cover will not close completely if the carriage is fixed with the carriage fixing pin. 

X0314 

X0200  

(3) When the current state is brought to an available condition to turn on the power, pull out the carriage fixing pin, 

return it to its stowed position and reactivate the printer. 

<IMPORTANT> 

 For this reason, be sure to activate the printer once again and perform the head cleaning after activation. 

Fixed location

Carriage fixing pin 

Stowed position

Carriage fixing pin 

Front cover 

*The cover will not close 

completely while the  

carriage is fixed. 
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4-3.  Connection between Printer and PC (for Windows) 

This chapter provides information about the procedures to install the GTX pro printer driver onto your PC and connection 

method of the printer to PC. 

For Windows 8.1 and 10, different dialog boxes may be displayed. Proceed with the next step while checking each 

procedural step. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

"4-3-1. Installing printer driver onto your PC >>P.45"

When connecting via 
USB

Add a Printer to PC 

"4-3-2. Connect with 

USB2.0 cable: Adding the 

i t t th PC >>P46"

Set static IP 
address on PC 

Printer static IP Address 
Set 

"4-3-3. When connecting via 
LAN: Static IP address setting 

>>P.48"

Printer static IP Address 
Set 

"8-17. Static IP address setting 
>>P.238"

Add a Printer to PC 

"4-3-4. When connecting via LAN: Adding a printer to PC >>P.52"

"7-4-1. CR (Carriage) speed adjustment >>P.216"

"7-4-2. Initial settings after head replacement >>P.217"

"7-4-3. Firing adjustment >>P.218"

"7-4-4. Platen-rolling adjustment >>P.219"

"7-4-5. White/color alignment >>P.220"

When connecting via LAN

Installing the printer driver 

Adjusting Printer 

Set static IP address on 
Printer main unit 
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4-3-1.  Installing printer driver onto your PC 

To begin with, on your PC, install the printer driver for file output, "Brother GTX pro FileOutput". 

At this stage, do not connect the printer to your PC yet. 

<TIPS> 

 You must log into your PC with administrator privileges. 

 

(1) Activate the PC. 

(2) Complete all of the current sessions. 

(3) Double-click on the "setup.exe" to execute the installer. 

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation. 

(5) When the dialog box shown below appears, click [Install]. 

 

(6) After the installation is completed, reactivate the PC. 
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4-3-2.  Connect with USB2.0 cable: Adding the printer to the PC 

(1) Once you have installed the printer driver, with the printer powered on, make a connection with a USB 2.0 cable 

between the printer and your PC. 

<TIPS> 

 For this connection of the USB cable, secure it in place by means of the cable clamp as required. 

(2) Follow the on-screen instructions to complete the installation. 

(3) After the installation is completed, open [Devices] > [Devices and Printers] from [Settings]. 

<TIPS> 

 In the case of Windows 8.1, select the [View devices and printers] from [Control Panel]. 

 

 
 

(4) Right-click the "Brother GTX pro" icon or the "Brother GTX pro FileOutput" icon for file output, and select the [Set as 

default printer]. 

(5) If LAN connection is required, perform static IP address setting on the printer and add the printer to the PC. 

If connecting only via USB and LAN connection is not required, configuration task on the PC is now completed. 
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(6) Adjust the carriage speed. Then adjust the printer using "GTX pro Maintenance".  

 Menu name Things to prepare See the operating procedure with 

GTX pro Maintenance 

1 [CR Speed Adjustment] ― 
"7-4-1. CR (Carriage) speed 

adjustment >>P.216" 

2 
[Initial settings after head 

replacement] 
― 

"7-4-2. Initial settings after head 

replacement >>P.217" 

3 [Firing Adjustment] 

Black paper or transparent sheet 

(such as OHP sheet) 

White paper 

"7-4-3. Firing adjustment >>P.218" 

4 [Platen-Rolling Adjustment] White paper 
"7-4-4. Platen-rolling adjustment 

>>P.219" 

5 [White/Color Alignment] 
Black paper or pretreated black or 

dark color T-shirt 

"7-4-5. White/color alignment 

>>P.220" 

 

What to do in the White Ink Pause Mode 

For the White ink pause mode, perform the following steps using the maintenance tool.  

 Menu name When in White Ink Pause Mode 

1 [CR Speed Adjustment] Performed 

2 [Initial settings after head replacement] 

Performed for color head only 

Upon completion of color head 

setting, click [Cancel] to close the 

maintenance tool once and then start 

it. Then proceed to the following 

steps. 

3 [Firing Adjustment] 

Performed for color head only 

Upon completion of color head 

setting, click [Cancel] to close the 

maintenance tool once and then start 

it. Then proceed to the following 

steps. 

4 [Platen-rolling adjustment] Performed 

5 [White/Color Alignment] Not required 

6 [Setting of the time displayed on the nozzle check pattern] Performed 
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4-3-3.  When connecting via LAN: Static IP address setting 

When connecting via LAN, Printer static IP address needs to be obtained beforehand. There are two ways to set a static 

IP address for the printer: from the PC and from the printer. For information on the setting from the printer, see Chapter 8. 

☞"8-17. Static IP address setting >>P.238" 

<TIPS> 

 If the PC cannot recognize the Printer, a correct static IP address might not be assigned. ☞"4-3-4. When connecting via LAN: 

Adding a printer to PC >>P.52" 

Consult your administrator. 

 

(1) With the printer powered on, make a connection with a USB 2.0 cable between the printer and your PC. 

<TIPS> 

 For this connection of the USB cable, secure it in place by means of the cable clamp as required. 

(2) From [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools". 

(3) After the window shown below appears, select the [IP Address Set] and click [Next]. 
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(4)  Select the desired IP address setting method and click [Next]. 
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If you selected "Manually enter the IP address" 

(5) Enter each of the pre-determined values of the printer for [IP Address], [Subnet Mask] and [Default Gateway], and 

click [Next]. (One instance of each value is cited as shown in the window below.) 
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If you selected "Automatically acquire the IP address"  

(5) Enter the host name to be set for the printer and click [Next]. 

<TIPS> 

 The host name can contain up to 31 characters. 

 

(6) When [IP address was successfully assigned to Printer.] is displayed, the process is complete. 

If there is any error in each of the values you have entered for the static IP Address, Subnet Mask and Default Gateway, an error 

message to inform you thereof accordingly will appear. In this case, correct the error and attempt the process again. 
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4-3-4.  When connecting via LAN: Adding a printer to PC 

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the 

printer. 

<TIPS> 

 For this connection of the LAN cable, secure it in place by means of the cable clamp as required. 

(2) Select [Settings] > [Devices] > [Devices and Printers]. 

<TIPS> 

 In the case of Windows 8.1, select the [View devices and printers] from [Control Panel]. 

(3) Click the [Add a printer]. 

 

(4) Select [The printer that I want isn't listed]. 

<TIPS> 

 In the case of Windows 8.1, select [The printer that I want isn't listed] -> [Add a local printer or network printer with manual 

settings], then click [Next]. 
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(5) Select [Add a local printer or network printer with manual settings], then click [Next]. 

 

 

(6) Select the [Create a new port], then select [Standard TCP/IP Port] for [Type of port], and finally click [Next]. 
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(7) In the [Hostname or IP address] field, enter the already-setup static IP address of the printer, uncheck the [Query 

the printer and automatically select the driver to use], and click [Next]. (One instance of each value is cited as 

shown in the window below.) 

 

<TIPS> 

 If you set the printer's IP address by automatic acquisition, you must check the IP address of the printer in advance. You 

can confirm the IP address by selecting [Confirm network setting] -> [IP Address] from the menu. ☞"8-25. Confirm network 

setting >>P.243". 

 If you are using a DNS server, you can use a host name and domain name instead of the IP address. Enter the host name 

of your choice.☞ "4-3-3. When connecting via LAN: Static IP address setting >>P.48" 

As for the domain name, check with your network administrator. 

(8) Then, the detection window of TCP/IP port appears, and the current window will automatically go to the additional 

port information window after the detection is completed. 

(9) After the window shown below appears, select the [Custom] in the [Device Type], and click [Settings]. 
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(10) In the [Protocol], select the [LPR], enter "BINARY_P1" in [Queue Name] of the [LPR Settings], and click [OK]. 

When the current screen goes back to the previous screen, click [Next]. 

 
 

(11) After the window shown below appears, click the [Have Disk]. 
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(12) Click the [Browse], select the "64bit_OS" folder in the installer according to the PC's OS (64 bit version). 

After the file path appears, click [OK]. 

 

 

(13) Make sure that a list of printer drivers is shown for the selected folder. 

After that, click [Next]. 

 

 

(14) After the window shown below appears, select the [Replace the current driver], and click [Next]. 
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(15) Enter [Printer name], and click [Next]. 

 

 

(16) Then, the specified printer will be added to the system, following which the window shown below appears, select 

the [Do not share this printer], and click [Next]. 
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(17) Click [Finish]. This exits the setting for the PC. 

<TIPS> 

 If the PC cannot recognize the Printer, a correct static IP address might not be assigned. Consult your administrator. 

 

 

(18) Adjust the carriage speed. Then adjust the printer using "GTX pro Maintenance". 

 Menu name Things to prepare See the operating procedure with 

GTX pro Maintenance 

1 [CR Speed Adjustment] ― 
"7-4-1. CR (Carriage) speed 

adjustment >>P.216" 

2 
[Initial settings after head 

replacement] 
― 

"7-4-2. Initial settings after head 

replacement >>P.217" 

3 [Firing Adjustment] 

Black paper or transparent sheet 

(such as OHP sheet) 

White paper 

"7-4-3. Firing adjustment >>P.218" 

4 [Platen-Rolling Adjustment] White paper 
"7-4-4. Platen-rolling adjustment 

>>P.219" 

5 [White/Color Alignment] 
Black paper or pretreated black or 

dark color T-shirt 

"7-4-5. White/color alignment 

>>P.220" 

6 
[Setting of the time displayed 

on the nozzle check pattern] 
― 

"7-4-6. Setting of the time displayed 

on the nozzle check pattern >>P.221"
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What to do in the White Ink Pause Mode 

For the White ink pause mode, perform the following steps using "GTX pro Maintenance". 

 Menu name When in White Ink Pause Mode 

1 [CR Speed Adjustment] Performed 

2 [Initial settings after head replacement] 

Performed for color head only 

Upon completion of color head 

setting, click [Cancel] to close the 

maintenance tool once and then start 

it. Then proceed to the following 

steps. 

3 [Firing Adjustment] 

Performed for color head only 

Upon completion of color head 

setting, click [Cancel] to close the 

maintenance tool once and then start 

it. Then proceed to the following 

steps. 

4 [Platen-rolling adjustment] Performed 

5 [White/Color Alignment] Not required 

6 [Setting of the time displayed on the nozzle check pattern] Performed 
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4-4.  Connection between Printer and PC (for Macintosh) 

This chapter provides information about the procedures to install the GTX pro printer driver and connection method of 

the printer to the PC. You can connect the printer to your PC using either a USB cable or a LAN cable. 

-Using a USB cable☞"4-4-2. Connecting the printer to your PC via a USB 2.0 cable >>P.61" 

-Using a LAN cable☞"4-4-3. Connecting the printer to your PC via a LAN cable >>P.63" 

 

4-4-1.  Installing printer driver onto your PC 

To begin with, onto your PC, install the printer driver for file output, Brother GTX pro FileOutput. 

At this stage, do not connect the printer to your PC yet. 

<TIPS> 

 You must log into your PC with administrator privileges. 

 

(1) Activate the PC. 

(2) Complete all of the current sessions. 

(3) Double-click on the "BrotherGTX pro_ver***.pkg" to execute installer. 

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation. 

(5) After the installation is completed, reactivate the PC. 
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4-4-2.  Connecting the printer to your PC via a USB 2.0 cable 

(1) With the printer powered on, make a connection of USB 2.0 cable between the printer and your PC. 

(2) From the Apple menu, open the [System Preferences] and click on the [Printers & Scanners]. 

 

(3) After that, click the + button in the lower-left corner. 

 

(4) Select the [Brother GTX pro xx] first, then click on the [Select Software…] of [Use]. 
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(5) Select the [Brother GTX pro] and click on the [OK]. 

 

(6) Then, click [Add]. 

 

(7) In the [Default printer], select either [Brother GTX pro xx] or [Brother GTX pro FileOutput]. 

This exits the setting for the USB connection. 
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4-4-3.  Connecting the printer to your PC via a LAN cable 

When you connect your Macintosh to the printer via a LAN cable, configure the IP address settings for the printer, 

referring to the Instruction Manual. 

Subsequently, perform the procedures below to add the printer to your PC. 

 

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the 

printer. 

<TIPS> 

 For this connection of the LAN cable, secure it in place by means of the cable clamp as required. 

(2) From the Apple menu, open the [System Preferences] and click on the [Printers & Scanners]. 

 

(3) After that, click the + button in the lower-left corner. 

 

(4) Select [IP]. 
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(5) In the [Address], enter the IP address of the printer you have just set up. 

Select the [Line Printer Daemon - LPD] of [Protocol]. 

In the [Queue], type in the word "BINARY_P1". 

Enter the name of the printer in the [Name]. 

Click on the [Select Software…] of [Use]. 

 

(6) Select the [Brother GTX pro] and click on the [OK]. 

 

(7) Then, click [Add]. 
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(8) Then, the current window goes back to the [Printers & Scanners] window into which the GTX pro printer (LAN) is 

added. 

In the [Default printer], select your desired GTX pro printer, as required. 

This exits the setting for the LAN connection. 
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4-5.  Moving the printer 

 

<IMPORTANT> 

 When you want to move the printer, perform [Printer transport preparation] before doing so. Otherwise, the print head may 

fail to eject ink-jet droplets due to the vibration during transport. 

(1) While the printer is in standby mode, press the on the operation panel to bring the menu screen into the view. 

(2) From the menu, select [Maintenance] > [Printer transport preparation], and press . 

(3) Check the remaining ink in the ink pouch and press . 

 

(4) Once the transport preparation is complete, turn off the power. 

(5) Remove the power plug from the outlet and move the printer. 
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5-1.  Types of applications 

You can create print data by either “using Brother products” or "using other applications”. Select applications to use 

depending on your needs. You are recommended to use Brother product applications as far as possible. If you want to 

use other applications, however, you are recommended to use one of the three recommended applications to achieve 

high-quality print results. This chapter describes the procedures for using other applications. 

 

Using Brother product 

Applications to use Reference 

GTX Graphics Lab Graphics Lab Instruction Manual 

When using other applications 

Applications to use Reference 

CorelDRAW(2018/2019) "5-3-1. When using CorelDRAW >>P.70" 

Adobe Photoshop(CC2020/CC2019) "5-3-2. When using Adobe Photoshop >>P.78" 

Adobe Illustrator(CC2020/CC2019) "5-3-3. When using Adobe Illustrator >>P.83" 

 

<TIPS> 

 Make proper settings, such as color settings and printing conditions, of each application, in accordance with the setting contents 

of the application. 

 In this chapter, the value RGB=(254,254,254) is described as "RGB=254", and the value RGB=(255,255,255) is described as 

"RGB=255". 
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About color mode (color space) 

The GTX pro printer is a printer of RGB type.  

Be sure to create image data in RGB mode, and always set the color space (input) you use for such data to sRGB 

(sRGB IEC61966-2.1). 

<TIPS> 

 When such application as Adobe and Corel is used, there are instances in which an image in CMYK mode cannot reproduce the 

color that is intended. 

 Even for an image in RGB mode, a similar color reproduction failure occurs when other color space than the specified one, such 

as Adobe RGB, is used. 

 

About print layout 

Specify the platen size that uses the paper size specified in the Print menu, and confirm the print layout. 

Moreover, use the "Brother GTX pro FileOutput" printer driver for file output, then display and check the print preview. 

<TIPS> 

 In order for a print image to be oriented properly at all times, it is advisable to set the GTX pro printer to the [Set as default 

printer]. 

 

How to create white data 

When creating print data with [Color + White Ink] or [White Ink Only], RGB=(255) is treated as "Transparent color", 

ejecting no ink. For such an image that you wish to print out in pure white color with white ink, make such a setting as 

RGB=254. 

<TIPS> 

 The treatment of RGB=255 varies depending on the applications. Configure the settings appropriately. 

 

About ARXP file 

Use the "Brother GTX pro FileOutput" printer driver for file output in order to save your print data in the ARXP format. 

When your print data is saved in the ARXP format, its information and the amount of used ink will be able to be reviewed. 

<TIPS> 

 When performing file output, be sure to use the printer driver, "Brother GTX pro FileOutput". If file output is performed using [Print 

to file] command that is supplied with each application, there may be some cases where the file extension cannot be saved 

as .arxp, or the file destination cannot be specified. 

 ARX4 files created with the GTX can be printed with the GTX pro. 

 The GTX pro printer cannot print out the print data that has been created for the GT-541/GT-782/ GT-3 series. 

 If you make a printer driver setting from the Control Panel of your PC, such setting sometimes will not take effect in each 

application. For this reason, verify that your printer driver has been set up properly before you begin printing. 
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5-2.  Sending print data using Brother GTX pro FileOutput (for Macintosh only) 

Saving print data to a file 

When using the "Brother GTX pro FileOutput" printer to save print data to a file, be sure to perform the save operation 

with the " GTX pro FileViewer" being activated. 

If you try to output and save the data to a file without activating the " GTX pro FileViewer", an error shown below will 

occur and the file cannot be saved to the system. 

<TIPS> 

 Not all applications display an error message. If that is the case, start the "GTX pro FileViewer" and try again. 

 

 
<TIPS> 

 The procedures to output a file from the "Brother GTX pro FileOutput" are the same as those for Windows PC. 

 

 

Transmission of print data 

Send such print data that has been saved using the "Brother GTX pro FileOutput" printer to the printer by performing the 

procedures mentioned below. 

<TIPS> 

 The procedures to send the print data are the same as those for Windows PC. 

 

(1) Double-click on a file with the extension ".arxp" assigned to its filename which has been saved by means of the 

"Brother GTX pro FileOutput" printer. 

(2) Subsequently, the " GTX pro FileViewer" starts working, then, under that condition, click on the [Send to Printer], 

which results in the file transmission. 
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5-3.  Using other applications 

5-3-1.  When using CorelDRAW 

First of all, perform the following procedures: 

 Color setting 

 Print size 

As required, perform the following procedures: 

 Create print data (ARXP file) 

 Use the color palette in Useful Tools. 

 Convert data to bitmap image data 

 Replace RGB=255 in bitmap image data with RGB=254 

 

<TIPS> 

 For this printer, it is recommendable to use CorelDRAW 2018/2019. The display screen is described assuming CorelDRAW 

2019. 

Color management settings 

(1) In the menu bar, select [Tools] > [Color Management]. 

(2) Establish the settings of [Color Management Settings] as follows: 

 [RGB profile]: [sRGB IEC61966-2.1] 

 [Primary color mode]: [RGB] 

 [Rendering intent]: [Relative colorimetric] 

 

 



 

71 

Creating print data

Print size 

(1) In the menu bar, select [File] > [Print]. 

(2) Set the [Printer] to either "Brother GTX pro" or "Brother GTX pro FileOutput", click on [Apply], and close the [Print] 

dialog box. 

<TIPS> 

 If [Printer] is set to "Brother GTX pro", the print data at the time of printing will be sent to the printer.  

If [Printer] is set to "Brother GTX pro FileOutput", the print data at the time of printing will be saved as an ARXP file. 

 

(3) In the menu bar, select [Layout] > [Page Layout]. 
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(4) Make the following settings in the [Page Size] window: 

 [Size]: [Custom] 

 [Width]: 14.0 in. (355.6 mm) 

 [Height]: 16.0 in. (406.4 mm) 

 Page orientation:  Portrait 

<TIPS> 

 Set the width and height to the size of platen to be used. ☞"5-4-1. Select the platen size >>P.91". The above size is the 

standard 14X16 platen size.  

 

 

 

Create print data (ARXP file) 

Save the image data and print settings as a set of print data in ARXP file format. 

The following will be made available if the print data is converted into an ARXP file: 

 Image data and print settings can be put together and stored. 

 Without connection to a PC, the printing can be performed directly from a USB flash memory unit. 

<TIPS> 

 Image editing is unavailable for any ARXP file. As such, save your image data for an editing purpose in advance. 

 For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file] 

command. Be sure to use the printer driver "Brother GTX pro FileOutput". 

 For details of directly sending data to the Printer from an application☞"6-6-2. Sending print data from applications >>P.155". 
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(1) In the menu bar, select [File] > [Print]. 

(2) Open the [Color] tab, and make the following settings: 

 Place a checkmark in the [Document color] checkbox. 

 [Color conversions]: "Brother GTX pro" or "Brother GTX pro FileOutput" 

 [Color profile]: [sRGB IEC61966-2.1] 

 [Rendering intent]: [Relative colorimetric] 

 

(3) On [General] tab, select [Printer] and select "Brother GTX pro FileOutput" for file output. 

<TIPS> 

 If the specified [Printer] is set to "Brother GTX pro ", the print data will be sent to the printer.  

If the specified [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file. 

(4) On [Preferences], create your settings of printer driver.☞ "5-4. Set up the printer driver >>P.89". 
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(5) When you press [OK] in the [Print] dialog box, the dialog box shown below will be displayed. After that, click [Save]. 

<TIPS> 

 There may be cases where this saving process takes several minutes. 

 

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARXP file to your PC. 

 

 

What to do when using the color palette in Useful Tools 

(1) Save the color pallet files for CorelDRAW, "GT_Colors.xml" and "GT_Tshirts.xml", on your PC, following the 

instructions on screen. 

(2) In the menu bar, select [Window] > [Color Palettes] > [Open Palette]. 

(3) Select the files having such filename as "GT_Colors.xml" and "GT_Tshirts.xml", respectively. 

 

<TIPS> 

 Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from 

the resulting print color. 

 

 



 

75 

Creating print data

Convert data to bitmap image data 

(1) In the menu bar, select [Bitmaps] > [Convert To Bitmap]. 

(2) Set the [Color mode] to [RGB Color]. 

<TIPS> 

 When the white ink is used for performing the printing, unmark the [Anti-aliasing] checkbox. 

 

 

<TIPS> 

 Even when the platen size to be used has been selected from the printer driver, the current setting in [Page Layout] may change 

to [Settings from printer].  

In the [Page Layout], be sure to change the width and the height according to the size of the platen. 
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Replace RGB=255 in bitmap image data with RGB=254 

RGB=255 is identified as a transparent color. In a portion where RGB=255 is contained, no ink will be ejected.  

In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.  

To make such replacement, use the method mentioned below. 

(1) In the menu bar, select [Effects] > [Adjust] > [Replace Colors]. 

(2) From the [Old color] pull-down menu, set RGB=255 in [Replace Colors]. 

 



 

77 

Creating print data

(3) In the same manner, set [New color] to RGB=254. 

(4) Set [Range] to "1", and click on the [OK] button. 

 
 

<TIPS> 

 For the vector data, change the fill color to RGB=254. 
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5-3-2.  When using Adobe Photoshop 

In Photoshop, configure the settings mentioned below: 

 Color setting 

As required, perform the following procedures: 

 Create print data (ARXP file) 

 Use the color palette in Useful Tools. 

 Replace RGB=255 with RGB=254 

 

<TIPS> 

 For an image created in the CMYK color mode, select [Image] > [Mode] in the menu bar, and change the color to the RGB color 

(sRGB). In order to edit an image, select [Image] > [Adjustments] in the menu bar and edit it, or edit it by means of the image 

quality improvement of the printer driver (☞"5-4-9. Set up the image quality >>P.103"). 

 For this printer, it is recommended to use Photoshop CC2020/CC2019. The display screen is described assuming Photoshop 

CC2020. 

Color setting 

(1) In the menu bar, select [Edit] > [Color Settings]. 

(2) Establish the settings of [Color Settings] as follows: 

[Working Spaces] 

 [RGB]: [sRGB IEC61966-2.1] 
[Conversion Options] 

 [Engine]: [Adobe(ACE)] 

 [Intent]: [Relative Colorimetric] 
[Color Management Policies] 

 [RGB]: [Convert to Working RGB] 

 [CMYK]: [Convert to Working CMYK] 

 [Gray]: [Convert to Working Gray] 

 [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes. 

 [Missing profiles]: Mark the [Ask When Opening] checkbox. 
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Create print data (ARXP file) 

Save the image data and print settings as a set of print data in ARXP file format. 

The following will be made available if the print data is converted into an ARXP file: 

 Image data and print settings can be put together and stored. 

 Without connecting to a PC, the printing can be performed directly from a USB flash memory. 

<TIPS> 

 Image editing is unavailable for any ARXP file. As such, save your image data for an editing purpose in advance. 

 For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file] 

command. Be sure to use the printer driver "Brother GTX pro FileOutput". 

 For details of directly sending data to the Printer from an application☞"6-6-2. Sending print data from applications >>P.155". 

(1) In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX pro" or "Brother GTX pro 

FileOutput", the layout is set to the platen size. 

(2) Make the settings as follows: 

 [Color Handling]: [Printer Manages Colors] 

 [Rendering Intent]: [Relative Colorimetric] 

 

(3) From [Printer], select "Brother GTX pro FileOutput" for file output. 

<TIPS> 

 If [Printer] is set to "Brother GTX pro", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file. 

(4) On [Print Settings], make your settings for the printer driver.☞ "5-4. Set up the printer driver >>P.89". 
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(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save]. 

<TIPS> 

 There may be cases where this saving process takes several minutes. 

 

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARXP file to your PC. 
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What to do when using the color palette in Useful Tools 

(1) Save the color pallet file for Photoshop, "GT_Colors_T.ase", on your PC, following the instructions on screen. 

(2) In the menu bar, select [Window] > [Swatches]. 

(3) Click on the  to open the submenu. 

 

(4) From [Replace Swatches], select [Swatch Exchange (*.ASE)] for the type of file and then select the file name 

[GT_Colors_T.ase]. 

 

 

 

<TIPS> 

 Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from 

the resulting print color. 

RGB=254 
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What to do when replacing RGB=255 with RGB=254 

RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.  

In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.  

To make such replacement, use the method mentioned below. 

(1) On the menu bar, select [Layer] > [New Adjustment Layer] > [Selective Color], and create a new layer. 

(2) Set the opacity to 20%, and click [OK]. 

 
 

(3) From the [Selective Color], make the following settings: 

 [Colors]: [Whites] 

 [Black]: 1% 

 Mark the [Absolute] option 

 

 

<TIPS> 

 The method to replace RGB=255 with RGB=254 as shown above can be used only when the [Color mode] is set to [8 bit] of 

[RGB Color]. 

 For Photoshop, the action file "SolidWhite.atn" is made available in Useful Tools, which changes RGB=255 to RGB=254 (☞

"5-5-2. Replace RGB=255 with RGB=254 (for Photoshop only) >>P.106"). For how to use it, refer to the Help feature that 

Photoshop is provided with. 
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5-3-3.  When using Adobe Illustrator 

In Illustrator, perform the required procedures mentioned below: 

 Color setting 

 Open a new file 

As required, perform the following procedures: 

 Create print data (ARXP file) 

 Use the color palette 

 

<TIPS> 

 Take one of the actions mentioned below, in order to avoid such troubles that no image data is inserted into the print range or part 

of image data is cut off.  

- Before start-up, specify the PC's default printer as the "Brother GTX pro" or the "Brother GTX pro FileOutput".  

- Use the "Brother GTX pro FileOutput" printer driver to output a file, then display and check the print preview. 

 For an image created in CMYK color mode, load the image into Photoshop, select [Image] > [Mode] in the menu bar, and change 

the color to the RGB color (sRGB). In order to edit an image, load the image into the Photoshop, edit it in the form of bitmap data, 

or edit it by means of the image quality improvement of printer driver (☞"5-4-9. Set up the image quality >>P.103"). 

 For this printer, it is recommended to use Illustrator CC2020/CC2019. The display screen is described assuming Illustrator 

CC2020. 
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Color setting 

(1) In the menu bar, select [Edit] > [Color Settings]. 

(2) Click on the [More Options]. 

(3) Ensure selection of the settings as mentioned below, and click [OK]. 

 [Settings]: [Custom] 
[Working Spaces] 

 [RGB]: [sRGB IEC61966-2.1] 
[Color Management Policies] 

 [RGB]: [Convert to Working Space] 

 [CMYK]: [Convert to Working Space] 

 [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes. 

 [Missing profiles]: Mark the [Ask When Opening] checkbox. 
[Conversion Options] 

 [Engine]: [Adobe(ACE)] 

 [Intent]: [Relative Colorimetric] 
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Open a new file 

(1) Set up a new document as follows: 

 [Width]: 14.0 in. (355.6 mm) 

 [Height]: 16.0 in. (406.4 mm) 

 [Orientation]: Portrait 

 [Color Mode]: [RGB] 

<TIPS> 

 Set the width and height to the size of platen to be used. (☞5-4-1. For other applications: Selection of platen size >>P.127) 

The above size is the standard 14X16 platen size.  
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Create print data (ARXP file) 

Save the image data and print settings as a set of print data in ARXP file format. 

The following will be made available if the print data is converted into an ARXP file: 

 Image data and print settings can be put together and stored. 

 Without connecting to a PC, the printing can be performed directly from a USB flash memory. 

<TIPS> 

 Image editing is unavailable for any ARXP file. As such, save your image data for an editing purpose in advance. 

 For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file] 

command. Be sure to use the printer driver "Brother GTX pro FileOutput". 

 For details of directly sending data to the Printer from an application☞"6-6-2. Sending print data from applications >>P.155". 

(1) In the menu bar, select [File] > [Print] > [Color Management]. 

(2) Make the settings as follows: 

 [Document Profile]: [sRGB IEC61966-2.1] 

 [Color Handling]: [Let Illustrator determine colors] 

 [Printer Profile]: [sRGB IEC61966-2.1] 

 [Rendering Intent]: [Relative Colorimetric] 
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(3) From [Printer], select "Brother GTX pro FileOutput" for file output. 

<TIPS> 

 If [Printer] is set to "Brother GTX pro ", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file. 

(4) On the [Advanced], make your settings for the printer driver.☞ "5-4. Set up the printer driver >>P.89". 

<CAUTION> 

 For Adobe Illustrator, set the platen size for the paper size in the Print dialog box in the application. The size or placement of 

the image may not be set correctly if you make settings in the Print Settings dialog. 

(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save]. 

<TIPS> 

 There may be cases where this saving process takes several minutes. 

 

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARXP file to your PC. 
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Using Useful Tools 

(1) Save the color pallet file for Illustrator, "GT_Colors_T.ase", on your PC, following the instructions on screen. 

(2) In the menu bar, select [Window] > [Swatches]. 

(3) Click on the , and select [Open Swatch Library] from the submenu. 

(4) Select [Other Library]. 

 

 

(5) On the [Open] screen, select the file having such filename as "GT_Colors_T.ase". 

<TIPS> 

 Unlike the Photoshop or CorelDRAW, this Swatch needs to be selected each time a file is opened.  

However, you can fix the Swatch library in the following method to display the screen automatically whenever you start the 

application if you are using Illustrator CC.  

Click  on the top right corner of the Swatch library and select [Fix] from the submenu. 
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5-4.  Set up the printer driver 

 

<TIPS> 

 The GTX pro printer driver treats RGB=(255) as "Transparent color" and does not eject the ink. For such an image that you wish 

to print out in pure white color with white ink, make such a setting as RGB=(254). 

 For the color replacement method, refer to a relevant page or help menu of each application software .☞"5-3. Using other 

applications >>P.70". 

 

(1) By following the printing procedures of each application software, open the print setup dialog box of the printer 

driver. 
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(2) In the dialog box for setting the printer driver, configure required settings. 

If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be 

configured. 

<TIPS> 

 Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary. 

 The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse 

the help feature. 

 For the detailed description of setup items, refer to each chapter mentioned below. 

 

(3) After your settings are completed, click [OK]. 

<TIPS> 

 You can refer to each value you have set up here by opening an ARXP file from the "GTX pro File Viewer". 
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5-4-1.  Select the platen size 

From the pull-down menu of [Platen Size:], select a platen size for print area. 

<TIPS> 

 The platen size is equivalent to the paper size. 

 

Setup item Platen to be used Size 

[16X21] 16X21 platen 16.0 in. x 21.0 in. (406.4 mm x 533.4 mm)

[16X18] 16X18 platen 16.0 in. x 18.0 in. (406.4 mm x 457.2 mm)

[14X16] 14X16 platen 14.0 in. x 16.0 in. (355.6 mm x 406.4 mm)

[10X12] 10X12 platen 10.0 in. x 12.0 in. (254.0 mm x 304.8 mm)

[7X8] 7X8 platen 7.0 in. x 8.0 in. (177.8 mm x 203.2 mm) 
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5-4-2.  Select the ink type 

From the [Select Ink:] option, select a combination of inks to be used. 

 

Setup item Description 

[Color+White Ink] This option enables a color image to be printed out on the mask layer of white ink. 

[White Ink Only] This option enables the white ink only to be used for printing out a monochrome image. 

[Color Ink Only] This option enables a color image to be printed out on a white background or lighter and 

pale color background. 

[Black Ink Only] This option enables the black ink only to be used for printing out monochrome image. 
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5-4-3.  Select the mode 

If you set [Mode:] to [Eco-Mode], the white ink volume serving as the background is automatically adjusted to reduce the 

overall ink consumption.  

<TIPS> 

 The luminance on the finished print may be slightly reduced depending on the color.  
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5-4-4.  Set up the white ink 

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], the setup items for [White Ink Settings:] will 

appear. 

Adjust the white ink volume separately in the [Highlight:] (visible white ink volume) and in the [Mask:] (white ink volume to 

cover the background color). 

Also, set the white ink time in the [Fast White Print Mode], [2 Layer White], and [White/Color Pause]. 
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Highlight 

This enables you to select whiteness (thickness) of RGB=254 in such nine levels as [1] to [13]. When you increase this 

value, the White ink volume will increase. You can specify [10] to [13] only if [2 Layer White] is enabled. 

Highlight setpoints Ink volume 

[1] White ink volume 200% 

[2] White ink volume 250% 

[3] White ink volume 300% 

[4] White ink volume 350% 

[5] White ink volume 400% 

[6] White ink volume 450% 

[7] White ink volume 500% 

[8] White ink volume 550% 

[9] White ink volume 600% 

[10] White ink volume 650% 

[11] White ink volume 700% 

[12] White ink volume 750% 

[13] White ink volume 800% 

 

<TIPS> 

 Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an 

appropriate highlight setting value before creating print data. Perform a highlight check pattern print and select an appropriate 

setting value.☞"5-5-6. Print out of highlight check pattern/mask check pattern >>P.110". 

 Depending on the settings of [Highlight:] and [Color Multiple Pass Printing], the [Print Time:] and [Whiteness:] will change 

accordingly. 

 [Print Time:] will be set to [X1] if the setup value of [Highlight:] is [5] and [Color Multiple Pass Printing] is turned OFF. With this [X1] 

serving as a reference value, how many times relates to how long the print time will take when printing. 

 Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink 

consumption. 

 

Mask 

This enables you to select the volume of white ink which is used as background color for color inks in such five levels as 

[1] to [5]. 

Setup value Description 

[1] or [2] These setup values are suitable for such lighter and pale background colors as pale pink, 

ash and cream. 

[3] This is the default value. 

This value will reproduce the most smooth white-gray-black gradation. 

[4] This value is suitable for vivid background color, e.g. red, purple, green, etc. It also covers 

the strong background colors. 

[5] This value enables the printing with the largest amount of white ink under all colors except 

darker color areas. 

 

<TIPS> 

 Perform a mask check pattern print and select an appropriate setting value. ☞"5-5-6. Print out of highlight check pattern/mask 

check pattern >>P.110" 
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Fast White Print Mode 

This option allows high speed printing in the white ink use mode. This does not change the ink amount or concentration. 

Turn it off if remarkable horizontal stripes are seen. 

<TIPS> 

 This setting menu will be enabled only if you have selected [Color+White Ink] in the [Select Ink:] settings. 

 Selecting [White Ink Only] from [Select Ink:] forcibly switches the printer to the high speed mode. 

 

2 Layer White 

You can make highlight settings at a level of [1] to [13] when 2 Layer White is enabled. 

Set the time from the start of printing the first white ink layer to the start of printing the second white ink layer. 

If you set a time shorter than the time it takes to print the first layer, the additional waiting time will be set to 0 seconds. 

<TIPS> 

 This setting menu will be enabled only if you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:] settings. 

 

White / Color Pause 

Set the time from the start of printing the previous white ink layer to the start of printing the color ink layer. 

If you set a time shorter than the time it takes to print the previous white ink layer, the additional waiting time will be set to 

0 seconds. 

<TIPS> 

 This setting menu will be enabled only if you have selected [Color+White Ink] in the [Select Ink:] settings. 

 Check this checkbox to activate it when you print a tiny image. 

 Tiny images may become black when printed. When that occurs, print a white layer first and wait for a while (waiting time), to 

print the color layers. 
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5-4-5.  Specify whether or not to use the background black color 

If you have selected [Color+White Ink] in the [Select Ink:], the setup items of [Use background black color (for black 

T-shirts only)] will appear. 

In the event that you wish to print a black T-shirt making use of the T-shirt's background black color, mark the [Use 

background black color (for black T-shirts only)] checkbox. 
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5-4-6.  Specify whether or not to perform Multiple Pass Printing 

If you have selected one of the [Color+White Ink], [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items 

for [Color Multiple Pass Printing] will appear. 

In cases where small and horizontal stripes are highly noticeable in the print result, mark the [Color Multiple Pass 

Printing] checkbox. 

<TIPS> 

 Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of inks to be consumed will remain unchanged. 

 When the [Color Multiple Pass Printing] checkbox is marked, it takes a longer time for the print time to be completed. For typical 

print time, refer to [Print Time:]. 
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5-4-7.  Set up the color ink 

If you have selected [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items of [Color Ink Settings:] will 

appear.  

In the [Color Ink Settings:] window, you can make your setting from the [Ink Volume:] or [Double Printing:] option. 

 

Ink volume 

This enables you to select the ink volume in such ten levels as [1] to [10]. 

 

Setup value Description 

[10] This is the default value. 

This value corresponds to 100%-cotton fabrics as well as for blended yarn fabrics (hemp 

50%/polyester 50% or cotton 50%/polyester 50%). 

[9] to [7] These values correspond to a thinner T-shirt, thick towel, and cotton products woven with 

twill fabrics. 

[6] to [4] These values correspond to thin and plain fabrics as well as for blended yarn fabrics that 

consist of cotton, polyester and polyurethane. 

[3] to [1] These values correspond to polyester jerseys and synthetic fabrics that have no water 

absorbency. 

 

<TIPS> 

 When you print other clothes than a thick T-shirt, check on the actual blurring first, then adjust a value in the [Ink Volume:] option. 
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Double Printing 

Performing the print cycle two times separately will make the printed color stand out more. 

 

Setup value Description 

[0] No separate processes 

[1] Separate processes (wait time between the 1st and 2nd print cycle) 

[2] Separate processes (longer wait time than the case with setting [1] between the 1st and 

2nd print cycle) 

[3] Separate processes (longer wait time than the case with setting [2] between the 1st and 

2nd print cycle) 

 

<TIPS> 

 For the options [1] to [3], the platen will reciprocate two times. 

 The higher the setpoint is, the longer the print time will be. 

 

 

5-4-8.  Set up the white ink 

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], this setting menu will be enabled. 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [White Ink Settings] 

appear. 

In the [White Ink Settings], you can make settings for [Transparent Color:], [Tolerance:], [Minimum Whiteness :],and  

[Choke Width:]. 
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Transparent color 

With this option, specify a color which is treated as a transparent color without using any color during the printing 

process. If you want to specify other colors excluding the RGB=255 as "Transparent color", perform the following 

procedures to make your setting. 

<TIPS> 

 The RGB=255 is treated as a "Transparent color" (non-printing color). 

 You would be better off making [Use background black color (for black T-shirts only)] OFF to produce better colors.  

 

(1) Click the [Transparent Color:] checkbox. 

Then, the pull-down menu for color selection becomes active. 

(2) In the pull-down menu, select a color which serves as a background color of T-shirt, or click on the [Custom...] to 

specify a RGB value. 

<TIPS> 

 This custom color you have specified is valid only for one color which is specified immediately before. This color cannot be 

saved in the list. 

 

 

Tolerance 

Specify the gradation range (RGB values) to smoothly connect the zone between "Unprinted color" and "Printed color" 

to be gradually changed in tone. 

<TIPS> 

 If this value is increased, the gradation range in which the mask white is generated from a state in which no mask white exists will 

increase. 

 The gradation's image quality depends on image data. For this reason, it is advisable to perform a test printing beforehand. 
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Minimum white ink volume 

When printing with [Color+White Ink], the volume of background white color ink for dark or black color ink can be 

controlled. 

When printing with [Color+White Ink], you can increase the amount of the white ink volume used as the base in a dark 

area by specifying a larger value. 

Selecting [Special] allows you to select a value of [3] or higher. 

<TIPS> 

 Larger the value, the more likely that blurring occurs.  

 

White Ink Choke Width 

This enables you to select the white ink choke width in such ten levels as [1] to [10]. When you increase this value, the 

choke width increases. By decreasing the print range of white ink, the white ink will be prevented from extending off from 

under the color inks. 

<TIPS> 

 Check the original image if white lines and/or dots are seen around the image, this may be caused by "Anti-alias" bitmap. 

 There are instances in which fine lines (characters or photographs) will disappear if this level is increased. For this reason, it is 

advisable to perform a test printing beforehand. 
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5-4-9.  Set up the image quality 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear. 

In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:]. 

Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application 

software. 

 

Setup item Description 

[Saturation:] The more vivid the color is, the higher its value. 

[Brightness:] The brighter the color is, the higher its value. 

[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value 

increases. 

 

<TIPS> 

 If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear. 

 For this reason, it is advisable to perform a test printing beforehand when you specify a higher value. 
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5-4-10.  Set up the color balance 

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear. 

In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], and [Black:]. 

You can adjust the color in 11 gradations, -5 to +5. 

<TIPS> 

 If you select [Black Ink Only] for ink selection, you can adjust [Black:] only.  

 

Setup item Description 

[Cyan:] Adjust the cyan ink volume.  

If you increase its value, the color becomes light bluish overall. If you decrease its value, 

the color becomes reddish overall. 

[Magenta:] Adjust the magenta ink volume.  

If you increase its value, the color becomes reddish-purple overall. If you decrease its 

value, the color becomes greenish overall. 

[Yellow:] Adjust the yellow ink volume.  

If you increase its value, the color becomes yellowish overall. If you decrease its value, 

the color becomes bluish overall. 

[Black:] Adjust the black ink volume.  

If you increase its value, the color becomes blackish overall. If you decrease its value, the 

color becomes whitish overall. 

 

 

 



 

105 

Creating print data

5-4-11.  Specify the print direction 

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional 

Printing]. 

 

<TIPS> 

 What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print 

direction specified on the printer side is set to [Auto]. 

 Print time will be doubled. 
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5-5.  Using Useful Tools 

Useful tools and print data are provided for adjusting colors or searching for an appropriate print setting. 

The "Useful Tools" will be installed onto the subdirectory under the "Brother GTX pro Tools" of your PC. 

For the details of each tool, please refer to the chapters described later. 

 

 

5-5-1.  Use the color palette 

The different color palettes are available for each software application as follows: 

 Adobe Photoshop/Illustrator: “GT_Colors_T.ase” 

 CorelDRAW: “GT_Colors.xml" and "GT_Tshirts.xml" 

For more information, refer to a relevant page or help menu of each application software (☞"5-3. Using other 

applications >>P.70"). 

<TIPS> 

 When using the printer driver by default, use one of them as a color sample to check color reproduction and create/edit the 

image data. (Because CorelDRAW cannot contain identical color in the same palette, the color palette is divided into two files.) 

 

5-5-2.  Replace RGB=255 with RGB=254 (for Photoshop only) 

For Photoshop, use this to change RGB=255 to RGB=254. 

(1) From the "Useful Tools", click "SolidWhite.atn", and follow the on-screen instructions to save the file on your PC. 

(2) In the menu bar of Photoshop, select [Window] > [Action file].  

(3) Click on the  to open the submenu.  

(4) From the [Load Actions], select "SolidWhite.atn" saved on your PC. 

<TIPS> 

 For information on using action files, refer to the Help feature that Photoshop is provided with. 

 "SolidWhite.atn" can be used only when the [Color mode] is set to [8 bit] of [RGB Color]. 
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5-5-3.  Check the color sample 

Use when checking the color sample. 

Please use this color chart as a color sample like the one that is commonly provided by an ink maker, for the print data 

(ARXP file) you created using your desired printer driver setting. 

<TIPS> 

 Make use of this color chart when you perform the printing after changing the settings of the printer driver. 

 

(1) From the "Useful Tools", click a required file name to download the data. The following files are provided as color 

samples. 

 GT_Blues.pdf 

 GT_Greens.pdf 

 GT_Oranges.pdf 

 GT_Reds.pdf 

 GT_ColorChart.pdf 

(2) Configure the printer driver and create print data. 

<TIPS> 

 For details of the printer driver's setting procedures, refer to "5-4. Set up the printer driver >>P.89". 

 For information on creating print data, refer to "5-3. Using other applications >>P.70". 

(3) Send the created print data to the printer and perform printing.☞ "6. Basic printing procedures >>P.113". 

<TIPS> 

 Check the print result and adjust the printer driver's settings. 
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5-5-4.  Print a grid pattern on the platen sheet 

You can print a grid pattern onto a new platen sheet. 

X0163 

(1) From the "Useful Tools", open such an ARXP file (for example, Grid14x16.arxp) that has a grid size suitable to the 

platen size. 

(2) Send the print data of grid pattern to the printer. 

(3) Without putting a T-shirt in place, print the grid pattern directly onto the platen sheet. 

<TIPS> 

 After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink. 

 

Platen sheet 

Platen 

Grid
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5-5-5.  Adjust the ink volume 

Set an optimum setting for [Ink Volume:] of the printer driver. 

Download the data from "Useful Tools" and perform printing to check the blurring beforehand (☞"6. Basic printing 

procedures >>P.113"). 

<TIPS> 

 Appropriate ink volume setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an 

appropriate ink volume setting value before creating print data. 

 There are four types of ink volume printing data. Select the ink volume print data to match the [Double Printing:] setting for the 

printer driver. 

(1) Select the desired file from "Ink Volume SinglePrint.arxp", "Ink Volume DoublePrint1.arxp", "Ink Volume 

DoublePrint2.arxp", and "Ink Volume DoublePrint3.arxp" from the "Useful Tools" to download data.   

(2) Send the data to the printer and perform printing.  

(3) Check the print result and adjust the value for [Ink Volume:] of the printer driver. 
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5-5-6.  Print out of highlight check pattern/mask check pattern 

This is one of the print data files for selecting the ideal setting for [Highlight:] of the printer driver. 

Download the data from "Useful Tools" and print the highlight check pattern for checking whiteness, background hiding 

level, and blurring beforehand. 

<TIPS> 

 Please print on a pretreated T-shirt. ☞"6. Basic printing procedures >>P.113". 

 Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an 

appropriate highlight setting value before creating print data. 

(1) From the "Useful Tools", click "Highlight-Mask Check at MW1.zip" or "Highlight-Mask Check at MW2.zip" to 

download data.  

<TIPS> 

 The file you should select differs depending on whether "Minimum Whiteness:" is set to [1] or [2].  

 Check the number at the end of the file name before downloading the file. 

(2) Unzip the file and the following print data will be displayed. 

 "HighlightCheckPattern"  

 "MaskCheckPattern" at each highlight  

(3) Print "HighlightCheckPattern" and select the optimum highlight setting.  

(4) Print "MaskCheckPattern" for the optimum highlight setting and select the optimum mask setting.  

(5) Check the print result and adjust the values for [Highlight:] and [Mask:] of the printer driver. 
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5-5-7.  Check the ejection timing 

Check whether or not the ejection timing is correct. 

(1) From the "Useful Tools", click "FIRING CHK COLOR.arxp" or "FIRING CHK WHITE.arxp" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the firing timing has been set correctly. 

 
5-5-8.  Check the platen feed setting 

Check whether or not the platen feed adjustment is appropriate. 

(1) From the "Useful Tools", click "FEEDING PATTERN(1).arxp" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the platen-rolling adjustment has been set correctly. 
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5-5-9.  Check the print position 

Check the alignment of the print position on the white side with the print position on the color side. 

(1) From the "Useful Tools", click "ALIGN CHK.arxp" to download data. 

(2) Send the data to the printer and perform printing. 

(3) Check the print result to make sure the print position on the white side has been aligned with the print position on 

the color side correctly. 
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WARNING 

 

 

 
 

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and 

contact the place of purchase or a qualified technician. If you continue to use the printer while there is a 

foreign object inside, it may result in fire or electric shocks or problems with correct operation. 

 

 

 

 

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or 

problems with correct operation. 

If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact 

the place of purchase or a qualified technician. 

 

 

 

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or 

electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power 

cord, and contact the place of purchase or a qualified technician. 

 
Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in 

injuries. 

Turn off the power when you approach the fan. 
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CAUTION 

 
This printer should only be used by operators who are appropriately trained in its safe operation. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand 

may get caught between the platen and an object, which may result in injury. 

 
Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and 

the covers, it may be injured. 

 
Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may 

touch against moving parts and this may result in injury. 

 
Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation. 

In case of contact with eyes, do not rub but immediately rinse the eyes with water. 

 
Do not disassemble the ink cartridge. 

 
Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They 

may cause diarrhea or vomiting. 

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution, 

pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately 

rinse the eyes with water. 

Keep the liquids out of the reach of children. 

 
When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator, 

sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles) 

designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

 
When a problem occurs with the operation of the printer, contact the place of purchase or a qualified 

technician. 

 

IMPORTANT 

 
Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be 

hit and damaged. 
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6-1.  Basic printing process flow 

What are described below are the basic work flows before the start and after the completion of print process. 

 

Fixation of ink 

Removing printed 
matter  

from platen 

Remove the print medium from the platen. 

Refer to "6-9. Removing printed matter from platen >>P.165". 

 

 

Fixate the ink onto the print medium. 

Refer to "6-10. Fixation of ink >>P.166". 

 

 

Printing 

Start the print operation. 

Refer to "6-7. Executing a printing job >>P.160". 

 

 

Sending/Loading  
Print data 

Placing print medium 
in position 

Platen adjustment 

Pretreatment for print 
medium 

To fixate the white ink onto a T-shirt, apply the pretreatment to it beforehand. 

If you are not using white ink, you do not need to pretreat print medium. 

Refer to "6-3. Pretreating process for print medium >>P.121". 

 

Replace the currently used platen with another one that suits the print medium. 

After the platen replacement is completed, adjust the platen's height. 

Refer to "6-4. Platen adjustment >>P.134". 

 

Put a print medium on the platen. 

Refer to "6-5. Placing print medium in position >>P.148". 

 

 

Send or load print data to the printer. 

Refer to "6-6. Sending/Loading Print Data >>P.151". 

 

 

Tasks to be performed 
before starting print 

operation 

Before starting printing, perform check and preparation tasks on the printer. 

Refer to "6-2. Tasks to be performed before starting print operation >>P.116". 
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6-2.  Tasks to be performed before starting print operation 

6-2-1.  Confirmation and disposal of waste ink 

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or higher 

level, discard the ink. 

(1) Check on the waste ink tank, and discard the waste ink. 

In an area under the other end of the waste ink tube (when removed) from the waste ink tank, place a receiving tray or the like so 

that the waste ink spilled from the tube will not be discharged onto the floor, etc. 

<NOTE> 

 Dispose of the waste ink properly as water-based waste fluid in accordance with applicable laws and ordinances. 

X0315 

X0316 

(2) Return the waste ink tank to its original state, and insert the waste ink tube into the tank. 

<IMPORTANT> 

 The waste ink tube should be cut diagonally. If the tip of the waste ink tube is immersed in the liquid, it will prevent the 

smooth flow of the waste ink, to disable the ink suction operation of the head cleaning function. Otherwise, waste fluid may 

flow reversely, causing the waste ink to spill contaminating the floor. 

 Avoid placing the waste ink tube horizontally as much as possible, and be sure not to let it bend. 

Otherwise the waste ink may have difficulty flowing through the tube. 

Waste ink tank 

Waste ink tube

Waste ink tank 

Receiving tray
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6-2-2.  Confirmation and refilling of cleaning solution 

Check to see if the amount of cleaning solution is kept at a proper liquid level in the cleaning liquid tank, and refill the 

tank with the solution when its amount is below the proper level. 

<TIPS> 

 Also, refill the tank with the solution when a warning message appears on the operation panel screen or in the warning message 

window when the cleaning liquid tank is not pulled out. 

(1) Pull out the cleaning liquid tank from the side of the printer. 

(2) Open its lid and refill it with the cleaning solution up to the "FULL" line. 

<IMPORTANT> 

 Be sure not to put the cleaning solution into the tank above the "FULL" line. 

FULL

LOW

X0044 

(3) Close the lid and slowly place the cleaning liquid tank into the printer. 

Cleaning solution 

Cleaning liquid tank
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6-2-3.  Daily agitation of the white ink 

Perform the procedures shown below if a white ink cartridge stirring message is displayed before starting operation. 

 

(1) Take out the white ink cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0317 

(2) Shake the cartridge 100 times side by side to stir the white ink. 

<IMPORTANT> 

 The white ink cartridge should be held horizontally when shaking it. 

 Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch. 

<NOTE> 

 Wear the provided gloves when performing this task. 

 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the 

edge of the ink pouch slightly winded, to make the ink easier to stir. 

X0194 

White Ink Cartridge

White Ink Cartridge 

Shake 100 times (for approx. 50 seconds) 

(Swing distance should be approx. 2 in. (5 cm). 

Increase the swing distance when the 

remaining ink level becomes low.) 

Ink pouch

Edge of the rib

Remaining ink volume should 

be approx. 5.9 in. (15 cm) 
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(3) Open the lid of the cartridge and place the ink pouch in its correct position. 

<IMPORTANT> 

 Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow 

into the wound section of the pouch when stirred, which can cause improper winding of the pouch. 

 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge 

downward and open the lid. 

 When setting the ink pouch, avoid unevenness or wrinkles on the pouch. 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

<NOTE> 

 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid. 

(a)

X0182 

X0078 

X0142 

Place the pouch in a straight alignment with the cartridge

Latch Lid 

No wrinkles
Ink pouch

Not sagged

LidCartridge
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(4) Close the lid, and put the white ink cartridge in position inside the printer. 

<IMPORTANT> 

 W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause the 

printer malfunction. 

 When setting the cartridge, do not shake the cartridge with the ink pouch facing down with the aim of facilitating the winding 

of the pouch. Doing so will cause wrinkles, and the proper winding of the ink pouch will not be possible. 

X0283 

(5) Repeat the same process to shake the other white ink cartridge to stir up the ink. 

(6) On the operation panel, press . 

Then, the white ink refilling will be performed automatically. 

The following screen will be displayed without white ink refilling in the case of insufficient agitation. 

After performing steps (1) to (5), press again. 

 

(7) When you are finished replacing the white ink, press  in the operation panel to print the nozzle check pattern. 

☞"7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.199". 
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6-3.  Pretreating process for print medium 
 

To fixate the white ink onto the surface of fabric of a T-shirt, apply the pretreatment to it beforehand. If you are not using 

white ink, you do not need to pretreat print medium. 

Workflow of pretreating process 

Step Item Detailed description 

1 Dilution of pretreatment 
Put the pretreatment into a polypropylene container or the like, and dilute it with 

pure water. 

2 
Application of diluted 

pretreatment  
By means of a spray or roller, apply the diluted pretreatment onto the print medium.

3 Fixation of pretreatment 
Fixate the pretreatment by using the heat press to apply heat and pressure onto 

the print medium. 

 

 

6-3-1.  Provisions for pretreatment 

Items to be prepared 

Two types of application means are available for the pretreatment―roller and spray. 

With reference to the table below, make what you need available in advance. 

 

Items to be prepared For roller coating For spray coating 

Pretreatment ○ ○ 

Pure water ○ ○ 

Pretreatment roller ○ – 

Handle (handgrip of roller) ○ – 

Tray ○ – 

Agent-coating table △ – 

Weighing instrument ○ ○ 

Spray – ○ 

Heat press ○ ○ 

Peel-off sheet △ △ 

Silicone foam (of open-cell structure) △ △ 

Adhesive roller △ △ 

 

 Pretreatment 

It is the white liquid that is needed for pretreating process for printing with white ink. If a print medium is not 

coated with this agent, no color development of white ink takes place, and the whiteness becomes insufficient. 

Also, no color will be produced from the color inks that are applied onto the white ink. In order to apply the 

pretreatment onto a T-shirt, use a spray or roller, and use the heat press to fixate it. 

<CAUTION> 

 Be sure to wear a pair of plastic gloves, a mask and protective glasses during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

 

 Pure water 

It refers to distilled water, purified water, etc. which is used to dilute the pretreatment with it. 

 

○: What you need 

: Useful items, if any 

–: Not required 

http://sds.brother.co.jp/sdsapp/index.html
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 Pretreatment roller (option) 

This is used to apply the pretreatment onto a T-shirt. It is advisable to use such a handgrip for the roller that is 

resistant to rust formation. 

<NOTE> 

 Separately provide a tray (container for dilution), handle (handgrip for roller), agent-coating table and weighing instrument 

for amount of coating. 

 

 Spray (commercially available item) 

This is used to apply the pretreatment onto a T-shirt. Use a spray (preferably of an electrically-operated type) 

that can emit fine spray. As compared with a roller, a spray allows for easy and even coating and reduces 

non-uniform coating, while it requires a special space for using it. 

In addition to a spray, a pretreatment application device (commercial product) is available that can apply the 

pretreatment onto a T-shirt automatically. As required, make them available for use separately. 

<CAUTION> 

 Fully take care of the air ventilation when you work on operation that generates mist such as spray application. 

 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

<IMPORTANT> 

 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer. 

Otherwise, it may cause failure of print heads. 

 

 Heat press 

It must deliver the performance through which the print range of the platen can to be covered and 180°C 

(356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be sure to use the heat press, 

but not an oven, to smoothen the surface. 

 

 Peel-off sheet 

When using the heat press, place this sheet on a T-shirt so that neither inks nor pretreatment can be attached to 

the press surface of the heat press. As a peel-off sheet, use a silicone-coated paper or a fluororesin sheet. 

There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used at the ink 

fixation stage. There is a tendency to bring the print result to an almost bright finish if a fluororesin sheet is used 

at the ink fixation stage. 

 

 Silicone foam (of open-cell structure) 

It is the foamed mattress which is made of silicone that resists heat. When fixating the inks or pretreatment by 

means of the heat press, use this foam to ventilate steam with ease. 

 

 Adhesive roller 

Use these to remove lint from a T-shirt or debris from its surface. 

 

http://sds.brother.co.jp/sdsapp/index.html
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 T-shirt (printing medium) 

100%-cotton fabric or polyester blended yarn fabric (cotton 50% or more) 

<TIPS> 

 Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even 

if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on 

it beforehand. 

 Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water. 

 Perform a printing test beforehand. Then, the following phenomena may occur: 

- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed. 

- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different 

color. 

- It is likely that a textile may become yellowish in color after the pretreatment is fixated. 
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6-3-2.  Dilution of pretreatment 

Be sure to use the pretreatment after diluting it with pure water. 

<CAUTION> 

 Be sure to wear a pair of plastic gloves and protective glasses during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

Dilution ratio 

Use within the ratio range of x3 (Pretreatment:Pure water=1:2) (Volume ratio). 

 

Dilution method 

<TIPS> 

 The figure below is based on the pretreatment (20 kg (44 lb)). When using the pretreatment (5 kg (11 lb)), remove the cap and 

pour the agent into the container, and dilute it with pure water, referring to step (4) and the subsequent steps. Dilution ratio is the 

same. 

(1) Unpack the pretreatment container from the shipping carton by cutting off the perforated paper along the perforated 

tear-off line to open the carton. 

X0079 

(2) Remove the cap, and place the cap in position. 

X0080 

Pretreatment 

Faucet

Cap 

Pretreatment 

http://sds.brother.co.jp/sdsapp/index.html
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(3) Orient the pour spout of faucet in the position as shown in the figure below. 

X0081 

 

(4) Lean the entire shipping carton of pretreatment toward a container for dilution to pour the agent into the container, 

and dilute it with pure water. 

<IMPORTANT> 

 Use with the dilution rate of x3 (Pretreatment:Pure water=1:2) (Volume ratio). 

 Close the cap of the container for dilution, and shake it sufficiently to provide equal concentration. 

X0082 

(5) To provide safekeeping for the pretreatment, close the faucet, place the pretreatment with the faucet part facing 

upward, and store the entire carton in a safe place. 

Pretreatment 

Faucet 

Pretreatment 

Pure water 

Container for dilution 
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6-3-3.  Application of pretreatment 

In order for the pretreated portions to be printed with inks, apply the pretreatment evenly to a wider area than the print 

range. 

<CAUTION> 

 Fully take care of the air ventilation when you work on operation that generates mist such as spray application. 

 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

<IMPORTANT> 

 Some T-shirts may leave distinct imprints of the pretreatment after it is fixated. Wash away any imprint of the pretreatment with 

water, if any.  

Also, some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.  

When performing the printing for the first time, do that after applying the agent to an unnoticeable area on trial. 

 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer. 

Otherwise, it may cause failure of print heads. 

Reference guide for amount of coating of pretreatment 

Determine a coating area and amount of coating according to a platen size. When your coating area differs from what 

are shown in the table below, calculate the amount of coating based on the area ratio. 

<IMPORTANT> 

 Depending on the type of fabric, the print quality cannot be guaranteed with the amount of coating of pretreatment shown below. 

It is therefore necessary to conduct sufficient print tests and adjust the amount of coating. 

 If the amount of coating of pretreatment is too small, imprints of the pretreatment may become less noticeable after it is fixated, 

whereas color reproduction of the white ink and color inks on the white ink will deteriorate. 

 Meanwhile, if the amount of coating of pretreatment is too large, imprints of the pretreatment may become noticeable, the printed 

surface may be cracked or discoloring may occur after washing. 

 

Platen Size Amount of coating of pretreatment 

16 x 21 45 g (1.6 oz) 

16 x 18 39 g (1.4 oz) 

14 x 16 30 g (1.1 oz) 

10 x 12 16 g (0.6 oz) 

7 x 8 8 g (0.3 oz) 

Letter size/A4-size 15 g (0.5 oz) 

Pocket size 

(3.9 in. x 3.9 in. (10 cm x 10 cm)) 
3 g (0.1 oz) 

 

http://sds.brother.co.jp/sdsapp/index.html
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For coating with a spray (commercial product: preferably of an electrically-operated type) 

(1) Fill a spray with the diluted pretreatment. 

<TIPS> 

 Please use a spray (preferably of an electrically-operated type) that can emit fine spray. 

X0083 

(2) Put a T-shirt flatly on a flat surface or lean it back against wall, and apply the pretreatment evenly onto it. 

<CAUTION> 

 Fully take care of the air ventilation when you work on operation that generates mist such as spray application. 

 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

<IMPORTANT> 

 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer. 

Otherwise, it may cause failure of print heads. 

<TIPS> 

 Note that pretreatment will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate in the T-shirt. 

Remove the intermediate plate from the T-shirt before the pressing stage. 

 When you are still unaccustomed to the spray coating, perform it while measuring the amount of coating by means of a 

weighing instrument. 

X0084 
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For coating with a pretreatment roller (option) 

(1) Make a polypropylene tray or the like, handle (handgrip for roller), weighing instrument to measure the amount of 

coating and agent-coating table ready for use. 

<TIPS> 

 It is convenient for you to use an agent-coating table that can cover the print area, because it prevents the pretreatment 

from soaking into the underside of the area. 

X0086 

(2) Weigh a T-shirt before applying the pretreatment to it, so that you will be able to know how much of the agent you 

have applied to it later. 

X0087 

(3) Slide a T-shirt onto the agent-coating table, with its printing side facing upward. 

<TIPS> 

 Note that pretreatment agent will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate inside the 

T-shirt when there is not an agent-coating table. 

X0088 
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(4) Attach the pretreatment roller to the handle (handgrip of roller). 

<TIPS> 

 Use a commercially available handle provided with a roller that fits the pretreatment roller's inside diameter of 0.8 in. (21 

mm). 

X0089 

(5) Pour the diluted pretreatment into the tray, and dip the pretreatment roller in the agent so that it will be dampened 

with the agent. 

X0090 

(6) Rub the pretreatment roller well against the scrub board of the tray and squeeze a redundant agent out of it. 

X0091 
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(7) Move the pretreatment roller on the T-shirt in a longitudinal direction, and apply the agent evenly onto the print 

range. 

X0092 

(8) Move the pretreatment roller on the T-shirt in a lateral direction, and apply the agent evenly onto the print range. 

<TIPS> 

 Depending on a difference in the force applied by you to the pretreatment roller, the pretreatment may not be applied evenly 

to a T-shirt. Move the pretreatment roller repeatedly on each area to apply the agent evenly onto such area. 

 When there is any area (gap) that fails to be coated with the pretreatment or any other area that is found to be unevenly 

coated, dip the pretreatment roller in the agent again, and apply the agent evenly there. 

X0093 

(9) Weigh the T-shirt to check to see if the required amount of pretreatment has been applied to it. 

<TIPS> 

 For the amount of coating of pretreatment☞"6-3-3. Application of pretreatment >>P.126". 

 If the amount of coating is small, color reproduction of the white ink and color inks on the white ink will deteriorate. 

 Meanwhile, if the amount of coating is too large, it is likely that a T-shirt may harden, imprints of the pretreatment may 

become noticeable or washing fastness may get worse and so on after the pretreatment is fixated. 

X0094 
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Maintenance of pretreatment roller 

If you continue using the pretreatment roller under a state in which any fuzziness, yarn waste, dust, etc. remain attached 

to its surface, you may not provide a uniform coating. 

In such case, use a toothbrush or the like to brush off such fuzziness to remove it from the surface. 

<CAUTION> 

 Be sure to wear a pair of plastic gloves and protective glasses during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

<NOTE> 

 After the pretreatment roller is used, put it in a plastic bag or the like hermetically to prevent it from drying up, and keep it in a flat 

place in an upright position.  

Also, when it remains unused for two weeks or longer, wash it well with running water, and let it dry in a shaded area before using 

it again. 

X0095 

 

Toothbrush, etc.
Pretreatment roller 

http://sds.brother.co.jp/sdsapp/index.html
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6-3-4.  Fixation of pretreatment 

<CAUTION> 

 As the operation will generate mist, fully take care of the air ventilation. 

 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash 

during the work operation. 

 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.  

http://sds.brother.co.jp/sdsapp/index.html 

<TIPS> 

 Because the pretreatment will not work best if it is dried through oven-based drying or air drying, be sure to use the heat press. 

As the oven does not bind fuzziness, the agent may be applied unevenly on white print. 

 When you put a T-shirt on the heat press, set it so as to flatten the T-shirt's surface, place a peel-off sheet on the entire press 

area, and apply pressure. 

 Note that any area in which the pretreatment is fixated may cause its effect to deteriorate or could cause the agent to be coated 

there unevenly if such area gets wet once. 

 Do not touch the treated area with your hand after the pretreatment is fixated. 

 After the pretreatment is fixated, do not touch or place the T-shirts on top of each other. 

 Avoid leaving the pretreatment as it is in any highly humid areas. 

 If the agent is left unchecked for a long time, use the heat press to apply pressure to a T-shirt immediately before the printing in 

order to dry it well. 

Guidelines on fixation conditions of pretreatment 

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat 

press. Be sure to perform the fixation after checking on the temperature and fixation results beforehand. 

<TIPS> 

 Prior to and during a fixation process, check the heat press's temperature. If the fixation is performed continuously, the heat 

press's temperature will decrease, resulting in improper fixation of the pretreatment. In this case, the whiteness cannot be 

reproduced because the white ink soaks into the fabric of a T-shirt. 

 Such a pressure is required that is adequate enough to flatten the surface. As the fixation conditions differ by heat press, check 

the ink fixation result in advance and adjust the pressure. 

 If it is not dry enough after pressing for 35 seconds, extend the time while checking the dried condition of the pretreatment. 

 The following values should be regarded as guidelines only, for the optimum fixation conditions depend on the amount of coating 

of pretreatment. 

 

Temperature Time 

180°C (356°F) 35 seconds 

 

http://sds.brother.co.jp/sdsapp/index.html
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(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the pretreatment 

properly. 

<TIPS> 

 Water droplets are generated around the heat press to evaporate water content of the pretreatment by the heat of heat 

press. Keep your working space clean so that the surface to be coated with the agent will not get wet. 

 A peel-off sheet should be used if needed, depending on the heat press you use. 

X0096 

 

(2) Remove the T-shirt from the heat press so that the steamy heat will escape from it. 

X0097 
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6-4.  Platen adjustment 
 

Replace the currently used platen with another one that suits the medium to be printed. 

<TIPS> 

 In cases where such an optionally sized platen as 10X12 platen is used, ascertain that a proper "Platen size" has been selected 

in the printer driver's setting menu. ☞"5-4-1. Select the platen size >>P.91". 

 When using the 16X21 platen: ☞"6-4-3. Using the 16X21 platen >>P.146" 

 

6-4-1.  Replacing the currently used platen with another one 

(1) On the operation panel, press , and move the platen toward the front of the printer. 

X0164 

(2) Loosen the platen fixing lever by rotating it one to two turns. 

<TIPS> 

 Depending on the height of the platen, the platen fixing lever may strike against the platen, and prevent rotation. In that 

case, move the platen fixing lever in the direction (a), draw the edge of the platen fixing lever forward as shown in (b), then 

loosen it again. 

X0257 
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(3) Remove the platen moving it straight upwards by holding both ends of it. 

X0258 

 

(4) Put another platen to be used in position directly from above. 

X0259 

Platen 

Platen 
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(5) Tighten the platen fixing lever. 

X0260 

Platen fixing lever 
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6-4-2.  Platen height adjustment 

When constantly printing on thick material, the platen height can be lowered by up to 1.2 in. (30 mm) by adjusting the 

platen bearing and collars. 

<TIPS> 

 Please refer to the table below for the platen's height adjustment range (height A, measured from the platen height adjustment 

lever; with the standard parts installed). 

 Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers. 

 When using the 16X21 platen, it can be used only at the lowest position. Remove all the collars before mounting the platen. Also 

note that the height adjustment range of the 16X21 platen is 0.4 in. (10 mm) at maximum. 

 When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen bearing. 

X0102 

Collars

SpacerCollars

0 to 0.4 in.  

(0 to 10 mm) 

0.4 to 0.8 in. 

(10 to 20 mm)
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Collars
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Case of 16X21 platen 

X0165  
 

As an example, the cases where the platen's height is set to the lowest position from the standard position and to the 

middle position from the lowest position are described below. 

From the standard to the lowest position 

(1) Detach the platen. 

(2) Remove the platen fixing lever, platen height adjustment lever, and collars. 

The number of collars and the height adjustment range are as follows: 

Position Height No. of collars

Highest position 

(standard) 
0 to 10 mm 2 

Middle position 10 to 20 mm 1 

Lowest position 20 to 30 mm None 

Case of 16×21 platen 

  No. of collars

Lowest position 0 to 10 mm None 

 

<TIPS> 

 Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.  

X0261 
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(3) Attach the platen height adjustment lever to the platen bearing. 

<CAUTION> 

 Attach the platen height adjustment lever to the position as illustrated in the figure below. The lever installed in 

the wrong position will interfere with the stopper when the platen is attached. 

<TIPS> 

 When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen 

bearing. 

X0262 

Platen height adjustment 
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Platen bearing 
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(4) Check that the end position of the platen height adjustment lever is aligned with that of the platen bearing. 

X0208 

 

(5) Loosen the knob while holding the platen height adjustment lever and lower the platen bearing and the height 

control lever. 

X0263 
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(6) Use the platen fixing lever to secure the platen temporarily. 

The number of collars and the position of screw hole for the platen bearing differ by the height of the platen 

adjusted. 

<TIPS> 

 If you are setting the platen's height to the lowest position, remove all the collars and fix the platen bearing at 

its highest screw hole temporarily. 

 If you are setting the platen's height to the middle position, attach one collar and fix the platen bearing at its 

middle screw hole temporarily. 

 If you are setting the platen's height to the highest position, attach two collars and fix the platen bearing at its 

lowest screw hole temporarily. 

X0264 

 

(7) Tighten the knob to secure the platen bearing in place. 

<TIPS> 

 Align the center of platen fixing lever with the position as illustrated in the figure below, and secure the platen 

bearing in place. 

X0265 

 

 

(8) Insert the platen to be used and tighten the platen fixing lever. 
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From the lowest position to the middle position 

(1) Detach the platen. 

(2) Remove the platen fixing lever, platen height adjustment lever. 

The number of collars and the height adjustment range are as follows: 

Position Height No. of collars

Highest position 

(standard) 
0 to 10 mm 2 

Middle position 10 to 20 mm 1 

Lowest position 20 to 30 mm None 

Case of 16×21 platen 

Position Height No. of collars

Lowest position 0 to 10 mm None 

 

<TIPS> 

 Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers. 

X0266 

 

(3) Loosen the knob while holding the platen bearing and lift the platen bearing to the top to tighten the knob again. 

X0267 
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(4) Attach the collar. 

X0268 

(5)  Attach the platen height adjustment lever to the platen bearing. 

<CAUTION> 

 Attach the platen height adjustment lever to the position shown below. The lever installed in the wrong position will interfere 

with the stopper when the platen is attached. 

<TIPS> 

 When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen bearing. 

X0269 
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(6) Check that the end position of the platen height adjustment lever is aligned with that of the platen bearing. 

X0208 

 

(7) Loosen the knob while holding the platen height adjustment lever and lower the platen bearing and the height 

control lever. 

X0270 
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(8) Use the platen fixing lever to secure the platen temporarily. 

The number of collars and the position of screw hole for the platen bearing differ by the height of the platen 

adjusted. 

<TIPS> 

 If you are setting the platen's height to the lowest position, remove all the collars and fix the platen bearing at its highest 

screw hole temporarily. 

 If you are setting the platen's height to the middle position, attach one collar and fix the platen bearing at its middle screw 

hole temporarily. 

 If you are setting the platen's height to the highest position, attach two collars and fix the platen bearing at its lowest screw 

hole temporarily. 

X0271 

 

(9) Tighten the knob to secure the platen bearing in place. 

<TIPS> 

 Align the center of platen fixing lever with the position as illustrated in the figure below, and secure the platen bearing in 

place. 

X0272 

 

 

(10) Insert the platen to be used and tighten the platen fixing lever. 
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6-4-3.  Using the 16X21 platen 

<CAUTION> 

 When using the 16X21 platen, handle it with care because it is heavy. Be sure not to touch the moving parts of the platen. 

Otherwise you may be injured. 

 When you slide the 16X21 platen manually, move it slowly. 

 

When you place or remove a T-shirt, and when you replace the platen, manually slide the platen forward and draw it out 

of the main unit completely to perform such operation. At this time, slide the platen while lifting it a little. When you 

perform printing, slide the platen backward and return it to the printing position before starting the print process. 

 

X0158 

<TIPS> 

 When using the 16X21 platen, remove all the collars for height adjustment before using it. For information on platen height 

adjustment, refer to "6-4-2. Platen height adjustment >>P.137". 

X0273
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(1) On the operation panel, press , and move the 16x21 platen toward the front of the printer. 

(2) Slide the 16X21 platen while lifting it a little to draw it forward. 

(3) Perform the work for placing or removing a T-shirt and replacing the platen in this condition. 

<TIPS> 

 For information on replacing the platen, refer to "6-4-1. Replacing the currently used platen with another one >>P.134". 

 For information on placing or removing a T-shirt, refer to "6-5. Placing print medium in position >>P.148". 

X0166 

 

(4) When you finish placing or removing a T-shirt, and replacing the platen, slide the platen backward and return it to its 

printing position. 

<IMPORTANT> 

 As the platen is positioned higher when it is slid forward, it is detected by the obstacle sensor, which prevents printing from 

being performed. However, if the platen's height is set at the lowest position, the platen is not detected by the obstacle 

sensor, and printing may be performed outside the print range of the platen.  

Make sure to start printing after sliding the platen to the printing position. 

X0168 
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6-5.  Placing print medium in position 
 

In order to provide an optimum printing image quality when a print medium is placed in position, you need to adjust the 

platen's height in accordance with the thickness of the T-shirt or other print medium. 

<CAUTION> 

 Ensure there is adequate space left in front of the printer and avoid placing any objects that may hinder your movement or the 

complete movement of the platen. The platen moves forward while operating and it can strike/damage anything set in its path of 

movement.  

 Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and the covers, it may be 

injured. 

<IMPORTANT> 

 Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

<TIPS> 

 Adjust the height of the platen corresponding to the print medium before using it. You can use the platen height adjustment lever 

to adjust the height of the platen. As a rough indication, adjust the height so that it is lowered by one step from the limit height 

detected by the obstacle sensor, and check that the platen is not detected by the sensor.  

In the event that the platen's height is lowered excessively, ink mist will be scattered inside the printer, which may result in 

staining of the printing surface, blurring of the printed image, and malfunction of the sensor and the main unit. 

 Use Uni-Directional Printing in the case where the platen's height needs to be lowered to avoid a hemmed (edge) and seam.  

☞"8-1. Setting the print direction >>P.229". 

 You can specify the Uni-Directional Printing for each print data from the printer driver as well.  

☞"5-4-11. Specify the print direction >>P.105". 

 When you print a thick printing material, you can always lower the platen's height by adjusting the platen bearing, collars.  

☞"6-4-2. Platen height adjustment >>P.137". 

 

(1) If the platen has not been moved forward, press  on the operation panel. 

(2) Use the platen height adjustment lever to adjust the height of platen. 

<TIPS> 

 Set the platen height adjustment lever to the position around "A" for a T-shirt, or to the position "C" for such thick material as 

a sweatshirt. 

 If the platen's height is lowered too much, the printing quality may deteriorate, the main unit may be soiled with ink mist and 

so on. 

X0274 

Platen height adjustment lever
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(3) Put a T-shirt onto the platen, with its printing side facing upward. 

<IMPORTANT> 

 If the 16X21 platen is mounted, slide it forward and place a T-shirt on it. 

<TIPS> 

 For the position alignment of white or pale-colored T-shirts, a grid to be printed out on the platen sheet is available from [All 

Programs] in the Start menu, by selecting "Brother GTX pro Tools" > "Useful Tools".  

☞"5-5-4. Print a grid pattern on the platen sheet >>P.108". 

X0110 

(4) Smooth down the creases in the T-shirt and remove lint and dust from it. 

<TIPS> 

 Seams on a hemmed (edge), neck portion, armhole, tucks and sleeves or the like are easily detected by the obstacle 

sensor. 

 In particular, both ends of the T-shirt tend to be raised easily during the printing operation if not flattened properly and 

detected by the obstacle sensor. 

 Touching on the fixated pretreated surface should be avoided during the work. 

 Do not pull the T-shirt with the pretreatment applied. Instead, flatten it in such a way that it will fit onto the platen surface 

well. 

 When the surface of the T-shirt does not remain flattened properly, the obstacle sensor detects it. 

 In the event that any T-shirt is placed on the platen by pulling it outward forcibly, there are instances in which ejection areas 

of the white and color inks are misaligned and the white ink extends off its specified printing area. In particular, be careful 

not to stretch a thin T-shirt outward on the platen. 

X0111 
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(5) The T-shirt should be placed on the T-shirt tray, trying not to draw the excessive parts like sleeves and hems into 

the printer. 

X0112 

 

(6) On the operation panel, press , and move the platen toward the rear of the printer. 

Try moving the platen, and check on the gap between the T-shirt surface and the obstacle sensor over the entire print area. 

<TIPS> 

 If this gap is too wide, adjust it by rotating the platen height adjustment lever. 

 Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and check that the 

platen is not detected by the sensor. 

 If the platen's height is too high, a print medium will strike against the print head during the printing process, which in turn 

results in ink stains or malfunction. 

 If the 16X21 platen is mounted, manually slide it backward until it returns to the original position, then move the platen 

toward the rear of the printer. 

 

(7) On the operation panel, press , and move the platen toward the front of the printer. 

<TIPS> 

 Repeat the height adjustment until the platen will be positioned at a proper height. 

 After your desired height is determined, start the printing operation.☞"6-7. Executing a printing job >>P.160". 

X0113 
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6-6.  Sending/Loading Print Data 

Print data can be loaded into the printer in the following ways: 

 Receive the print data from the PC connected with the USB or LAN cable. 

 Load the print data from the USB flash. 

For details, please refer to the chapters described later. 

 

6-6-1.  Sending print data from ARXP file preview 

(1) Open an ARXP file. 

<TIPS> 

 Double click on the ARXP file, or select [All Programs] > "Brother GTX pro Tools" > "GTX pro File Viewer", to select and 

open the ARXP file. You can also load an ARX4 file. 

 

(2) The file's printing conditions and preview window will be displayed. 

<TIPS> 

 If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, the preview window will be displayed 

against a "Black" background or a "Transparent color" background which has been specified in the Advanced settings. 

 If you have selected [Color Ink Only] in the Select Ink operation, the preview window will be displayed against a "White" 

background. 

 When you press the Details button, those items that have been specified in the Advanced setting window of the printer 

driver appear. 

 

 When [Color+White Ink] or [White Ink Only] is selected 
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 When [Color Ink Only] is selected 

 
 

 [Details] 
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(3) If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, you can change the 

background color of the preview window and preview the print image. Select [Change…] > [Define Custom Colors], 

and enter RGB value. 

<TIPS> 

 When the [White Data] checkbox is marked, the preview window for white ink only will be displayed. 

 

 

 

"Example: Preview window for printing an image on a brown (R=128, G=64, B=64) T-shirt" 
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(4) For the print data that requires multiple cycles of platen reciprocate movement, print data of each layer can be 

verified separately by selecting the desired layer to be displayed. From the [Present Layer], select a layer that you 

want to bring into the view. 

<TIPS> 

 In the layer that is shown as [Total], the preview window of the final print result is displayed. 

 When the [White Data] checkbox is marked, the preview window for white ink only will be displayed. 

 

(5) Check the printing conditions and preview window, and click on [Send to Printer]. 

Then, the ARXP file is sent to the printer. 

<TIPS> 

 Make sure that a connection of USB 2.0 cable or LAN cable is made between your PC and the printer.  

 In the event that two or more GTX pro printer drivers have been installed on your PC, select one of them and click [OK]. 
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6-6-2.  Sending print data from applications 

CorelDRAW 

(1) In the menu bar, select [File] > [Print]. 

(2) Open the [Color] tab, and make the following settings: 

 Place a checkmark in the [Document color] checkbox. 

 [Color conversions]: "Brother GTX pro" or "Brother GTX pro FileOutput" 

 [Color profile]: [sRGB IEC61966-2.1] 

 [Rendering intent]: [Relative colorimetric] 

 

(3) Open [General] tab and select "Brother GTX pro" from [Printer]. 

<TIPS> 

 If the specified [Printer] is set to "Brother GTX pro", the print data will be sent to the printer.  

If the specified [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file. 

(4) On [Preferences], set up the printer driver and send the print data by clicking [OK] in the [Print] dialog box. 

<TIPS> 

 Setting the printer driver ☞"5-4. Set up the printer driver >>P.89" 

 Clicking on [OK] will not start the print operation of the printer itself. The print button of the printer should be pressed to start 

the printing operation. 
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Adobe Photoshop 

(1) In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX pro" or "Brother GTX pro 

FileOutput", the layout is set to the platen size. 

(1) Make the settings as follows: 

 [Color Handling]: [Printer Manages Colors] 

 [Rendering Intent]: [Relative Colorimetric] 

 

(2) From [Printer], select "Brother GTX pro". 

<TIPS> 

 If [Printer] is set to "Brother GTX pro ", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file. 

(3) In the [Print Settings], set up the printer driver, and send the print data by clicking [Print]. 

<TIPS> 

 Setting the printer driver ☞"5-4. Set up the printer driver >>P.89" 

 Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to 

start the printing operation. 
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Adobe Illustrator 

(1) In the menu bar, select [File] > [Print] > [Color Management]. 

(2) Make the settings as follows: 

 [Document Profile]: [sRGB IEC61966-2.1] 

 [Color Handling]: [Let Illustrator determine colors] 

 [Printer Profile]: [sRGB IEC61966-2.1] 

 [Rendering Intent]: [Relative Colorimetric] 

 

(3) From [Printer], select "Brother GTX pro". 

<TIPS> 

 If [Printer] is set to "Brother GTX pro", the print data will be sent to the printer.  

If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file. 

(4) In the [Advanced], set up the printer driver, and send the print data by clicking [Print]. 

<TIPS> 

 Setting the printer driver ☞"5-4. Set up the printer driver >>P.89" 

 Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to 

start the printing operation. 
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6-6-3.  Loading print data (ARXP file) from USB flash memory 

(1) Insert a USB flash memory into the insertion slot near the operation panel of the printer. 

<IMPORTANT> 

 Do not apply undue force to the USB flash memory when you insert it into the slot. Otherwise, it could be damaged. 

<TIPS> 

 Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You cannot use a 

USB memory with security functions such as password lock function or beyond 32 GB. 

 Note that the data which can be loaded from the USB flash memory is only the data in the ARXP or ARX4 format. 

X0038 

 

(2) From the menu, select [Print Data Load], and press . 

<TIPS> 

 The information on file is shown on the liquid crystal panel. 

 
 

(3) Select a filename to be printed out, and press . 

<TIPS> 

 Selecting  will display the file stored in . 

 Folders in the USB flash memory are shown down to the 3rd layer. Folders created in the 4th layer or below are not 

displayed. 

 

USB flash insertion 
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(4) Check the print image displayed in the preview window, and press . 

<IMPORTANT> 

 Never touch the USB flash memory when the print button is blinking. Otherwise, any already-saved data may be corrupted. 

<TIPS> 

 Depending on data size, it may take several minutes before the loading process is completed. 

 When any files of USB flash memory cannot be read out. ☞"9-1. Troubleshooting instructions >>P.248" 

 If a folder contains more than one print data, you can use  buttons to switch the preview display screen. 

 It is possible to change the direction of the preview display screen as well. ☞"8-7. Preview display settings >>P.232". 

 
The print data loading will be completed when the print button stops blinking and remains lit, while the electric chime sounds. 
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6-7.  Executing a printing job 

6-7-1.  Executing a print job once for a single print medium 

(1) Receiving a print data file. 

The print button blinks during reception of data. When the data reception is completed, an audible alarm is activated and the print 

button illuminates. 

As there are two types of audible alarms, make sure the mounted platen matches the platen size of the print data. 

<TIPS> 

 When data of the same platen size as the previous one was received: A notice sound of "ping-pong" is output. 

 When data of a different platen size from the previous one was received: A notice sound of "ping-pong pan-pong" is output. 

(2) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button 

to start the printing. 

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard. 

<TIPS> 

 If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the 

printer, but no print job will be started. In this case, press the print button once again. 

 Pressing  causes the printing to be canceled. 

 The printer may shift to low temperature operation mode, when the room temperature is less than 18°C 

(64.4°F) and white ink is used.  

During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. 

Change the low temperature operation setting as needed.☞ "8-11. Print Operation Settings Under Low Temperature 

>>P.234". 

 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any 

warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly 

so as to conform with the print warranty scope.☞ "11-1. Apparatus >>P.350" 
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6-7-2.  Executing a print job several times for multiple print media 

You can keep the identical print data and execute a print job several times for multiple print media. 

<TIPS> 

 When the power is turned off, the retained print data is erased. 

 In the event that [ON] is selected from the [Auto Job Delete] in the [Printer Setting] window, the print data will be erased after the 

printing of the specified number of print media is completed. To change the setting, refer to "8-16. Automatic deletion of print data 

>>P.237". 

(1) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button 

to start printing. 

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard. 

<TIPS> 

 If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the 

printer, but no print job will be started. In this case, press the print button once again. 

 Pressing  causes the printing to be canceled. 

 The number of print media of which printing is completed is shown on the liquid crystal panel. 

 The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white 

ink is used.  

During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. 

Change the low temperature operation setting as needed.☞ "8-11. Print Operation Settings Under Low Temperature 

>>P.234". 

 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any 

warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly 

so as to conform with the print warranty scope.☞ "11-1. Apparatus >>P.350" 

(2) Replace the platen's printed medium (T-shirt) with the next one and repeat the procedure until the desired number 

of print jobs are completed. 
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6-7-3.  Performing the printing from receiving history 

You can print out such print data that you have received before. 

<TIPS> 

 The print data that can be retained are max. 100 pieces of them and 800 MB in total capacity, wherein each print data will be 

erased in the order from the oldest to the latest. 

 When the power is turned off, the retained print data is erased. 

 In the event that [ON] is selected from the [Auto Job Delete] in the [Printer Setting] window, the print function in the [Receiving 

History] is disabled. Change the settings as needed.☞"8-16. Automatic deletion of print data >>P.237" 

(1) From the menu, select a print data you want to print out in the [Receiving History]. 

<TIPS> 

 Each of the pieces of print data is displayed in the order in which they are received from the newest to the oldest ones. 

(2) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button 

to start the printing. 

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard. 

<TIPS> 

 If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the 

printer, but no print job will be started. In this case, press the print button once again. 

 Pressing  causes the printing to be canceled. 

 The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white 

ink is used.  

During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. 

Change the low temperature operation setting as needed.☞"8-11. Print Operation Settings Under Low Temperature 

>>P.234". 

 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any 

warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly 

so as to conform with the print warranty scope.☞"11-1. Apparatus >>P.350". 
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6-8. Scheduling a print 
 

When the printer is not in the standby state, you can schedule a print by pressing the Print button so that the printer will 

perform a print as soon as it returns to the standby state. 

 

6-8-1. When you can schedule printing 

You can schedule printing by pressing the Print button in advance while the print data is being received, during the 

post-print processing, and during the circulation of white ink. 

This is useful if the printer performs the post processing for the previous print job after you remove the printed T-shirt and 

set a new T-shirt to the platen. 

<TIPS> 

 Be sure to remove the printed T-shirt from the platen and set the next T-shirt to the platen before you press the Print button. 

 You cannot press the Print button in advance if the printer is being operated from the menu or an error has occurred. 

 

When you can schedule printing Description 

The printer is receiving print data While the printer is receiving print data sent via the USB or LAN cable 

The printer is post-processing after 

a print 

When a print job finishes and the platen is unloaded and while the printer is wiping, 

capping, cleaning the wiper, or performing an auto purge after a print job 

During the white ink circulation 
While the white ink is being circulated inside the printer at specified intervals or at a 

scheduled time for circulation 

 

6-8-2. When a scheduled print begins 

A scheduled print begins when each of the following conditions is true: 

When you schedule printing When the print begins 

The printer is receiving print data When the printer has completely received print data 

The printer is post-processing 

after a print 

When the printer has finished all the processes such as wiping, capping, cleaning 

the wiper, or an auto purge after a print job 

During the white ink circulation When the white ink circulation is completed 

 

<TIPS> 

 The Print button flashes fast during the period between when you schedule printing and when the printing begins. 

 

 



 

164 

Basic printing procedures

6-8-3. When printing does not begin 

A scheduled printing does not begin when each of the following conditions is true: 

 If an error occurs when printing should begin. (For example, this is true if the ink is depleted in the previous print 

job.) 

 If the data to print is missing from the printer when printing should begin. (For example, this is true if the data 

being printed when you schedule printing is deleted by the [Auto Job Delete] function. ☞"8-16. Automatic 

deletion of print data >>P.237") 

 

6-8-4. Cancelling scheduled printing 

You can cancel scheduled printing by pressing the Cancel button during the period between when you schedule printing 

and when printing begins. 

If you schedule a print during the white ink circulation and press the Cancel button, both the white ink circulation and the 

scheduled print are cancelled. 
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6-9.  Removing printed matter from platen 

(1) Hold the shoulder portions of print medium with your hand, and pull it out slowly in the forward direction indicated. 

<IMPORTANT> 

 Because the printed surface is still wet with ink, avoid touching it. 

 If any ink is attached to your hands, wash your hands with soap and water. 

 Those inks that are attached to fabrics cannot be cleaned up, please handle the inks with utmost care. 

<TIPS> 

 The printed ink is not fixated at this point - therefore, handle the T-shirt with care to avoid the printed surface touching with 

other objects. 

X0114 

 

T-shirt 
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6-10.  Fixation of ink 
For fixation of ink, use the heat press or oven. 

 Heat press 

It is useful because you can control its temperature and operating time with ease. 

 Oven 

If the number of articles to be printed is high, it will improve the operational efficiency. 

<CAUTION> 

 Please use the heat press and oven in a well-ventilated area. If your working area is not well ventilated, wear a protective mask. 

<TIPS> 

 If the inks are fixated insufficiently, discoloring may occur due to washing and friction. 

 Keep the fixation surface of heat press and peel-off sheet clean.  

Otherwise, the printing surface may be soiled with stains from the peel-off sheet. 

 If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer may occur.  

When a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer may occur in the 

same fashion.  

When a color transfer takes place, wipe the color-transferred area and clean off dirt with a soft and clean cloth or a toothbrush 

that is moistened with a small amount of mild detergent for home use and/or alcohol. 

 Component of pretreatment remains on the T-shirt on which the ink was fixated after applying pretreatment. For this reason, it is 

advisable to wash such T-shirts with water before wearing them. 

Guidelines on fixation conditions of ink 

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat 

press or oven. Be sure to perform the fixation after checking on the temperature and fixation results beforehand. 

<TIPS> 

 Because optimum conditions vary depending on the type of your heat press or oven, use the fixation conditions as a reference 

guide. Be sure to adjust the conditions while checking on the temperature and ink fixation results beforehand. 

 Because some print media easily get scorched, please carefully check and see how the surface actually looks like.  

In particular, the print media onto which the pretreatment has been applied will easily get scorched. 

 When using the heat press, adjust the pressure while checking the ink fixation result. 

 If it is not dry enough after processing for the period of the guideline, extend the time while checking the dried 

condition of the ink. 

 

Device Temperature Time 

Heat press 180°C (356°F) 35 seconds 

Oven Surface temperature: 160°C (320°F)*1 3 min. and 30 sec. to 5 min. 

*1: Because a T-shirt may be discolored if this temperature increases too high, great care should be taken to exercise 

temperature control. 
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Ink fixation by means of heat press 

(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the ink properly. 

<TIPS> 

 For the guidelines on fixation conditions of ink☞"6-10. Fixation of ink >>P.166". 

 For details, refer to the instruction manual of your heat press. 

 There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used as a peel-off sheet or 

to an almost bright finish if a fluororesin sheet is used as the same at the ink fixation stage. Selectively use either of them 

according to your desired finish. 

X0115 

Ink fixation by means of conveyor-type oven 

(1) Fixate inks onto a T-shirt by means of the conveyor-type oven. 

<TIPS> 

 For the guidelines on fixation conditions of ink☞"6-10. Fixation of ink >>P.166". 

 For the conveyor-type oven, identify the oven's internal temperature, and check up on actual ink fixation result. 

 For details, refer to the instruction manual of your conveyor-type oven. 

X0116 

Heat press 

Peel-off sheet 

T-shirt

T-shirt Conveyor-type oven 

out in

Silicone foam 
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7 Precautions to keep good printing quality/use printer over the long term 

 

DANGER 

 
Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5 

minutes later. 

 

CAUTION 

 
Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your 

fingers. 

 
Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation. 

In case of contact with eyes, do not rub but immediately rinse the eyes with water. 

 
Do not disassemble the ink cartridge. 

 
Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They 

may cause diarrhea or vomiting. 

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution, 

pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately 

rinse the eyes with water. 

Keep the liquids out of the reach of children. 

 
Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your 

eyes or onto your skin. 

It can cause inflammation. 

Do not drink or eat the grease. It may cause diarrhea or vomiting. 

Keep the liquids out of the reach of children. 

 
When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother 

will not be held responsible for any accidents or problems resulting from the use of non-genuine parts. 

 
When replacing parts or installing optional accessories, be sure to follow the procedures described in the 

Instruction Manual. Incorrect procedures could cause injuries or problems. 

 

IMPORTANT 

 
Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be 

hit and damaged. 
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7-1.  Tasks to be performed regularly 

7-1-1.  Replacement of ink pouch with a new one 

If the  is displayed in the remaining ink volume indication window on the operation panel screen, replace the ink 

pouch which is marked with X with a new one. 

<IMPORTANT> 

 No cartridges can be refilled with any ink. Do not disassemble the ink pouch. In order to use the printer for a long period and to 

take full advantage of its capabilities, we recommend to use the ink pouches that are specified by us. 

 During the printing process or head cleaning operation, avoid replacing any ink pouch with a new one. Otherwise, the printer may 

break down. 

<TIPS> 

 If you replace an ink pouch that still has much amount of remaining ink in the way of use, the remaining ink volume indication 

window may not display the correct remaining volume. 

 Any ink pouch has been designed to leave a small amount of ink in it when reading the end of its service life. This is required to 

protect the printer and keep its good printing quality. Please keep this matter in mind. 

 

(1) Take out the ink cartridge displayed on the screen from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

K Y

C M

W12 W34

X0318 Cartridge
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(2) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the lid. 

(a)

X0042 

(3) Pinch the latch at the front end of ink pouch, and draw out the depleted ink pouch from the cartridge. 

<CAUTION> 

 Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular 

basis. 

X0119 

(4) Unpack a new ink pouch from its shipping carton. 

For the white ink pouch, shake it 100 times each in the side to side direction with its obverse side and reverse side facing upward 

separately, as shown below. 

<NOTE> 

 Shake the pouch under the condition it remains contained in the inner box. 

X0048 

White ink pouch

Lid
Cartridge 

Latch Lid

Ink pouch

Cartridge 

Cartridge's tip end 

Latch
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(5) Unpack a new ink pouch from its inner box. 

<IMPORTANT> 

 Do not place the ink pouch near the sharp edges. It could break the pouch and leak the contained ink. 

 Handle the ink pouch with care. It could be damaged when bent, snagged by sharp objects, or dropped. 

X0143 

(6) Put a new ink pouch in the cartridge. 

Push the tip end of the ink pouch into the cartridge until it clicks into place. 

Straighten the ink pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount in position by pulling 

it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

(7) Put the ink pouch in its correct position. 

<CAUTION> 

 Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand. 

X0041

(a)

 

Ink pouch 

Stretch

Place the pouch in a straight alignment with the cartridge

Align lines with 

each other 

Ink pouch

Ink pouch

Cartridge
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(8) Close the lid, and put the ink cartridge in position inside the printer. 

<IMPORTANT> 

 Be sure to put a cartridge in its correct position. If a different ink cartridge is put by mistake, the applicable print head may be 

adversely affected. If a cartridge of different color is placed, please set it into the right position. If colors are mixed on the 

print result or within the ink pouch, please contact your dealer. 

 When setting the cartridge, do not shake the cartridge with the ink pouch facing down with the aim of facilitating the winding 

of the pouch. 

Doing so will cause wrinkles, and the proper winding of the ink pouch will not be possible. 

X0283 

<NOTE> 

 Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

 

(9) Attach a shelf life seal included with ink pouch onto the front surface of the cartridge. 

X0144 

 

 

Shelf life label
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7-1-2.  Cleaning and replacement of maintenance parts 

Clean or replace individually selected maintenance parts. 

(1) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

(2) Select [Select individually] and press . 

  

(3) Select the maintenance part you want to clean or replace following the message and press . 

<TIPS> 

 The nozzle guard, wiper, exhaust cap, and suction cap should be cleaned at the same time. 

(4) Clean and replace. 

<TIPS> 

 For the way to perform cleaning and replacement, refer to the respective maintenance parts. 

☞"7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap >>P.174" 

☞"7-1-4. Replacing the wiper cleaner >>P.186" 

☞"7-1-5. Replacing the flushing foam >>P.189" 

☞"7-1-7. Replacing the fan filter >>P.197" 
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7-1-3.  Cleaning the nozzle guard, wiper, exhaust cap, and suction cap 

When a warning message appears in the warning message window, perform the cleaning. 

In the event that maintenance has been performed inadequately, a printed material may be soiled with waste ink during 

a print session or a printed surface quality may deteriorate. 

 

(1) Make the clean stick R, clean stick T, cleaning cup, gloves and cleaning solution, which come standard with the 

printer, available for use. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

(3) Select [Part with Error/Warning] and press  

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(4) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select 

[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink 

from drying up. 
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(5) Open the front cover, and clean each of the nozzle guards, wipers, exhaust caps, and suction caps. 

Two types of clean sticks are provided. Use either the clean stick T or R depending on what you want to clean. 

<TIPS> 

 For the cleaning method, refer to the description mentioned below. 

X0319
 

(6) After the cleaning is completed, close the front cover. 

(7) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, a head cleaning will be performed to prevent any ink from drying up. 

 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

 

 

Front cover
Exhaust cap 

Wiper

Exhaust cap

Wiper

On the white side

On the color side 

Nozzle guard

Suction 

cap

Suction cap 

Locations to be 

cleaned with 

clean stick T 

Locations to be 

cleaned with 

clean stick R 
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Cleaning of the nozzle guard, wiper and exhaust cap should be performed separately for the white side and color side. 

For the way to perform cleaning, refer to the respective items. 

 

Perform cleaning of the white side. 

Nozzle guard  
Cleaning 

Prepare a new clean stick R and the cleaning solution. 

Perform cleaning of the nozzle guard part and the resin part on the white side. 
☞"Cleaning the nozzle guard (Use clean stick R) >>P.177" 

Rinse the cleaning cup, and prepare a new clean stick R and the cleaning solution. 

Wiper  
Cleaning 

Perform cleaning of the wiper part on the white side. 
☞"Cleaning wiper (Use clean stick T) >>P.180" 

Perform cleaning of the color side. 

Nozzle guard  
Cleaning 

Perform cleaning of the nozzle guard part and the resin part on the color side. 
☞"Cleaning the nozzle guard (Use clean stick R) >>P.177" 

Wiper  
Cleaning 

Perform cleaning of the wiper part on the color side. 
☞"Cleaning wiper (Use clean stick T) >>P.180" 

Exhaust cap  
Cleaning 

Perform cleaning of the exhaust cap part on the color side. 
☞"Cleaning exhaust cap (Use clean stick T) >>P.182" 

Cleaning  
suction cap 

Perform cleaning of the suction cap part on the white side.  
☞"Cleaning suction cap (Use clean stick T) >>P.184" 

Exhaust cap  
Cleaning 

Perform cleaning of the exhaust cap part on the white side. 
☞"Cleaning exhaust cap (Use clean stick T) >>P.182" 

Cleaning  
suction cap 

Perform cleaning of the suction cap part on the color side.  
☞"Cleaning suction cap (Use clean stick T) >>P.184" 

Prepare a new clean stick T and the cleaning solution. 

Rinse the cleaning cup, and prepare a new clean stick T and the cleaning solution. 
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Cleaning the nozzle guard (Use clean stick R) 

(1) Put a proper amount of cleaning solution into the cleaning cup. 

(2) Moisten a new clean stick R with the cleaning solution. 

<IMPORTANT> 

 Use a new clean stick R when you start cleaning. 

 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction. 

 Do not use other fluids (water, etc.), because they may damage the print heads. 

 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 

 Do not shed cleaning solution in the maintenance unit. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0320 

 

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup

Do not drain waste ink.
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(3) Wipe clean the sides of the nozzle guard with the clean stick R. 

<IMPORTANT> 

 Be sure not to touch the nozzle surface as well as the level surface and sidling surface of the nozzle guard. 

<TIPS> 

 Manually move the carriage to such a position that you can perform the cleaning with ease. 

X0276

 

  

 

Nozzle guard

Clean stick R

Nozzle surface

Nozzle guard 

Side Side 
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(4) Wipe the resin part between the print head's nozzle surface and nozzle guard. 

<IMPORTANT> 

 Be sure not to touch the red-frame zone of the nozzle surface. 

 For cleaning, be sure not to use any tool other than clean stick R. 

X0237 

 

Cleaning conditions 

Pre-cleaning state Post-cleaning state 

 

 

 

<IMPORTANT> 

 Be sure to use the clean stick R separately for white ink and color ink. 

<TIPS> 

 There may remain white ink in the black resin part, but it doesn't matter if the severity is small as shown in the photo. Wipe away 

the white ink spreading out of the nozzle guard and nozzle surface. 

Clean this part 

Cleaning location 

Between the nozzle surface and nozzle guard

Cleaning location 

Between the nozzle surface and nozzle guard 

Nozzle surfaceNozzle guard 

X0238Cleaning location 

Between the nozzle surface and nozzle guard
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Cleaning wiper (Use clean stick T) 

(1) Put a proper amount of cleaning solution into the cleaning cup. 

(2) Moisten a new clean stick T with the cleaning solution. 

<IMPORTANT> 

 Use a new clean stick T when you start cleaning. 

 Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction. 

 Do not use other fluids (water, etc.), because they may damage the print heads. 

 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 

 Do not shed cleaning solution in the maintenance unit. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0321 

(3) Use clean stick T to wipe clean the surface of the wiper as well as the gap between the convex part and the wiper. 

<IMPORTANT> 

 Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction. 

 Be sure to use the clean stick T separately for color ink and white ink. 

 If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp 

objects could damage the wiper, possibly resulting in failure to eject ink-jet droplets. 

Cleaning cup

Cleaning solution 

Clean stick T 

Cleaning cup

Do not drain waste ink.
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(4) Use the clean side of clean stick T to wipe clean the back of the wiper. 

X0322

 

(5) Rinse the clean stick T in the cleaning cup to use it for cleaning of the exhaust cap to be performed next. 

<IMPORTANT> 

 Be sure to use the clean stick T separately for white ink and color ink. 

 

Wiper 

Clean stick T

Front

Back 

Front 

Wiper 

Clean stick T 

Convex part 
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Cleaning exhaust cap (Use clean stick T) 

(1) Wipe clean the rubber seal of exhaust cap with the clean stick T. 

<IMPORTANT> 

 Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction. 

 The clean stick T used for cleaning the wiper should be rinsed in the cleaning cup before the next use. Be sure to use the 

clean stick T separately for color ink and white ink. 

 If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp 

objects could damage the exhaust cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets. 

(2) Use the clean stick T to soak up the ink accumulated in the exhaust cap, and remove it. 

<IMPORTANT> 

 If there is any ink clot in the exhaust cap, move the clean stick T in the direction as illustrated below. If the stick is moved 

toward yourself, any of the exhaust suction ports may be clogged with ink clot. 

X0323 

(3) Rinse the clean stick T in the cleaning cup to use it for cleaning of the suction cap to be performed next. 

<IMPORTANT> 

 Be sure to use the clean stick T separately for white ink and color ink. 

<TIPS> 

 Some cleaning solution may remain in the exhaust cap, but it will not cause any functional problem. 

 

Clean stick T 
Rubber seal

Exhaust suction ports 

Clean stick T 
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Cleaning conditions 

 Pre-cleaning state Post-cleaning state 

On the 

white side 

 
 

On the 

color side 

 
 

 

Exhaust cap rubber part Exhaust cap rubber part

Exhaust cap rubber part Exhaust cap rubber part X0389
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Cleaning suction cap (Use clean stick T) 

(1) Wipe the rubber seal and lip of the suction cap with one side of the tip portion of clean stick T in parallel with the 

seal. 

<IMPORTANT> 

 Clean the lip of the suction cap with clean stick T. The print head dries and causes an ejection failure if solidified ink 

remains. 

 Do not touch the sponge of the suction cap. The sponge may come off. 

 Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a 

printer malfunction.  

 The clean stick T used for cleaning the wiper and exhaust cap should be rinsed in the cleaning cup before the next use. 

Be sure to use the clean stick T separately for color ink and white ink. 

 If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp 

objects could damage the suction cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets. 

 Be sure not to pinch the rubber seal. If it is damaged, its sealing property will be degraded, which in turn may lead to 

non-ejection of ink-jet droplets from the print heads. 

X0324  

(2) Replace clean stick T with clean stick R, rinse the cleaning cup, and clean the nozzle guard on the color side head. 

<IMPORTANT> 

 Be sure to use the clean stick T separately for white ink and color ink. 

 The used clean stick T should be disposed of, and should not be reused. 

 After cleaning the nozzle guard of the color side head, rinse the cleaning cup with pure water, let it dry sufficiently, and store 

it so that dust does not get inside. 

Rubber seal 
Clean stick T

Sponge 

Lips 

Outer side
Outer side 

Sectional view 

The outer side of the suction cap does not need to  

be cleaned.  
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Cleaning conditions 

Pre-cleaning state Post-cleaning state 

 
 

 

X0390
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7-1-4.  Replacing the wiper cleaner 

When a warning message appears on the operation panel screen or in the warning message window, replace the 

specified wiper cleaner with a new one. 

<TIPS> 

 When you replace the wiper cleaner, check the staining state inside the printer. If parts inside the printer (carriage guide shaft, 

roller guide, and carriage roller) are stained, perform cleaning.☞"7-1-6. Cleaning the internal area of printer >>P.192" 

 

(1) Have the supplied gloves and wiper cleaner ready. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

(3) Select [Part with Error/Warning] and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(4) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, after attaching the wiper cleaner, close the front cover and turn on the 

power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be 

performed to prevent any ink from drying up. 

(5) Open the front cover. 
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(6) Raise the wiper cleaner and move it to its upright position, and remove it by moving it upward. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0325 

(7) Take out the wiper cleaner from its packing bag, and remove it from its protector. 

<IMPORTANT> 

 As soon as it is unpacked, do not leave it as it is and put it in position. 

X0128 

Wiper cleaner Front cover

Wiper cleaner 

Protector 



 

188 

Precautions to keep good printing quality/use printer over the long term

(8) Insert a new wiper cleaner into the printer from above, tip it leftward and put it in place. 

<TIPS> 

 First, insert the shaft from above. Then fold it to the left, press the area with the PUSH indication until a clicking sound is 

heard, and get the latch into position. 

X0326 

(9) Close the front cover. 

(10) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

<TIPS> 

 A head cleaning will be performed to prevent ink from drying up. 

Wiper cleaner 
Shaft

Latch 
Latch 

Shaft 
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7-1-5.  Replacing the flushing foam 

When a warning message appears on the operation panel screen or in the warning message window, replace the 

specified flushing foam with a new one. 

<TIPS> 

 When you replace the flushing foam, check the staining state inside the printer. If parts inside the printer (carriage guide shaft, 

roller guide, and carriage roller) are stained, perform cleaning.☞"7-1-6. Cleaning the internal area of printer >>P.192" 

 

(1) Make the clean stick R, gloves and flushing foam, which come standard with the printer, available for use. 

<TIPS> 

 For this cleaning, you can use an already-used dirty clean stick R. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

(3) Select [Part with Error/Warning] and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(4) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, after attaching the flushing receiver, close the front cover and turn on 

the power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be 

performed to prevent any ink from drying up. 

(5) Open the front cover. 
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(6) Remove the flushing foam from the maintenance unit. 

<IMPORTANT> 

 Remove the flushing foam without removing the flushing receiver from the maintenance unit. 

 Ink droplets will drop off from the hole in flushing foam. After removal, apply a waste cloth to the bottom face. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0327 

(7) Wipe the gloves with a waste cloth. 

X0436

 

Flushing receiver 
Front cover

Waste cloth

Waste cloth

Waste cloth 

Gloves
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(8) Assemble a new flushing foam to the flushing receiver. 

<IMPORTANT> 

 After this assembly process is completed, make sure that no flushing foam extends off the outboard end portions of flushing 

receiver. If it sticks out of the end portions, it may interfere with any nozzles and may result in non-ejection of ink-jet 

droplets. 

<TIPS> 

 It is not necessary to clean the flushing receiver. 

X0330
 

(9) Close the front cover. 

(10) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

<TIPS> 

 The head cleaning will be performed to prevent ink from drying up. 

Flushing receiver 
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7-1-6.  Cleaning the internal area of printer 

When you replace the wiper cleaner and the flushing foam, check the staining state inside the printer. If parts inside the 

printer (carriage guide shaft, roller guide, and carriage roller) are stained, perform cleaning. 

(1) Prepare a clean stick R, cleaning cup, gloves, cleaning solution, and grease which come standard with the printer. 

<IMPORTANT> 

 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may 

result in a printer malfunction. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select 

[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink 

from drying up. 

(4) Open the front cover. 

X0331 

Front cover
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(5) Remove three screws to remove the encoder cover. 

<CAUTION> 

 Do not touch the latch under the encoder cover. Otherwise, the operator may get injured. 

<IMPORTANT> 

 Do not touch the encoder on the main unit. 

X0148 

(6) Put a proper amount of cleaning solution into the cleaning cup. 

Latch 

Latch

Encoder cover 

Screw
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(7) Moisten a clean stick R with the cleaning solution. 

<IMPORTANT> 

 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 

 Do not shed cleaning solution in the maintenance unit. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0320 

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup

Do not drain waste ink. 
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(8) With the clean stick R, wipe away the ink mist on the carriage roller part. 

(9) Move the carriage from side to side to rotate the roller part, and wipe all around the carriage roller. 

X0448 

(10) Clean the carriage guide shaft and the three sides (upper, front, and lower sides across which the roller rolls) of 

roller guide. 

<TIPS> 

 Moisten a waste cloth (non-fuzzy cloth) with a small amount of alcohol, and use such cloth to wipe clean the internal 

surface. 

 Do not use alcohol on parts other than the carriage guide shaft and the roller guide. 

(11) Apply a proper amount of the grease (which is included with the printer) onto the carriage guide shaft. 

<CAUTION> 

 When handling the grease, perform the work operation in such a manner that it will not get into your eyes or onto your skin. 

X0063 

Roller guide 

Carriage guide shaft

Front cover

Carriage roller

Clean stick RCarriage 



 

196 

Precautions to keep good printing quality/use printer over the long term

(12) Insert the two latches under the encoder cover and fix the cover with three screws. 

(13) Close the front cover. 

(14) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, a head cleaning will be performed to prevent any ink from drying up. 

 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

(15) Adjust the carriage speed.☞ "7-4-1. CR (Carriage) speed adjustment >>P.216". 

(16) Print out a nozzle check pattern.☞ "7-2-1. Print out of the nozzle check pattern (checking on the print heads) 

>>P.199". 
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7-1-7.  Replacing the fan filter 

When a warning message appears in the warning message window, replace the fan filter with a new one. 

 

(1) Make the gloves which come standard with the printer, as well as a new fan filter, available for use. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

(3) Select [Part with Error/Warning] and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen.  

 Pressing  will not move the platen or head if the error and warning displayed are [Fan Filter To Be Replaced] only. 

(4) Follow the on-screen message and turn off the power. 

(5) Remove the fan filter from the main unit of printer. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0332 

Fan filter 
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(6) Mount a new fan filter to the frame of filter case. 

<IMPORTANT> 

 Mount the fan filter properly in correct position in such a way that its coarse mesh surface faces toward the inner area of 

printer. 

X0062 

(7) Mount the assembled fan filter in the main unit of printer. 

(8) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, a head cleaning will be performed to prevent any ink from drying up. 

Fan filter

Coarse mesh surface

Filter case

Toward the fan

Toward the inner area of printer

Fine-meshed surface
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7-2.  Tasks to be performed when needed 

7-2-1.  Print out of the nozzle check pattern (checking on the print heads) 

By printing out a nozzle check pattern, you can check on the printing quality. 

It is recommended to always perform this procedure to verify the output. 

<TIPS> 

 The serial number, firmware version, and print date (day/month/year) and time are printed at the bottom of the nozzle check 

pattern. 

The date and time will be printed in Coordinated Universal Time with "(UTC)" printed at the end if time adjustment as a 

maintenance tool has not been made. You can print the date and time according to your environment by making time 

adjustment. ☞"7-4-6. Setting of the time displayed on the nozzle check pattern >>P.221" 

 

(1) Put the platen 14X16 in place, and position its level at "A". 

☞"6-4-1. Replacing the currently used platen with another one >>P.134" and "6-4-2. Platen height adjustment 

>>P.137". 

(2) As illustrated below, put the A4-size or letter-size white paper on the platen in alignment with the right-hand corner 

of the platen at its front edge. 

When the paper is loosely fitted, fix its edge with a tape or the like. 

A T-shirt can also be used instead. 

<TIPS> 

 When printing out a nozzle check pattern on the white side, print it on a pretreated black or dark color textile or black paper, 

or a transparent sheet (such as OHP sheet). 

X0043 

(3) From the menu, select [Test Print] > [Nozzle Check CMYK], and press . 

Then, printing will begin. 

(4) After printing on the color side is completed, remove the printed paper and replace it with a paper for printing on the 

white side. 

(5) From the menu, select [Test Print] > [Nozzle Check White], and press . 

Then, printing will begin. 

 

 

Paper

Platen 
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X0241

(6) Check to see if the printed result of both sides are acceptable, and if no ink-jet droplets have been ejected, perform 

a head cleaning for print heads.☞ "7-2-2. Head cleaning >>P.201" 

<IMPORTANT> 

 If the print result shows an intermittent line, non-ejection has occurred. A head cleaning should be performed on the print 

head that has a poor nozzle check result. 

 Even if the lines of the white-side printed result are light, since white ink is fired from more than one nozzle on the same 

place, the quality is not affected. 

 

On the color side On the white side 

Non-ejection occurred at the arrowed area. 

 

Example: 

 

Non-ejection occurred at the arrowed area. 

 

Example: 
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7-2-2.  Head cleaning 

This printer has been designed to perform the Auto Cleaning every time 24 print jobs are printed after the previous Auto 

Cleaning, or before starting the printing using the white ink when one hour or more elapses after the previous printing 

that used the white ink. 

<TIPS> 

 The frequency and start timing of Auto Cleaning can be changed. ☞"8-12. Auto Cleaning Setting >>P.235" 

 

In the event that there is any faintly printed or missing portion on a printed material, head cleaning sometimes provides a 

solution. 

 

Selecting a type of head cleaning from the menu to perform the head cleaning 

(1) While the printer is in standby mode press  on the operation panel to bring the menu screen into the view. 

(2) From the menu, select [Head Cleaning], and press . 

 

(3) By pressing , select one of the options: [Normal Cleaning], [Powerful Cleaning], [Super Cleaning] or [Flash 

Firing],and press . 

<TIPS> 

 For selecting a desired cleaning option, follow the instructions in the respective steps.☞"9-2-1. Recovery action to be taken 

for such a nozzle that is unable to eject ink-jet droplets >>P.257". 
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(4) By pressing , select the [All Colors], [All Whites], or [All Print Heads], and press . 

<TIPS> 

 Under the condition that the nozzle which has been confirmed not ejecting ink-jet droplets, determine the color for which the 

head cleaning should be performed.☞ "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.199"  

 

(5) Then, the head cleaning will be performed for the specified print heads. 

<TIPS> 

 The cleaning operation cannot be canceled halfway. 

 After the procedures are completed, the current screen will go back to the standby mode screen. 
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7-2-3.  White ink circulation 

When whiteness is not enough, it may be solved by performing white ink circulation. 

(1) While the printer is in standby mode, press  on the operation panel to bring the menu screen into view. 

(2) From the menu, select [Maintenance] > [White Ink Circulation], and press . 

<IMPORTANT> 

 Do not turn off the power because if you do so, the machine mail fail because necessary maintenance operations are not 

performed. 

<TIPS> 

 Time required for completing the white ink circulation varies depending on the ambient temperature. It normally takes 7 and 

a half minutes although it can take up to 15 minutes. White ink is circulated automatically every six hours and white ink 

three times as much as normal is circulated every 24 hours. 

 If you are activating the printer after having had its power off for a long period, it will take up to 40 minutes. 
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 7-2-4.  Cleaning the CR (carriage) plate 

Clean the carriage plate when it is contaminated with ink. 

<TIPS> 

 You can use an already-used clean stick R. 

(1) Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available 

for use. 

<IMPORTANT> 

 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may 

result in a printer malfunction. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select 

[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink 

from drying up. 

(4) Open the front cover. 

X0331 

(5) Put a proper amount of cleaning solution into the cleaning cup. 

Front cover
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(6) Moisten a clean stick R with the cleaning solution. 

<IMPORTANT> 

 If you use an already-used clean stick R, do not use it for other purposes than cleaning the carriage plate. 

 Do not use other fluids (water, etc.), because they may damage the print heads. 

 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 

 Do not shed cleaning solution in the maintenance unit. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0320 

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup

Do not drain waste ink.
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(7) With the clean stick R, wipe away the accumulated ink on the carriage plate of the left-side of the print head. 

<IMPORTANT> 

 Be sure not to touch the nozzle surface. 

<TIPS> 

 Manually move the carriage to such a position that you can perform the cleaning with ease. 

X0250 

(8) Clean the carriage plate on the left side of the other print head in the same manner. 

<IMPORTANT> 

 The used clean stick R should be disposed of, and should not be reused. 

(9) Close the front cover. 

(10) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, a head cleaning will be performed to prevent any ink from drying up. 

 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

 

Carriage plate

Clean stick R 

Contaminated with ink 
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7-2-5.  Replacing the platen sheet 

When the platen sheet gets soiled, replace it with a new one. 

(1) Remove the platen from the main unit of the printer. 

☞ "6-4-1. Replacing the currently used platen with another one >>P.134" 

(2) Peel the platen sheet off the platen. 

<TIPS> 

 When it is hard to peel the platen sheet off, warm it using a hair dryer or the like and peel it off. 

X0064 

(3) Wipe the surface of the platen with a clean cloth moistened with a mild detergent which is diluted with water, then 

wipe the platen clean with a dry and soft clean cloth. 

(4) Mount the platen in the main unit of the printer. 

☞"6-4-1. Replacing the currently used platen with another one >>P.134" 

(5) Peel the release paper (small in size) off a new platen sheet. 

X0157 

Platen sheet 

Platen

Platen sheet 

Release paper (small) 
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(6) Position the platen sheet to match the platen surface, and onto the platen, stick the portion of the platen sheet 

where the release paper (small) was removed. 

<TIPS> 

 If the 16X21 platen is used, slide it forward before working on it. 

X0065 

(7) Peel off the rest of the release paper, and paste the whole platen sheet onto the entire platen. 

<TIPS> 

 Straighten the platen sheet, and stick it properly while pressing it with hands outward from the center to avoid making 

wrinkles. 

X0066 

(8) As required, print a grid pattern onto the new platen sheet. 

☞ "5-5-4. Print a grid pattern on the platen sheet >>P.108" 

<TIPS> 

 After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink. 

 

Positioning 

Platen sheet 

Platen sheet

Platen

Release paper 

Platen
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7-3.  White Ink Pause Mode 

7-3-1.  Disabling white ink 

If you do not plan to use the white ink for 1 month or longer, it is recommended to set the printer to white ink pause mode. 

This eliminates the necessity to maintain the white ink, and saves its consumption. 

<TIPS> 

 Although the white ink pause mode can be activated even when the remaining volume of maintenance solution in the 

maintenance solution pouch is running short, there may be a case where the pouch needs to be replaced with a new one in the 

middle of the process depending on such remaining volume. If the remaining volume is 500 g (17.6 oz) or less, prepare a new 

maintenance solution pouch, follow the instructions on the screen to replace the pouch, and activate the mode again. 

 

(1) From the menu, select [Maintenance] > [White Ink Pause Mode] > [Enable]. 

(2) Check the waste ink tank for its availability and take a necessary measure for it, if any, then press . 

(3) Remove the white ink cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0333 
(4) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the 

lid. 

(a)

X0042 

White Ink Cartridge

Lid
Cartridge

Latch Lid
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(5) Pinch the latch at the front end of the ink pouch, and draw out the white ink pouch from the cartridge. 

<CAUTION> 

 Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular 

basis. 

X0119 

(6) Put the maintenance solution pouch in the cartridge. 

Push the tip end of the maintenance solution pouch into the cartridge until it clicks into place. 

Straighten the maintenance solution pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount 

into position by pulling it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

(7) Put the maintenance solution pouch in its correct position. 

<CAUTION> 

 Avoid touching portion (a) of the cartridge. Otherwise, you may cut your hand. 

X0041

(a)

 

Maintenance solution pouch 

Cartridge

Place the pouch in straight alignment with the cartridge

Align lines with 
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(8) Close the lid, and put the maintenance solution cartridge in position inside the printer. 

(9) Repeat the same process to replace the other white ink cartridge with the maintenance solution pouch. 

(10) On the operation panel, press . 

Then, the white ink will be replaced with the maintenance solution. 

<TIPS> 

 After the procedures are completed, the current screen will go back to the standby mode screen. 

 Always keep the maintenance solution cartridge placed in its position. 

 As required, restart printing with the white ink.☞"7-3-2. Reusing White Ink >>P.212" 

 If the maintenance solution pouch runs out, replace the maintenance solution pouch with a new one. 
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7-3-2.  Reusing White Ink 

Perform the following operations when you restart printing with the white ink after activating the white ink pause mode. 

(1) From the menu, select [Maintenance] > [White Ink Pause Mode] > [Disable]. 

(2) Check the waste ink tank level and take a necessary measure for it, if any, then press . 

(3) Remove the maintenance solution cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0333 
(4) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the 

lid. 

(a)

X0042 

Maintenance solution cartridge

LidCartridge 

Latch Lid
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(5) Remove the maintenance solution pouch from the cartridge, and put the white ink pouch in place. 

Push the tip end of the ink pouch into the cartridge until it clicks into place. 

Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of cartridge, and mount in position by 

pulling it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

(6) Make sure that the white ink pouch is set in its correct position, to close the lid. 

<CAUTION> 

 Avoid touching portion (a) of cartridge. Otherwise, you may cut your hand. 

X0041

(a)

 

(7) Shake the cartridge 100 times side to side to stir the ink. 

<IMPORTANT> 

 The white ink cartridge should be held horizontally when shaking it. 

 Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch. 

<NOTE> 

 Wear the provided gloves when performing this task. 

 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the 

edge of the ink pouch slightly winded, to make the ink easier to stir. 

X0194 

White ink pouch 

Cartridge

Place the pouch in straight alignment with the cartridge

Align lines with 

each other 

White Ink Cartridge 
Ink pouch

Edge of the rib

Remaining ink volume should 

be approx. 5.9 in. (15 cm) Shake 100 times (for approx. 50 seconds) 

(Swing distance should be approx. 2 in. (5 cm). 

Increase the swing distance when the remaining 

ink level becomes low.) 

Stretch
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(8) Open the lid of the cartridge and place the ink pouch in its correct position. 

<IMPORTANT> 

 Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow 

into the wound section of the pouch when stirred, causing improper winding of the pouch. 

 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge 

downward and open the lid. 

 When setting the ink pouch, avoid unevenness or wrinkles on the pouch. 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

<NOTE> 

 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid. 

(a)

X0182 

X0078 

X0142 

(9) Close the lid, and put the white ink cartridge in position inside the printer. 

<IMPORTANT> 

 W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause 

printer malfunction. 

(10) Repeat the same process to replace the other maintenance solution cartridge with the white ink pouch. 

Place the pouch in straight alignment with the cartridge

Latch Lid 

No wrinkles

Not sagged

Ink pouch

LidCartridge
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(11) On the operation panel, press . 

Then, the white ink will be installed. 

<TIPS> 

 When the white ink pouch runs low on its remaining volume of white ink, the Install Ink function can no longer get started. 

Furthermore, there may be cases where the pouch needs to be replaced with a new one during the installation process of 

white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow the instructions on the 

screen to replace the pouch, and activate the mode again. 

 After the procedures are completed, the current screen will go back to the standby mode screen. 
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7-4.  Adjustment/setup 

7-4-1.  CR (Carriage) speed adjustment 

Carriage speed should be adjusted when the error message [Adjust CR] is displayed on the operation panel. Adjustment 

should always be performed when carriage shaft cleaning or print head replacement tasks are carried out, or after 

completing the setup procedures. 

(1) While the printer is in standby mode, press  on the operation panel to bring the menu screen into view. 

(2) From the menu, select [Printer Setting] > [CR Speed Adjustment], and press . 

(3) Select [Start] or [Start (after cleaning/setup)] and press . 

 [Start]: If you cannot clean the internal area of the printer such as carriage shaft immediately after the head 

replacement or when the error message is displayed. 

 [Start (after cleaning/setup)]: After cleaning the carriage shaft. 

Wait until the carriage stops moving and the sound of pong is heard.  

It takes about 3 minutes to adjust the carriage speed. 
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7-4-2.  Initial settings after head replacement 

Set V-rating after replacing the print head or completing the setup procedure. 

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools". 

(3) After the window shown below appears, select [Initial settings after head replacement] and click [Next]. 

 

(4) Perform the required operation by following the on-screen instructions in the dialog box. 

After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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7-4-3.  Firing adjustment 

Because the ejection timing varies depending on the platen's height and properties of each print head, this function is 

provided to adjust the ejection timing for each print head when any print head is replaced with a new one or after the 

completion of the setup procedure, for instance. If you want to make adjustments after replacing the print head, 

configure the initial settings after print head replacement before you do so. 

(1) Make several sheets of A4-size or letter-size paper (black paper or transparent sheet such as OHP sheet, and 

white paper) available for use. 

(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools". 

(4) After the window shown below appears, select [Firing Adjustment] and click [Next]. 

 

(5) Perform the required operation by following the on-screen instructions in the dialog box. 

After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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7-4-4.  Platen-rolling adjustment 

Platen feed adjustment should be performed after replacing the print head or completing the set up procedure. 

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement 

and adjust the firing timing before you do so. 

(1) Make several sheets of A4-size or letter-size white paper available for use. 

(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools". 

(4) When the window shown below is displayed, select [Platen-rolling adjustment] and click [Next]. 

 

(5) Perform the required operation by following the on-screen instructions in the dialog box. 

After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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7-4-5.  White/color alignment 

This is the adjustment function to align the print position on the white side with the print position on the color side. Adjust 

white/color alignment after replacing a print head or completing the setup procedure. 

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement 

and adjust the firing timing and platen feed before you do so. 

(1) Prepare a sheet of black paper or a pretreated black or dark color T-shirt. 

(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC. 

(3) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools". 

(4) After the window shown below appears, select the [White/Color Alignment] and click [Next]. 

 

(5) Perform the required operation by following the on-screen instructions in the dialog box. 

After the adjustment is completed, the currently displayed screen will go back to the window mentioned above. 
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7-4-6.  Setting of the time displayed on the nozzle check pattern 

Set the time displayed on the nozzle check pattern. 

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" of "Brother GTX pro Tools". 

(3) After the window shown below appears, select [Setting of the time displayed on the nozzle check pattern] and click 

[Next]. 
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(4) Perform the required operation by following the on-screen instructions in the dialog box. 

<CAUTION> 

 Confirm that the date and time of your PC are set correctly, and continue. 

 
 

(5) After the setting is completed, the currently displayed screen will go back to the Main screen. 
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7-4-7.  Set the scheduled time for white ink circulation 

White ink circulation can be performed at a specified time. If not set, white ink circulation will be performed automatically 

every six hours. 

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" of "Brother GTX pro Tools". 

(3) After the window shown below appears, select [Set the scheduled time for white ink circulation] and click [Next]. 

 

(4) After the window shown below appears, select [Set the scheduled time for white ink circulation.] and click [Next]. 
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(5) Set the scheduled time for white ink circulation and click [Next]. 

<CAUTION> 

 Confirm that the date and time of your PC are set correctly, and continue. 

 Enter four or more start time settings. 

 You cannot set the scheduled time in such a manner that the length of the intervals of white ink circulation is longer than six 

hours. 

 Input a time range of "0:00" to 23:59". 

<TIPS> 

 You can check on the main unit the scheduled time you set.☞"8-23. Check circulation schedule >>P.241". 
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7-5.  When Not Using for a Long Period of Time 

When the printer will not be used for a prolonged period of time, take appropriate procedures before storing the printer 

depending on storage period or condition. 

<IMPORTANT> 

 Do not turn the printer off. Otherwise, the printer may be damaged. 

 If the power source to the printer cannot be sustained, please contact your dealer in advance. 

<NOTE> 

 If any error message is displayed on the screen, follow the instructions. 

 When storing the printer for more than two weeks, cleaning of the nozzle guard, wiper and exhaust cap should be performed.  

☞"7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap >>P.174" 

 

7-5-1.  When Not Using for a Long Period of Time: within 2 weeks 

The printer can be used through normal procedure after the storage period, by performing the following maintenance 

tasks. 

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with waste ink up to its one-half or 

higher level, discard the ink.☞ "6-2-1. Confirmation and disposal of waste ink >>P.116" 

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the 

proper level.☞ "6-2-2. Confirmation and refilling of cleaning solution >>P.117" 

(3) Stir the white ink if a white ink cartridge stirring message is displayed on the operation panel screen.☞ "6-2-3. Daily 

agitation of the white ink >>P.118" 

(4) As required, print out a nozzle check pattern.☞ "7-2-1. Print out of the nozzle check pattern (checking on the print 

heads) >>P.199" 

 

7-5-2.  When Not Using for a Long Period of Time: more than 2 weeks 

Perform the following maintenance every two weeks. 

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or 

higher level, discard the ink.☞ "6-2-1. Confirmation and disposal of waste ink >>P.116". 

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the 

proper level.☞ "6-2-2. Confirmation and refilling of cleaning solution >>P.117". 

(3) Stir the white ink if a white ink cartridge stirring message is displayed on the operation panel screen.☞"6-2-3. Daily 

agitation of the white ink >>P.118" 

(4) Print out a nozzle check pattern and verify the result.☞ "7-2-1. Print out of the nozzle check pattern (checking on 

the print heads) >>P.199" 

(5) If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result 

again.☞ "7-2-2. Head cleaning >>P.201". 
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7-5-3.  When Not Using for a Long Period of Time: within 2 weeks with white ink pause mode 

The printer can be used through normal procedure after the storage period, by performing the following maintenance 

tasks. 

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or 

higher level, discard the ink.☞ "6-2-1. Confirmation and disposal of waste ink >>P.116" 

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the 

proper level.☞ "6-2-2. Confirmation and refilling of cleaning solution >>P.117" 

(3) As required, print out a nozzle check pattern for the color side.☞ "7-2-1. Print out of the nozzle check pattern 

(checking on the print heads) >>P.199" 

<TIPS> 

 For the White ink pause mode, print the nozzle check patterns for the head only on the color side. 

 

7-5-4.  When Not Using for a Long Period of Time: more than 2 weeks with white ink pause mode 

Perform the following maintenance every two weeks. 

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or 

higher level, discard the ink.☞ "6-2-1. Confirmation and disposal of waste ink >>P.116" 

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the 

proper level.☞ "6-2-2. Confirmation and refilling of cleaning solution >>P.117" 

(3) Print out a nozzle check pattern on the color side and verify the result.☞ "7-2-1. Print out of the nozzle check 

pattern (checking on the print heads) >>P.199" 

<TIPS> 

 For the White ink pause mode, print the nozzle check patterns for the head only on the color side. 

(4) If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result 

again.☞ "7-2-2. Head cleaning >>P.201" 

(5) Perform the normal white head cleaning.☞ "7-2-2. Head cleaning >>P.201" 
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As required, make settings and adjustments as mentioned below. 

About menu layer on the setting screen 

Menu Setting screen Description 

[Printer Setting] 

[Print Direction] 

[Auto] 

[Always Bi-Directional] 

[Always Uni-Directional] 

[Back Light] 

[Light High] 

[Light Medium] 

[Light Low] 

[Auto Screen Erase Time] 

[No Auto Screen Erase] 

[5 min] 

[10 min] 

[15 min] 

[30 min] 

[Menu TimeOut Setting] 

[1min] 

[3min] 

[5min] 

[Speaker Volume] 0 to 7 

[Temperature] 
[Fahrenheit] 

[Centigrade] 

[Preview display settings] 
[display it upward] 

[display it downward] 

[File name display setting] 
[Priority to file name display] 

[Priority to job name display] 

[Platen Obstacle sensor] 
[Check when platen is loading] 

[Check during printing as well] 

[Platen too low sensor] 
[Enable] 

[Disable] 

[Low Temperature Mode] 
[Enable(Normal)] 

[Disable] 

[Auto Cleaning Setting] 1 to 24 

[Auto Cleaning Start Timing] 
[Conduct before Printing] 

[Conduct after Printing] 

[Flushing Interval Setting] 

[every 40 lines] 

[normal 22 lines] 

[every 10 lines] 

[every 6 lines] 

[Flushing Volume Setting] 

[More] 

[Standard] 

[Less] 

[Wiping frequency] 

[Standard] 

[Medium-high] 

[High] 

[Auto Job Delete] 
[OFF] 

[ON] 

[IP Address Set] 
[Manual setting] 

[Automatic acquisition] 
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Menu Setting screen Description 

[Printer Setting] 

[Network filtering] 
[Enable] 

[Disable] 

[Shortcut button setting] 

[Normal cleaning] 

[Auto cleaning] 

[Print data Load] 

[White Ink Circulation] 

[Cartridge Attach/Remove Check] 
[Check] 

[No check] 

[CR Speed Adjustment] 
[Start] 

[Start (after cleaning/setup)] 

[Total Print]   

[CTG Attach/Remove History]   

[Check circulation schedule]   

[Temperature/Humidity Info]   

[Confirm network setting] 

[IP Address]  

[Subnet Mask]  

[Default Gateway]  

[Host name]  

[MAC address]  

[Language] 

[English] 

[Español] 

[Français] 

[Deutsch] 

[Italiano] 

[日本語] 

[中文] 

[Türkçe] 

[Русский] 

[한국어] 

[Version] 

[Firm Version]  

[Data Info]  

[Serial No.]  

[Head information]  
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8-1.  Setting the print direction 

(1) From the menu, select [Printer Setting] > [Print Direction], and press . 

(2) Select your desired print direction of the print heads, and press . 

<TIPS> 

 The print direction is displayed here in the form of either bi-directional or the uni-directional icon . 

 Note that the setting of the print direction gives priority to the printer's setting over the setting of the printer driver. 

 The setting content will be kept intact until it is changed for the next printing job. 

 
 

8-2.  Screen back light adjustment 

(1) From the menu, select [Printer Setting] > [Back Light], and press . 

(2) Select your desired brightness of Liquid crystal panel, and press . 

<TIPS> 

 During this menu selection process, the screen is displayed with the selected brightness. 
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8-3.  Setup of Auto Screen Erase Time 

(1) From the menu, select [Printer Setting] > [Auto Screen Erase Time], and press . 

(2) Select your desired time until the liquid crystal panel and print button become unlit, and press . 

<TIPS> 

 During this menu selection process, the currently selected set value is displayed. 

 
 

8-4.  Setting the menu timeout period 

(1) From the menu, select [Printer Setting] > [Menu TimeOut Setting], and press . 

(2) Select the time before the display screen returns to the standby mode screen, and press . 

<TIPS> 

 During this menu selection process, the currently selected set value is displayed. 
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8-5.  Speaker volume adjustment 

(1) From the menu, select [Printer Setting] > [Speaker Volume], and press . 

(2) Adjust the speaker volume in eight-step scale from 0 to 7, and press . 

<TIPS> 

 You can adjust the volume while checking it. 

 
 

 

8-6.  Setup of temperature indication 

(1) From the menu, select [Printer Setting] > [Temperature], and press . 

(2) Select your desired unit of ambient temperature to be shown on the liquid crystal panel, and press . 
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8-7.  Preview display settings 

Set the display direction of the preview image. 

(1) From the menu, select [Printer Setting] > [Preview display settings], and press . 

(2) Select the display direction and press . 

<TIPS> 

 During this menu selection process, the currently selected set value is displayed. 

 
 

8-8.  File name display setting 

Make file name display settings of print data. 

The display name you set is reflected in the selection screen of standby mode or receiving history or the USB memory 

loading screen. 

(1) From the menu, select [Printer Setting] > [File name display setting], and press . 

(2) Select the display method and press . 

<TIPS> 

 The job name is set automatically by the image editing application. 
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8-9. Platen Obstacle sensor 

Specify the detection mode of the obstacle sensor by selecting either [Check when platen is loading] or [Check during 

printing as well]. 

(1) From the menu, select [Printer Setting] > [Platen Obstacle sensor], and press . 

(2) Select the obstacle sensor setting and press . 

<TIPS> 

 During this menu selection process, the currently selected set value is displayed. 

 The obstacle sensor is intended to detect wrinkles of the print media or foreign object on it to prevent the print head from 

contacting wrinkles or foreign matter or minimize the time during which the contact continues. 

 If the print head comes into contact with wrinkles or foreign object, a failure to eject ink-jet droplets or a mechanical failure may 

occur. 

 If the obstacle sensor detects a foreign object, the printing process and the platen operation are immediately stopped. 

 If you select [Check when platen is loading], the obstacle sensor works only while the platen is moving from the front to the rear. 

 If you select [Check during printing as well], the obstacle sensor works during the period from when you press the print button to 

when the printing process completes. 

 
 

8-10. Platen too low sensor 

The sensor is activated if it detects that the print medium is far because the platen is too low. 

Enable or disable this function when using the printer. 

(1) From the menu, select [Printer Setting] > [Platen too low sensor], and press . 

(2) Select the Platen too low sensor function and press . 

<TIPS> 

 The platen too low sensor checks if the platen is too low when it is completely inserted. 

 If the platen too low sensor is activated, the printing process and the platen operation are immediately stopped. 
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8-11.  Print Operation Settings Under Low Temperature 

Configure the printer with automatic switching to low temperature operation mode for ensuring print quality when [Temp 

Low] is displayed on the liquid crystal panel. It is set to [Enable(Normal)], by default. 

If the low temperature operation mode is enabled, the printer will automatically be switched to the low temperature 

operation. Although it can assure print quality, it may take longer time for printing. 

If the low temperature operation mode is disabled, print speed will not slow down; however, poor ejection may occur. 

(1) From the menu, select [Printer Setting] > [Low Temperature Mode], and press . 

(2) Select the print mode under low temperature and press . 

<TIPS> 

 When [Disable] is selected, white ink injection may become unstable when trying to print a wide area. 
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8-12.  Auto Cleaning Setting 

Setting the Number of Printed Sheets for Auto Cleaning 

Specify the number of printed sheets as the frequency of Auto Cleaning; where head cleaning is automatically 

performed every time a predetermined number of sheets are printed in order to protect the printer and provide stable 

printing quality. If the printing quality deteriorates in continuous printing, decrease the number of printed sheets for Auto 

Cleaning. The default value is 24. 

(1) From the menu, select [Printer Setting] > [Auto Cleaning Setting], and press . 

(2) Press  to set up the number of sheets to be printed in the range between 1 and 24, and press . 

<TIPS> 

 The printing quality tends to deteriorate if the humidity is low. 

 If the auto cleaning is performed more frequently, the Wiper cleaner and flushing foam will need to be replaced with a new one 

earlier. 

 
 

Auto Cleaning Start Timing 

Specify your desired auto cleaning start timing. 

(1) From the menu, select [Printer Setting] > [Auto Cleaning Start Timing], and press . 

(2) Select your desired auto cleaning start timing, and press . 

<TIPS> 

 Even when [Conduct after Printing] is selected, Auto Cleaning may be performed before printing, depending on the state of use. 
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8-13.  Flushing Interval Setting 

Perform this if the printing quality deteriorates during printing operations. 

(1) From the menu, select [Printer Setting] > [Flushing Interval Setting], and press . 

(2) Select the desired number of scanning operations until the flushing starts, and press . 

<TIPS> 

 The printing quality tends to deteriorate during the printing operation if the humidity is low. 

 Setting shorter flushing intervals improves the printing quality, however, increases the ink consumption and increases the time 

required for printing. 

 
 

 

8-14.  Flushing Volume Setting 

Perform this if the printing quality deteriorates at the startup of the printing operation. 

(1) From the menu, select [Printer Setting] > [Flushing Volume Setting], and press . 

(2) Select your desired volume of ink to be ejected from the print heads during the flushing operation before the 

printing operation starts, and press . 

<TIPS> 

 The printing quality tends to deteriorate at the startup of the printing operation if the humidity is low. 

 Setting larger flushing volume improves the printing quality, however, increases the ink consumption. 
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8-15.  Wiping frequency settings 

Perform this if the white printing quality deteriorates while printing. 

(1) From the menu, select [Printer Setting] > [Wiping frequency], and press . 

(2) Select the target [Wiping frequency] while printing, and press . 

<TIPS> 

 The printing quality tends to deteriorate while printing if the temperature is low. 

 Frequent wipes will improve the printing quality, which, however, will take more time to print. 

 
 

8-16.  Automatic deletion of print data 

(1) From the menu, select [Printer Setting] > [Auto Job Delete], and press . 

(2) Select the desired function of Auto Job Delete, and press . 

 



 

238 

What to do when needed

8-17.  Static IP address setting 

In the [IP Address Set] window, select the manual setting or automatic acquisition, and set up the [IP Address], [Subnet 

Mask] and [Default Gateway] when you select the manual setting. 

(1) From the menu, select [Printer Setting] > [IP Address Set], and press . 

(2) Select either [Manual setting] or [Automatic acquisition] and press . 

<TIPS> 

 If you select [Automatic acquisition], the screen will go back to the standby mode screen after the settings are automatically 

acquired. 

 

(3) To make manual settings, press  to move to and select your desired position. 

(4) To make manual settings, press  to specify your desired numeric value. 

(5) When the  button is pressed, the selected value is accepted, and the display screen goes to the [IP 

Address], [Subnet Mask] and [Default Gateway] in an orderly manner. 

<TIPS> 

 The display screen shown here has been taken as an example. 
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8-18.  Network filtering settings 

This function will enhance LAN security. Enable or disable this function when using the printer. Setting this function to 

[Enable] will allow access only from subnet mask to which LAN-connected GTX belongs. It is set to [Disable], by default. 

 

(1) From the menu, select [Printer Setting] > [Network filtering], and press . 

(2) Select [Enable] or [Disable] and press . 

 
 

8-19.  Shortcut button setting 

You can set the operation that takes place when the shortcut button on the operation panel is pressed. 

(1) From the menu, select [Printer Setting] > [Shortcut button setting], and press . 

(2) Select the function and press . 

<TIPS> 

 During this menu selection process, the currently selected set value is displayed. 

 If you select [Normal Cleaning], you will be presented with the Normal Cleaning Head Selection menu. 

 If you select [Auto Cleaning], Auto-Cleaning begins. 

 If you select [Print Data Load], you will be presented with the screen to select the print data to load. 

 If you select [White Ink Circulation], the white ink circulation begins. 
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8-20.  Cartridge Attach/Remove Check 

This check function prevents the agitation omission and insufficient agitation of the white ink cartridge. 

Enable or disable this function when using the printer. 

Agitate the white ink cartridge if the white ink cartridge stirring message is displayed.☞ "6-2-3. Daily agitation of the 

white ink >>P.118" 

<TIPS> 

 It takes about 60 to 120 seconds to agitate the W12 or W34 cartridge. 

 If the period in which each cartridge is removed is less than 60 seconds, you cannot move to the next screen by pressing  

while the white ink cartridge stirring message is displayed. 

 

(1) From the menu, select [Printer Setting] > [Cartridge Attach/Remove Check], and press . 

(2) Select either [Check] or [Uncheck] and press . 

 
 

8-21.  Display of total printed sheets 

On this display screen, the total number of printed sheets is shown. 

(1) From the menu, select [Total Print], and press . 

(2) Then, the total number of printed sheets is displayed. 

<TIPS> 

 Only the number of printed sheets of which printing has succeeded is counted, in which the canceled number of sheets is 

not included. 

 All the printed sheets involved in printing operation, including test print, are counted. 

 The display screen shown here has been taken as an example. 

 The count of total number of printed sheets cannot be reset. 

 



 

241 

What to do when needed

8-22.  Cartridge Attach/Remove Check History 

This function makes it possible to display records on the state of the white ink cartridge removed for 60 seconds or more. 

You can use this function to check whether the agitation of the white ink cartridge is performed regularly. 

 

(1) From the menu, select [Cartridge Attach/Remove Check History], and press . 

(2) The cartridge attach/remove check history is displayed, and you can use the  keys to see the records on 

cartridge attachment and removal. 

 
 

8-23.  Check circulation schedule 

White ink circulation can be performed at a specified time. 

 

(1) From the menu, select [Check circulation schedule], and press . 

(2) Display the circulation schedule. 

<TIPS> 

 If the scheduled time of white ink circulation is not set with the maintenance tool, the circulation schedule will not be displayed. 
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8-24.  Display of Temperature/Humidity Info 

On this display screen, the ambient temperature and humidity are shown. 

(1) From the menu, select [Temperature/Humidity Info], and press . 

(2) Then, the ambient temperature and humidity are displayed. 

<TIPS> 

 Make the setting of temperature indication unit in the Temperature window. 

 The display screen shown here has been taken as an example. 
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8-25.  Confirm network setting 

In the [Confirm network setting] window, display the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and 

[MAC address]. 

(1) From the menu, select [Confirm network setting], and press . 

(2) Select one out of the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and [MAC address], and press 

. 

 

(3) Display [IP Address], [Subnet Mask], [Default Gateway], [Host name], or [MAC address].  

<TIPS> 

 The display screen shown here has been taken as an example. 
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8-26.  Language setting 

Select your desired language to be shown on the liquid crystal panel. 

(1) From the menu, select [Language], and press . 

(2) Select your desired language in the [Language] window, and finalize your setting by pressing . 

(3) Follow the on-screen message, and turn off the power and on again. 
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8-27.  Display of version 

On this display screen, the firmware's version information, [Firm Version], as well as [Data Info] and [Serial No.], are 

shown. 

(1) From the menu, select [Version], and press . 

(2) In the window shown below, select one of the [Firm Version], [Data Info] and [Serial No.], and press . 

 

(3) Then, one of the [Firm Version], [Data Info] and [Serial No.] will appear. 

<TIPS> 

 Pressing the  button  causes the currently displayed window to go back to the [Version] window. 

 The display screen shown here has been taken as an example. 
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8-27-1.  Updating of firmware 

When a new firmware is released, please update the firmware. 

<TIPS> 

 To check any release information of a new firmware, please visit the website of Brother Industries, Ltd. 

 

(1) Download the firmware's updated data from the website of Brother Industries, Ltd. 

(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Firmware Update" from "Brother GTX pro 

Tools". 

(3) Specify the firmware's updated data (.bwf). 

 

(4) Make a connection of the USB 2.0 cable or LAN cable between your PC and the printer, and update your firmware 

by performing the on-screen procedures. 
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CAUTION 

 
Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand 

may get caught between the platen and an object, which may result in injury. 

 
Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and 

the covers, it may be injured. 

 
Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may 

touch against moving parts and this may result in injury. 

 
Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your 

fingers. 

 
When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may 

be injured. 

 
Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They 

may cause diarrhea or vomiting. 

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution, 

pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately 

rinse the eyes with water. 

Keep the liquids out of the reach of children. 

 
Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your 

eyes or onto your skin. 

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting. 

Keep the liquids out of the reach of children. 

 
When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother 

will not be held responsible for any accidents or problems resulting from the use of non-genuine parts. 

 
When replacing parts or installing optional accessories, be sure to follow the procedures described in the 

Instruction Manual. Incorrect procedures could cause injuries or problems. 

 

IMPORTANT 

 
Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged. 

 



 

248 

Troubleshooting

9-1.  Troubleshooting instructions 

With reference to the descriptions below, troubleshoot your problem. 

No print data can be sent from PC 

Probable Cause Remedy Reference 

Have you selected an incorrect 

printer or not? 

From the menu for printing, check your printer name. 
- 

Has a USB or LAN cable been 

connected properly? 

Ascertain that connection of the USB 2.0 cable or the 

LAN cable has been made correctly. 
- 

Are you using such PC or OS that 

is outside the specification? 

Check your PC's operating environment. "11-2. Software >>P.351" 

Are you using such a USB 2.0 

cable that is outside the 

specification? 

Use a 2.0 cable that is compliant with the 

specification. 

"1-3. Other items you 

must make available for 

use >>P.22" 

Has any noise been produced 

between the printer and your PC? 

Remove the USB 2.0 cable/LAN cable first, then 

make a connection of it once again in five seconds. If 

the problem continues, power off the printer first, then 

reactivate it in five seconds. 

- 

Does your PC function properly? Restart the PC. - 

Has any other USB device been 

connected to your PC?  

Remove the other USB device, restart the PC, and 

check to see if the printer functions properly. 
- 

Has the USB cable/LAN cable 

been damaged? 

Use a different USB or LAN cable. 
- 

 

No printing job gets started even after pressing the print button 

Probable Cause Remedy Reference 

Is the print scheduled (is the button 

flashing fast)? 

The print begins as soon as the printer becomes 

available. Wait for a while. 
- 

Is any error message displayed? Eliminate the cause of the error, and perform printing 

once more.. 

"10. Error message 

>>P.311" 

Does the menu screen still appear 

on the screen, or are you 

performing the maintenance 

operation from the menu? 

Please exit the menu. Alternatively, please wait until 

the maintenance operation will come to an end. 
- 

Is the automatic head cleaning 

operation underway? 

Please wait until the ongoing head cleaning 

operation is completed. 
- 

Is the printer in the white ink 

circulation stage? 

Please wait until the ongoing white ink circulation is 

completed. 
- 

Is the room temperature suited to 

the usage conditions? 

Check for your PC's operating environment and 

adjust the room temperature. 

"11-1. Apparatus >>P.350"

Does the printer receive no print 

data, or is it in the state to receive 

such data (the print button is not 

illuminating)? 

Send the print data to the printer. Alternatively, please 

wait until the reception of print data is completed. 
- 

Do you find that the temperature of 

print heads is 

becoming high, and [Color Head 

Getting Warm] or [W Head Temp 

Rising] message appears? 

There may be the possibility that the flat cables of 

print heads have not been put in place and the 

temperature of print heads has become high. 

Turn off the power, make sure that the flat cable is in 

place, and wait until the temperature decreases. 

- 
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The power cannot be turned on 

Probable Cause Remedy Reference 

Is the power cord connected to 

the printer? 

Make sure that the power cord is connected to the 

printer. 
- 

Is the front cover closed firmly? Close the front cover properly. - 

 

An error occurs immediately after activating the printer 

Probable Cause Remedy Reference 

Is any error message displayed? Check the content of the error, and restart the printer. 

If the error is still not eliminated, please contact your 

dealer or Brother. 

"10. Error message 

>>P.311" 

 

No print data can be loaded from USB flash memory 

Probable Cause Remedy Reference 

Has the USB flash memory been 

inserted into its insertion slot 

properly? 

Insert the USB flash memory into the insertion slot 

firmly. - 

Is the applicable file ARP or AR3 

file? 

This printer cannot print out the print data of 

GT-541/GT-782/GT-3. Recreate the print data. 
- 

Is your USB flash memory suited 

to required conditions? 

Please use a FAT32-formatted USB flash memory of 

which storage capacity ranges from 2 GB to 32 GB. 

You cannot use a USB memory with security functions 

such as password lock or beyond 32 GB. 

- 

Has your USB flash memory 

been broken? 

Check to see if it functions properly using your PC or 

the like. 
- 

 

Neither uni-directional printing nor bi-directional printing can be performed 

Probable Cause Remedy Reference 

Do the settings of printer driver 

and printer agree with each 

other? 

Note that the setting of the printer's setting has priority 

over the setting of printer driver. The printer driver's 

setup value takes effect only if the printer's setting is 

[Auto].  

"8-1. Setting the print 

direction >>P.229" 
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The depletion of ink in an ink pouch cannot be detected 

Probable Cause Remedy Reference 

Is an ink pouch in its correct 

position? 

If the ink pouch is in contact with the side of the ink 

cartridge case, detection may not be performed 

correctly.  

Put a proper ink pouch in its correct position. 

"7-1-1. Replacement of 

ink pouch with a new one 

>>P.169" 

After stirring the white ink, is the 

lid of the ink cartridge opened 

and the pouch placed in the 

correct position? 

Open the lid of the white ink cartridge and 

appropriately rewind the ink pouch. Ink might have 

entered into the wound section of the pouch when 

stirred, which could have caused improper winding of 

the pouch. 

"6-2-3. Daily agitation of 

the white ink >>P.118" 

 

"x" is displayed for the remaining ink level after replacing the ink pouch 

Probable Cause Remedy Reference 

Is a wrong color of an ink pouch 

installed? 

Put an ink pouch in its correct position. If colors are 

mixed on the print result or within the ink pouch, 

please contact your dealer. 

- 

 

Remaining volume indication of the ink pouch does not reflect the actual status 

Probable Cause Remedy Reference 

Didn't you replace an ink pouch in 

the way of use? 

If you take out an ink pouch that still has much amount 

of remaining ink in the way of use, then set a different 

ink pouch or the original used ink pouch back to the 

printer, it can indicate a different volume from the 

actual remaining volume. If you keep on using it and 

the volume is reduced to some extent, the correct 

remaining volume will be displayed again. 

- 
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9-2.  Solutions to print quality problems 

With reference to the descriptions below, troubleshoot your problem. 

Print is too light 

Probable Cause Remedy Reference 

Is the setting of an image editing 

software application made 

improperly, or is an image placed 

in CMYK mode? 

Edit the image. "5-3. Using other 

applications >>P.70" 

Have the printing conditions been 

applied improperly, or does your 

image data have insufficient color 

saturation?  

Using [Color Processing], adjust saturation or contrast 

as appropriate. 

"5-4-9. Set up the image 

quality >>P.103" 

Is a sufficient amount of ink left in 

a cartridge? 

Replace the old ink pouch with a new one. "7-1-1. Replacement of 

ink pouch with a new one 

>>P.169" 

Is there any nozzle that does not 

eject ink-jet droplets? 
Perform [Head Cleaning] from the menu.  

If no improvement is attained, follow the referenced 

instructions. 

"9-2-1. Recovery action to 

be taken for such a nozzle 

that is unable to eject 

ink-jet droplets >>P.257" 

Is initial settings after head 

replacement configured? 

With reference to, configure the initial settings after 

head replacement. 

"7-4-2. Initial settings after 

head replacement 

>>P.217" 

Isn't the [Low Temperature Mode] 

set to [Disable]? 

Change the setting to [Enable (Normal)]. "8-11. Print Operation 

Settings Under Low 

Temperature >>P.234" 

 

Horizontal stripe (banding) is found on printed material 

Probable Cause Remedy Reference 

Is there any nozzle that does not 

eject ink-jet droplets? 

Perform [Head Cleaning] from the menu. 

If no improvement is attained, follow the referenced 

instructions. 

"9-2-1. Recovery action to 

be taken for such a nozzle 

that is unable to eject 

ink-jet droplets >>P.257" 

Do you print ink dots on a highly 

water-absorbing print medium? 

Set the print head's print direction to [Always 

Uni-Directional]. 

Also, combine the color multiple pass printing with 

the printing. 

"8-1. Setting the print 

direction >>P.229" 

"5-4-6. Specify whether or 

not to perform Multiple 

Pass Printing >>P.98" 

Is the platen positioned at too low 

level? 

Adjust the height of the platen corresponding to the 

print medium before using it. You can use the platen 

height adjustment lever to adjust the height of platen. 

As a rough indication, adjust the height so that it is 

lowered by one step from the limit height detected by 

the obstacle sensor, and check that the platen is not 

detected by the sensor. 

"6-5. Placing print medium 

in position >>P.148" 

Is the firing timing well-timed? Adjust the ejection timing again. It is likely that the 

setup value is incorrectly set after replacing a print 

head or the platen with a new one, or after adjusting 

the platen height. 

"7-4-3. Firing adjustment 

>>P.218" 



 

252 

Troubleshooting

Probable Cause Remedy Reference 

Is platen feed adjusted? Perform the platen feed adjustment. It is likely that 

the setup value is incorrectly set after replacing a 

print head or the platen with a new one. 

"7-4-4. Platen-rolling 

adjustment >>P.219" 

Is the [White High Speed Print] 

check box of the print data turned 

on? 

Turn off the [White High Speed Print] check box to 

create the print data. 

"5-4-4. Set up the white 

ink >>P.94" 

Isn't the temperature low? Change the wiping frequency setting. "8-15. Wiping frequency 

settings >>P.237" 

Isn't the [Low Temperature Mode] 

set to [Disable]? 

Change the setting to [Enable (Normal)]. "8-11. Print Operation 

Settings Under Low 

Temperature >>P.234" 

 

Blurring is observed (when printed with [Color Ink Only]) 

Probable Cause Remedy Reference 

Isn't the amount of ink excessive 

against the print media? 

Print the ink volume and check the blurring, and select 

appropriate set value for [Ink Volume:]. 

"5-5-5. Adjust the ink 

volume >>P.109" 

"5-4-7. Set up the color ink 

>>P.99" 

 

Blurring is observed (when printed with [Color+White Ink]) 

Probable Cause Remedy Reference 

Is the [Highlight:] of [White Ink 

Settings:] too high? 

Print the highlight check pattern to check the blurring, 

and select appropriate set value for [Highlight:]. 

"5-5-6. Print out of 

highlight check 

pattern/mask check 

pattern >>P.110" 

"5-4-4. Set up the white 

ink >>P.94" 

By turning ON the [White/Color Pause] or [Color 

Multiple Pass Printing] checkbox, extend time before 

the color ink settles onto the white ink, to prevent 

blurring. Try this method to eliminate blurring without 

weakening the highlight. 

"5-4-8. Set up the white 

ink >>P.100" 

"5-4-6. Specify whether or 

not to perform Multiple 

Pass Printing >>P.98" 
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Ink sticks to such an area where no print data exists (ink stain, horizontal stripe, etc.) 

Probable Cause Remedy Reference 

Is the area around the print heads 

soiled with waste ink spilled from 

the wiper cleaner or head cap? 

Clean the head section and suction cap. 

Furthermore, replace the wiper cleaner with a new 

one. 

"7-1-3. Cleaning the 

nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174" 

"7-1-4. Replacing the 

wiper cleaner >>P.186" 

Is any lint attached to the nozzle 

surface? 

Clean the nozzle guard. "7-1-3. Cleaning the 

nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174" 

Is the carriage plate contaminated? Clean the carriage plate. "7-2-4. Cleaning the CR 

(carriage) plate >>P.204" 

Do the print heads rub against a 

T-shirt? 

Flatten the surface of T-shirt, and adjust the platen's 

height as required. 

"6-5. Placing print medium 

in position >>P.148" 

Has the flushing foam become 

dirty? 

Replace the flushing foam with a new one. "7-1-5. Replacing the 

flushing foam >>P.189" 

Has the platen sheet become 

dirty? 

Replace the platen sheet with a new one. "7-2-5. Replacing the 

platen sheet >>P.207" 

Has any ink attached to the 

carriage that secures the print 

heads in place or is it dripping off? 

Perform the cleaning of the carriage plate and 

remove the accumulated ink. 

"7-2-4. Cleaning the CR 

(carriage) plate >>P.204" 

 

The edges of the image are blurred, characters and straight lines are doubly printed and printed 

result appears too granular 

Probable Cause Remedy Reference 

Is the platen positioned at a level 

that is too low? 

Adjust the height of the platen corresponding to the 

print medium before using it. You can use the platen 

height adjustment lever to adjust the height of platen. 

As a rough indication, adjust the height so that it is 

lowered by one step from the limit height detected by 

the obstacle sensor, and check that the platen is not 

detected by the sensor.  

"6-5. Placing print medium 

in position >>P.148" 

Is the firing timing correct? Adjust the ejection timing again. It is likely that the 

setup value is incorrectly set after replacing a print 

head or the platen with a new one, or after adjusting 

the platen height. 

"7-4-3. Firing adjustment 

>>P.218" 

Is the image enlarged on the 

printer setting screen? 

When a low resolution image is enlarged on the 

printer setting screen, it may blur or angle the image. 

Pattern data should be enlarged on an image editing 

application, and its roughness should be checked. 

- 
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Thin color cannot be printed out well gradually 

Probable Cause Remedy Reference 

Is the ambient atmosphere at a 

high temperature and very dry, 

which in turn tends to cause the 

nozzle surface to dry up? 

Perform the flushing more frequently. In addition, 

increase the flushing volume. 

"8-13. Flushing Interval 

Setting >>P.236" 

"8-14. Flushing Volume 

Setting >>P.236" 

 

White ink is not printed out evenly 

Probable Cause Remedy Reference 

Has the pretreatment been 

applied unevenly? 

Apply the recommended amount of pretreatment 

evenly to the target area. 

"6-3-3. Application of 

pretreatment >>P.126" 

Has the pretreatment caused any 

change in hardness or 

deformation of the pretreatment 

roller? (This applies to the case 

where the pretreatment roller is 

used.) 

After the pretreatment roller is used, put it in a plastic 

bag or the like hermetically to prevent it from drying 

up, and keep it in a flat place in an upright position. 

Also, when it remains unused for two weeks or 

longer, wash it well with running water, and let it dry in 

a shaded area. 

- 

Is any water content attached to 

the pretreatment roller after the 

pretreatment is fixated? 

Prevent water content from being attached to the 

roller after the pretreatment is fixated.  

"6-3-4. Fixation of 

pretreatment >>P.132" 

Is there any lint, yarn waste, dust, 

etc. that are attached to the 

surface of pretreatment roller? 

(This applies to the case where 

the pretreatment roller is used.) 

Clean the surface of the pretreatment roller. "6-3-3. Application of 

pretreatment >>P.126" 

Did you shake the pretreatment 

after its dilution? 

Shake the pretreatment sufficiently. "6-3-2. Dilution of 

pretreatment >>P.124" 

Is the [Low Temperature Mode] 

set to [Disable]? 

Change the setting to [Enable (Normal)]. "8-11. Print Operation 

Settings Under Low 

Temperature >>P.234" 

Has the pretreatment been fixated 

insufficiently? 

Check on an actual temperature of the heat press 

and its pressure during the fixation stage. 

Always keeping the lower iron (where media is 

placed) of the heat press at heated temperature with 

a heating source may solve this problem. 

"6-3-4. Fixation of 

pretreatment >>P.132" 

 

Whiteness of print result is insufficient 

Probable Cause Remedy Reference 

Has the pretreatment been 

applied insufficiently? 

Apply a proper amount of pretreatment. "6-3-3. Application of 

pretreatment >>P.126" 

Has the pretreatment been fixated 

insufficiently?  

Check on an actual temperature of the heat press 

and its pressure during the fixation stage. 

"6-3-4. Fixation of 

pretreatment >>P.132" 

Is there any nozzle that does not 

eject ink-jet droplets? 

Perform [Head Cleaning] from the menu.  

If no improvement is attained, follow the referenced 

instructions. 

"9-2-1. Recovery action to 

be taken for such a nozzle 

that is unable to eject 

ink-jet droplets >>P.257" 

Is the white ink circulated 

insufficiently? 

From the menu, select [Maintenance] > [White Ink 

Circulation] to circulate the white ink properly. 
- 
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Probable Cause Remedy Reference 

Is the white ink stirred 

insufficiently? 

In the event that the white ink remains accumulated in 

the bottom of the ink pouch, shake the pouch 100 

times and additionally shake it until the ink is stirred 

well.  

Also, when the remaining ink level becomes 

approximately 5.9 in. (15 cm), shake the cartridge 

with its cover open and with the edge of the ink pouch 

slightly winded. 

- 

Is the [Low Temperature Mode] 

set to [Disable]? 

Change the setting to [Enable (Normal)]. "8-11. Print Operation 

Settings Under Low 

Temperature >>P.234" 

Is the dilution rate of the 

pretreatment correct? 

Dilute the pretreatment appropriately. "6-3-2. Dilution of 

pretreatment >>P.124" 

Is the [Highlight:] of [White Ink 

Settings:] too low? 

Print the highlight check pattern to check the blurring, 

and select appropriate set value for [Highlight:]. 

"5-5-6. Print out of 

highlight check 

pattern/mask check 

pattern >>P.110" 

"5-4-4. Set up the white 

ink >>P.94" 

 

Too much luster 
Probable Cause Remedy Reference 

Are you using Teflon-treated 

peel-off sheet for fixation? 

Use a silicon coated peel off sheet when curing the 

ink to reduce the gloss. 
- 

 

Too fuzzy 
Probable Cause Remedy Reference 

Did you touch the print media 

(T-shirt) just before printing? 

Excessively touching the media (T-shirt) on the 

platen by trying to flatten the media before printing 

could cause fuzziness. Make sure not to touch the 

media surface too much after the pretreatment is 

fixated. 

- 

Does it take a long time before 

printing, after the pretreatment 

fixation? 

Leaving the print media (T-shirt) after fixing the 

pretreatment may cause fuzziness, because the 

media would absorb water. Print the pretreatment 

fixated media as soon as possible. 

- 

Is the upper iron on the heat press 

contaminated during the 

pretreatment fixation process? 

If the upper iron is contaminated, it could roughen the 

print media (T-shirt) surface by a heat press process, 

to cause fuzziness. Clean the upper iron of the heat 

press with a cloth. 

If the condition persists, try using a peel-off sheet 

during the pretreatment fixation process, to probably 

improve the condition. 

- 

Unevenly dried during the fixation 

process? 

It may be solved by inserting a silicone foam 

between the heat press lower iron and a print media 

(T-shirt) during ink fixation. 

- 
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Background white ink spreads out when printed with [Color+White Ink] 
Probable Cause Remedy Reference 

[White/Color Alignment] 

misaligned? 

Misalignment of white and color inks can occur when 

the media thickness or the platen height is changed. 

Adjust the platen height first for the actual media to be 

printed, and align the white and color inks positions. 

"7-4-5. White/color 

alignment >>P.220" 

Is the media easy to stretch when 

wet? 

Print misalignment may occur between white and 

color inks when the media stretches when wet with 

white ink. Increasing [Choke Width:] can prohibit 

spreading of the background white ink.  

"5-4-8. Set up the white 

ink >>P.100". 

 

Printed surface cracks after fixation 
Probable Cause Remedy Reference 

Isn't the print surface folded before 

fixation is completed? 

Try not to touch the print surface until the fixation 

process is completed. 
- 

 

The lower left side area of the printer's main unit is soiled with ink 
Probable Cause Remedy Reference 

Is the waste ink tube dismounted 

from the maintenance unit? 

For help, please contact your dealer. 
- 

Is the waste ink tube clogged 

causing the waste ink to flow 

reversely? 

Straighten the waste ink tube to remove the clog. 

 - 

 

The cleaning solution is leaked from the cleaning liquid tank 
Probable Cause Remedy Reference 

Is the main body of printer put 

aslant? 

Place the printer horizontally. 

If the problem is still not remedied, please contact your 

dealer. 

"4-1. Installation of printer 

>>P.38" 

 

Takes longer print time than before 

Probable Cause Remedy Reference 

Is the ambient temperature under 

18°C (64.4°F)? 

Adjust the room temperature to 18°C (64.4°F) or 

more. 

If it is difficult to adjust the room temperature, set the 

operational configuration under low temperature to 

[Disable]. 

"8-11. Print Operation 

Settings Under Low 

Temperature >>P.234" 

Is your printing under 

high-temperature and low humidity 

environment? 

Lower your room temperature below 30°C (86°F). 

Raise your room humidity over 35%. - 

Is the wiping frequency set to 

[Medium-high] or [High]? 

Change the wiping frequency to [Standard]. 
- 
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9-2-1.  Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets 

Please verify the followings when any nozzle is not ejecting ink droplets. 

Items to be checked Description Remedy Document 

Is the cap contaminated? 

When the cap is contaminated, it cannot fully 

contact the head, which would lead to 

suction failure. 

Clean the cap 

Refer to "7-1-3. Cleaning 

the nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174". 

Is there any deposit of ink 

around the nozzle 

surface? 

When the surrounding area of nozzle 

surface is contaminated, it could lead to 

ejection failure since the wiper cannot clean 

the nozzle surface properly. Or, it could 

reduce the adhesion between the nozzle 

and cap, thereby causing ink suction failure.

Cleaning the 

surrounding area 

of nozzle surface 

Refer to "9-2-4. Cleaning 

the surrounding area of 

nozzle surface >>P.271" 

Is the wiper contaminated? 

When the wiper tip is contaminated, it could 

lead to ejection failure since the wiper 

cannot clean the nozzle surface properly. 

Clean the wiper 

Refer to "7-1-3. Cleaning 

the nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174". 

Is there any indication of 

scar or deformation on the 

wiper? 

When the wiper has any scar or 

deformation, it could lead to ejection failure 

since the wiper cannot clean the nozzle 

surface. 

Replace the 

wiper 

Refer to "9-2-7. Replacing 

the Wiper >>P.303". 

Is the wiper cleaner 

contaminated? 

If the wiper cleaner is contaminated, residual 

dirt on the wiper may prohibit the wipers 

cleaning function. 

Replacing the 

wiper cleaner 

Refer to "7-1-4. Replacing 

the wiper cleaner >>P.186".

Is the wiper cleaner dried? 
If the wiper cleaner is dry, it may prohibit the 

wiper's proper function to wipe clean. 

Replacing the 

wiper cleaner 

Refer to "7-1-4. Replacing 

the wiper cleaner >>P.186".

Is the flushing foam 

floated? 

If the flushing foam is not placed 

appropriately, it may touch the nozzle 

surface to stop ejection from the nozzle. 

Replace the 

flushing foam 

Refer to "7-1-5. Replacing 

the flushing foam >>P.189".

Is the ink accumulated on 

the flushing foam? 

If an ink accumulates on the flushing foam, 

the ink may touch the nozzle surface to 

prevent ink from ejecting. 

Replace the 

flushing foam 

Refer to "7-1-5. Replacing 

the flushing foam >>P.189".

Is the tube correctly 

connected to the head? 

If they are loosely mated, it may allow air to 

enter into the head section during the head 

cleaning operation, to cause non-ejection 

condition of the nozzle. 

Verify connection 

between the 

head and the 

tube 

Refer to "9-2-6. 

Replacement of print head 

>>P.277". 

Is the ink pouch properly 

attached to the cartridge? 

If the ink pouch is not properly installed, the 

cartridge cannot fully wind it, and fails to 

supply enough ink to the head. 

Install an ink 

pouch 

Refer to "7-1-1. 

Replacement of ink pouch 

with a new one >>P.169". 

Is the tube filled with ink? 

If a large amount of air exists in the tube, that 

air will go into the head to cause 

non-ejection condition of the nozzle. 

Re-install the ink 
Refer to "9-2-8. Re-install 

the ink >>P.308". 

 

After carrying out appropriate remedial measures listed above, make sure the non-firing nozzle has been recovered. If it 

has not, perform the steps 1 to 5 to recover the non-firing nozzle. 
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Step 1: Print out a nozzle check pattern 

(1) Print out a nozzle check pattern (1st time).☞ "7-2-1. Print out of the nozzle check pattern (checking on the print 

heads) >>P.199" 

(2) Check the result of the printed nozzle check pattern (1st time), and carry out the following procedures.☞ "7-2-1. 

Print out of the nozzle check pattern (checking on the print heads) >>P.199" 

<TIPS> 

 Even if the white print result is weak, since the white ink is ejected on one same spot through multiple nozzles, a relatively 

large amount of ink volume will be used, and the firing problem of a single nozzle will not affect the print quality so much. 

Even in a condition with weak lines, the print is performed without a problem. 

 

Existence or nonexistence of a 

nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 

does not eject any ink-jet droplets 

If a number of non-firing of white head is observed in printing although such 

non-firing problems do not occur in nozzle check pattern printing, please 

contact your dealer.  

If a number of non-firing of white head is observed in printing although such 

non-firing problems do not occur in nozzle check pattern printing, replace 

the filter. ☞"9-2-5. Replacing the color filter >>P.274" If non-firing cannot be 

resolved after replacing the filter, please contact your dealer. 

Such a nozzle exists that does not 

eject any ink-jet droplets 

Proceed to Step 2. 
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Step 2: Perform the head cleaning 

(1) Perform a normal cleaning.☞ "7-2-2. Head cleaning >>P.201" 

(2) Print out a nozzle check pattern (2nd time). 

(3) Check the result of the printed nozzle check pattern (2nd time), and carry out the following procedures. 

Existence or nonexistence of a 

nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 

does not eject any ink-jet droplets 

Exit 

Ten-or-less nozzles exist that do 

not eject any ink-jet droplets 

Perform the normal cleaning once again. Subsequently, proceed to (4). 

Ten-or-more nozzles exist that do 

not eject any ink-jet droplets 

Perform the powerful cleaning. Subsequently, proceed to (4). 

More than half of the nozzles of 

the color heads have a problem 

concerning firing of the print 

heads. 

Re-install the ink. ☞"9-2-8. Re-install the ink >>P.308" 

Subsequently, proceed to (4). 

More than half of the nozzles of 

the white heads have a problem 

concerning firing of the print 

heads. 

Clean the white heads. ☞"9-2-2. White head cleaning >>P.262" 

Subsequently, proceed to (4). 

(4) Print out a nozzle check pattern (3rd time). 

(5) Check the result of the printed nozzle check pattern (3rd time), and carry out the following procedures. 

Existence or nonexistence of a 

nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 

does not eject any ink-jet droplets 

Exit 

Such a nozzle exists that does not 

eject any ink-jet droplets 

Proceed to Step 3. 
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Step 3: Check that no ink-jet droplets are ejected from the applicable nozzle 

(1) Check locations of the non-ejecting nozzles on the result of the printed nozzle check pattern (1st to 3rd time), and 

carry out the following procedures. 

Comparison of non-ejection nozzle 

positions 
Recovery action 

The same nozzle always does not 

eject ink-jet droplets 

Perform the super cleaning -> print out of nozzle check pattern for the third 

time in a row. 

A different nozzle does not eject 

ink-jet droplets 

Leave the printer as it is for about 30 minutes, and perform the normal 

cleaning -> print out of nozzle check pattern for the third time in a row. 

(2) Check a result of the resultant nozzle check patterns, and carry out the following procedures. 

Existence or nonexistence of a 

nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 

does not eject any ink-jet droplets 

Exit 

Such a nozzle exists that does not 

eject any ink-jet droplets 

Proceed to Step 4. 

 

Step 4: Clean the nozzle surface 

(1) Clean the nozzle surface of the print heads.☞ "9-2-3. Cleaning of head nozzle >>P.268" 

(2) Print out a nozzle check pattern. 

(3) Check a result of the resultant nozzle check patterns, and carry out the following procedures. 

Existence or nonexistence of a 

nozzle that does not eject any 

ink-jet droplets 

Recovery action 

Such a nozzle does not exist that 

does not eject any ink-jet droplets 

Exit 

Such a nozzle exists that does not 

eject any ink-jet droplets 

Proceed to Step 5. 

 

<IMPORTANT> 

 Even if the nozzles on the white side have a bit of problem concerning firing, since the white ink is ejected on one same 

spot through multiple nozzles, relatively large amount of ink volume will be used, and firing problem of a single nozzle will 

not affect the print quality so much. Even in a condition with a problem concerning firing as shown in (a), print is performed 

without a problem as shown in (b). 

 

(a) (b) 
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Step 5: Head Replacement 

(1) Replace the print head with a new one.☞ "9-2-6. Replacement of print head >>P.277" 
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9-2-2.  White head cleaning 

If a problem concerning firing of the white head side is not cleared even after performing the head cleaning, perform the 

white head cleaning. 

After the white head cleaning is completed, conduct the Install White Ink After Cleaning. 

<TIPS> 

 Although the white head cleaning can begin even when the remaining volume of maintenance solution in the maintenance 

solution pouch is running short, there may be cases where the pouch needs to be replaced with a new one during the cleaning 

depending on such remaining volume. If the remaining volume is 500 g (17.6 oz) or less, prepare a new maintenance solution 

pouch. 

 When the white ink pouch runs low on its remaining volume of white ink, the Install White Ink After Cleaning function can no 

longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the installation 

process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch. 

White Head Cleaning 

(1) From the menu, select [Maintenance] > [White Head Cleaning], and press . 

<TIPS> 

 Perform the work operation by following the on-screen instructions. 

(2) After making sure that the waste ink tank is filled one-half or less full with waste ink, and press . 

(3) Take out the white ink cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0333 

White Ink Cartridge
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(4) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the 

lid. 

(a)

X0042 

(5) Pinch the latch at the front end of ink pouch, and draw out the white ink pouch from the cartridge. 

<CAUTION> 

 Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular 

basis. 

X0119 

(6) Put the maintenance solution pouch in the cartridge. 

Push the tip end of the maintenance solution pouch into the cartridge until it clicks into place. 

Straighten the maintenance solution pouch in such a manner that it will be aligned with the gutter of the lid of the cartridge, and 

mount in position by pulling it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

Maintenance solution pouch

Cartridge

LidCartridge

Latch Lid

White ink pouch

Cartridge 

Cartridge's tip end 

Latch

Stretch
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(7) Put the maintenance solution pouch in its correct position. 

<CAUTION> 

 Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand. 

X0041

(a)

 

(8) Close the lid, and put the maintenance solution cartridge in position inside the printer. 

(9) Repeat the same process to replace the other white ink cartridge with the maintenance solution pouch. 

(10) On the operation panel, press . 

Then, the white head cleaning will be performed. 

<TIPS> 

 White head cleaning will take approximately 25 minutes. Perform the "Install White Ink After Cleaning" operation by 

following the on-screen instructions. 

Place the pouch in a straight alignment with the cartridge

Align lines with 

each other 
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Install White Ink After Cleaning 

(1) Make sure the message [Install White Ink After Cleaning] is displayed on the liquid crystal panel. 

<TIPS> 

 Perform the work operation by following the on-screen instructions. 

(2) Take out the maintenance solution cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0333 

(3) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the 

lid. 

(a)

X0042 

Maintenance solution cartridge

Lid
Cartridge

Latch Lid
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(4) Take out the maintenance solution pouch from the cartridge, and put the white ink pouch in place. 

Push the tip end of ink pouch into the cartridge until it clicks into place. 

Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of the cartridge, and mount in position by 

pulling it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

(5) Put the white ink pouch in its correct position. 

<CAUTION> 

 Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand. 

X0041

(a)

 

(6) Shake the cartridge 100 times side to side to stir the ink. 

<IMPORTANT> 

 The white ink cartridge should be held horizontally when shaking it. 

 Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch. 

<NOTE> 

 Wear the provided gloves when performing this task. 

 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the 

edge of the ink pouch slightly winded, to make the ink easier to stir. 

X0194 

White ink pouch 

Cartridge

Place the pouch in a straight alignment with the cartridge

Align lines with 

each other 

White Ink Cartridge 
Ink pouch

Edge of the rib

Remaining ink volume should 

be approx. 5.9 in. (15 cm) 
Shake 100 times (for approx. 50 seconds) 

(Swing distance should be approx. 2 in. (5 cm). 

Increase the swing distance when the remaining 

ink level becomes low.) 

Stretch
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(7) Open the lid of the cartridge and place the ink pouch in its correct position. 

<IMPORTANT> 

 Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow 

into the wound section of the pouch when stirred, which can cause improper winding of the pouch. 

 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge 

downward and open the lid. 

 When setting the ink pouch, avoid unevenness or wrinkles on the pouch. 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

<NOTE> 

 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid. 

(a)

X0182 

X0078 

X0142 
(8) Close the lid, and put the white ink cartridge in position inside the printer. 

<IMPORTANT> 

 W12 and W34 cartridges should correctly be placed in their original locations. Wrongly placed cartridges could cause a 

printer malfunction. 

(9) Repeat the same process to replace the other maintenance solution cartridge with the white ink pouch. 

(10) Check the waste ink tank level and take any necessary measure for it, if any, then press  on the operation panel. 

After the cleaning is completed, the Install White Ink After Cleaning function will get started. 

<TIPS> 

 The "Install White Ink After Cleaning" operation will take approximately 15 minutes. After the procedures are completed, the 

current screen will go back to the standby mode screen. 

Place the pouch in a straight alignment with the cartridge

Latch Lid 

No wrinkles

Not sagged

Ink pouch

LidCartridge
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9-2-3.  Cleaning of head nozzle 

If a problem of non-ejection of ink-jet droplets is not cleared even after performing the head cleaning, perform the head 

nozzle cleaning. 

<IMPORTANT> 

 Clean the nozzle guard first, then clean the head nozzle. ☞ "7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction 

cap >>P.174" 

(1) Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available 

for use. 

<IMPORTANT> 

 Use a new clean stick R when you start cleaning. 

 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may 

result in the printer malfunction. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select 

[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink 

from drying up. 

(4) Open the front cover. 

X0331 

Front cover
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(5) Put a proper amount of cleaning solution into the cleaning cup. 

(6) Moisten a clean stick R with the cleaning solution. 

<IMPORTANT> 

 Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you 

start cleaning. 

 Do not use other fluids (water, etc.), because they may damage the print heads. 

 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 

 Do not shed cleaning solution in the maintenance unit. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0320 

 

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup

Do not drain waste ink. 
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(7) With a clean stick R, clean the nozzle surface of print head. 

Manually move the carriage to such a position that you can perform the cleaning with ease. 

<IMPORTANT> 

 Be sure not to bring corner edges of the clean stick R into contact with the nozzle surface. 

 Avoid roughly rubbing the nozzle surface. 

 The used clean stick R should be disposed of, and should not be reused. 

X0251 

 

(8) Close the front cover, turn on the power. 

(9) From the menu, select [Head Cleaning] > [Powerful Cleaning] > [All Print Heads], and press . 

<NOTE> 

 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, the head cleaning will be performed to prevent any ink from drying up. 

 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

 

Clean stick R 

Nozzle surface

Print head 



 

271 

Troubleshooting

9-2-4.  Cleaning the surrounding area of nozzle surface 

(1) Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available 

for use. 

<IMPORTANT> 

 Use a new clean stick R when you start cleaning. 

 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may 

result in the printer malfunction. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select 

[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink 

from drying up. 

(4) Open the front cover. 

X0331 

Front cover
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(5) Put a proper amount of cleaning solution into the cleaning cup. 

(6) Moisten a clean stick R with the cleaning solution. 

<IMPORTANT> 

 Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you 

start cleaning. 

 Do not use other fluids (water, etc.), because they may damage the print heads. 

 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle. 

 Do not shed cleaning solution in the maintenance unit. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0320 

 

Cleaning cup

Cleaning solution 

Clean stick R 

Cleaning cup

Do not drain waste ink.
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X0253

(7) With a clean stick R, clean the surrounding area of nozzle surface of print head. 

Manually move the carriage to such a position that you can perform the cleaning with ease. 

<IMPORTANT> 

 Be sure not to bring the clean stick R into contact with the nozzle surface. 

 The used clean stick R should be disposed of, and should not be reused. 

X0293 

 

(8) Close the front cover, turn on the power. 

(9) From the menu, select [Head Cleaning] > [Powerful Cleaning] > [All Print Heads], and press . 

<NOTE> 

 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, the head cleaning will be performed to prevent any ink from drying up. 

 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place. 

 

Cleaning conditions 

Pre-cleaning state Post-cleaning state 

 

 

 

Clean stick R 

Nozzle surface
Surrounding area of nozzle 

surface 

Cleaning area 

Cleaning  

prohibited 

area 
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9-2-5.  Replacing the color filter 

If a number of non-firing color head nozzles is observed after printing, the filter should be replaced. 

<IMPORTANT> 

 When replacing multiple filters, filters for individual colors should be replaced one by one. Replace the filter for the first color and 

install ink, then replace the next filter. Removing multiple filters at the same time might damage the print head. 

<TIPS> 

 Ink installation should be performed after replacing the filters. If the ink level is low, make a new ink pouch available for use. 

 

(1) Prepare the supplied gloves and optional filter. 

(2) From the menu, select [Maintenance] > [Exchange Filter], and press . 

(3) From [Black], [Yellow], [Cyan], and [Magenta] select non-firing color and press . 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(4) Follow the on-screen message and turn off the power. 

(5) Open the front cover. 

X0331 

 

(6) Lay a waste cloth under the filter to be replaced. 

<TIPS> 

 Non-fuzzy, clean cloth should be used. 

X0396 

Front cover

Filter

Color print head 

Waste cloth

Filter
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(7) Remove the filter from the bracket. 

X0397 

(8) Rotate the nut of the tube on the head side and remove the filter. 

X0437 

(9) Place a new filter on the head side tube and fasten the nut. 

<IMPORTANT> 

 Install the filter with no stamp facing the tube. Pay attention to this installation orientation. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0334 

 

Nut

New filter 

Without stamp

Head side tube 

Nut 

Filter 

Filter
Bracket
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(10) Rotate the nut of the tube on the cartridge side to remove the old filter. 

X0438 

(11) Attach the cartridge side tube to a new filter and fasten the nut. 

<IMPORTANT> 

 Make sure to install the filter with the stamped side facing the cartridge side tube. 

X0335 

(12) Remove the waste cloth from under the filter. 

(13) Close the front cover, turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

(14) Perform the [Filter exchange after ink Load] operation by following the on-screen instructions. 

<TIPS> 

 When replacing multiple filters, go back to the beginning of the procedure to start replacing the next filter. 

 After the procedures are completed, the current screen will go back to the standby mode screen. 

Old filter 

Stamped side

New filter 

Nut 
Cartridge side tube 

Nut 

New filter
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9-2-6.  Replacement of print head 

If a problem of non-ejection of ink-jet droplets is not cleared even after cleaning the head nozzle, replace a print head 

with a new one. 

The replacement procedures vary from the color heads to the white heads. According to each of the replacement 

procedures, replace each print head with a new one separately. 

<TIPS> 

 Do not confuse the color side print head with the white side print head. 

     Check the case color (red for the color side, white for the white side) and replace the case. 

 Ink needs to be re-installed after replacing the print head. If the ink level is low, make a new ink pouch available for use. 

 

Replacement procedures for print head on the color side 

(1) From the menu, select [Maintenance] > [Head Replacement] > [Color], and press . 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(2) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

(3) Open the front cover. 

X0331 

(4) Remove the upper case of a new print head. 

(5) Remove four caps from the new print head. 

X0068 

Upper case 

Cap 

Print head 

Front cover
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(6) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are 

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled. 

<IMPORTANT> 

 Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink. 

 Be careful not to confuse it with the tube for the print head on the white side. 

 When you replace the print head, be sure to move the carriage manually to the position of platen at the center of the printer 

before starting the replacement. If you perform the mounting of the head when the carriage is directly above the 

maintenance unit, it may damage the maintenance unit or the heads. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0398 

(7) Remove the core claw using the supplied screwdriver. 

<IMPORTANT> 

 Hold the core center by hand to make it easy to insert the screwdriver into the claw. 

X0399 

Tube Cap 

Tube 

Driver 

Core

Latch 
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(8) Remove the resin cover which is placed on the top of the carriage board and remove the flat cable. 

X0400 

(9) Unlock the print head, and remove the print head. 

<IMPORTANT> 

 When removing the print head in position, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off 

the dripping ink. 

②

①

X0401 

(10) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case. 

<IMPORTANT> 

 When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause 

poor printing. 

<TIPS> 

 Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both 

hands to remove it. 

X0069 

Lock

Print head

Flat cable

Resin cover 

CasePrint head 

(a) part 
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(11) By following the procedures mentioned below, mount a new print head on the carriage. 

a Insert the rearward end of the print head into the carriage. 

s Push with force in direction s so that the illustrated part (a) makes contact with the side of the metal plate of the print head. 

d Lock the print head in place. 

<IMPORTANT> 

 Make sure the illustrated (a) part is in contact with the side of the metal plate. 

 When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught 

in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them. 

 When you mount d, push it down from the top. Otherwise, you may get your finger caught in it and get injured. 

<TIPS> 

 If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which 

in turn may result in poor printing. Please insert the print head as far as it can go. 

①

① (b)

X0402 

③
②

(a)
X0403 

 

Print head 

Carriage 

Print head
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(12) Insert the flat cable into the core and connect it to the carriage board. 

(13) Fit the claw by pushing the core until it clicks into place. 

Leave a slack to avoid interference between the flat cable and the resin cover. 

X0404 

 

(14) Place the resin cover back onto the carriage board, and engage the two latches properly. 

Tuck the extra flat cable as shown in the illustration. 

X0405 

(15) Remove the cap you connected in step (6) from the tube, and connect the tubes to the print head. 

<IMPORTANT> 

 To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make a 

connection of the rest of the tubes. 

 Be sure to connect each tube with its correct position. 

Flat cable
Core

Latch

Resin cover 
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(16) Tighten the nut firmly until it stops so that each tube is fixed to the print head. 

M
C
Y
K

M4
C3
Y2
Bk1

X0406 

 

(17) Close the front cover, turn on the power. 

(18) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [Color], and press . 

Perform the work operation by following the on-screen instructions. 

<TIPS> 

 After the procedures are completed, the current screen will go back to the standby mode screen. 

(19) Adjust the carriage speed.☞ "7-4-1. CR (Carriage) speed adjustment >>P.216" 

(20) Print the nozzle check patterns. ☞ "7-2-1. Print out of the nozzle check pattern (checking on the print heads) 

>>P.199" 

(21) Perform the initial settings after head replacement configuration.☞ "7-4-2. Initial settings after head replacement 

>>P.217". 

(22) Adjust the ejection timing of print head.☞ "7-4-3. Firing adjustment >>P.218". 

(23) Perform the platen feed adjustment.☞ "7-4-4. Platen-rolling adjustment >>P.219" 

(24) Make the position adjustment between the white head and the color head.☞ "7-4-5. White/color alignment 

>>P.261 

Tube

Nut

Print head 

*Remove the ink clot.。



 

283 

Troubleshooting

Replacement procedures for print head on the white side (if you use a capping pouch) 

<IMPORTANT> 

 When you replace a print head on the white side, you can minimize ink consumption by installing a capping pouch (optionally 

available) in addition to a print head. Instead of the capping pouch, a white ink pouch at its ink depletion level before its expiry 

date can also be used. 

(1) From the menu, select [Maintenance] > [Head Replacement] > [White], and press . 

(2) Make available a capping pouch and select [Yes] in response to the instructions on screen. 

<IMPORTANT> 

 Instead of the capping pouch, a white ink pouch at its ink depletion level before its expiry date can also be used. 

<TIPS> 

 Perform the work operation by following the on-screen instructions. 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Remove the white ink cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0333 

(4) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the 

lid. 

(a)

X0042 

White Ink Cartridge

LidCartridge

Latch Lid
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(5) Pinch the latch at the front end of ink pouch, and draw out the white ink pouch from the cartridge. 

<CAUTION> 

 Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular 

basis. 

X0119 

(6) Put the capping pouch in the cartridge. 

<TIPS> 

 You can use a capping pouch of either the old or new shape. 

< New capping pouch> 

Push the tip end of capping pouch into the cartridge until it clicks into place. 

X0294 

< Old capping pouch> 

Push the tip end of capping pouch into the cartridge until it clicks into place. 

Straighten the capping pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount in position by 

pulling it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

Old capping pouch 

Cartridge

White ink pouch

Cartridge 

Cartridge's tip end 

Latch

Stretch

New capping pouch

Cartridge
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(7) Put the capping pouch in its correct position. 

< New capping pouch> 

<CAUTION> 

 Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand. 

<NOTE> 

 After closing the lid, the winding is complete when the latch of the cartridge side is raised. 

X0295

(a)

X0296 

Latch 

Cartridge
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< Old capping pouch> 

<CAUTION> 

 Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand. 

<NOTE> 

 Close the lid while holding the slack of the capping pouch by hand. 

 After closing the lid, confirm that the capping pouch has been taken up to the end. When the latch of the cartridge side is 

raised, the winding is complete. 

X0041

(a)

 

X0201 

 

(8) Close the lid, and put the capping cartridge in position inside the printer. 

(9) Repeat the same process to replace the other white ink cartridge with the capping pouch. 

(10) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

(11) Open the front cover. 

X0331 

(12) Remove the upper case of a new print head. 

Front cover

Place the pouch in a straight alignment with the cartridge

Align lines with 

each other 

Latch 

Cartridge 
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(13) Remove four caps from the new print head. 

X0068 

(14) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are 

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled. 

<IMPORTANT> 

 Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink. 

 Be careful not to confuse it with the tube for the print head on the color side. 

 Be sure not to tighten the nut for part (a) by mistake. It could remove the tube and leak the contained ink. 

 When you replace the print head, be sure to move the carriage manually to the position of the platen at the center of the 

printer before starting the replacement. If you perform the mounting of the head when the carriage is directly above the 

maintenance unit, it may damage the maintenance unit or the heads. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0407 

Upper case 

Cap 

Print head 

Tube Cap 

Tube 

(a)
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(15) Remove the core claw using the supplied screwdriver. 

<TIPS> 

 Hold the core center by hand to make it easy to insert the screwdriver into the claw. 

X0408 

(16) Remove the resin cover which is placed on the top of the carriage board and remove the flat cable. 

X0409 

(17) Unlock the print head, and remove the print head. 

<IMPORTANT> 

 When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping 

ink. 

 

②
①

X0410 

Lock

Print head

Resin cover 

Flat cable

Driver

Core

Latch
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(18) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case. 

<IMPORTANT> 

 When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause 

poor printing. 

<TIPS> 

 Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both 

hands to remove it. 

X0069 

CasePrint head 

(a) part 
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(19) By following the procedures mentioned below, mount a new print head on the carriage. 

a Insert the rearward end of print head into the carriage. 

s Push with force in direction s so that the illustrated part (a) makes contact with the side of the metal plate of the print head. 

d Lock the print head in place. 

<IMPORTANT> 

 Make sure the illustrated (a) part is in contact with the side of the metal plate. 

 When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught 

in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them. 

 When you mount d, push it down from the top. Otherwise, you may get your finger caught in it and get injured. 

<TIPS> 

 If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which 

in turn may result in poor printing. Please insert the print head as far as it can go. 

①

(b)①
X0411 

③
②

(a)
X0412 

Print head

Carriage 

Print head
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(20) Insert the flat cable into the core and connect it to the carriage board. 

(21) Fit the claw by pushing the core until it clicks into place. 

Leave a slack to avoid interference between the flat cable and the resin cover. 

X0413 

(22) Place the resin cover back onto the carriage board, and engage the two latches properly. 

Tuck the extra flat cable as shown in the illustration. 

X0414 

 

Flat cable

Core

Latch

Resin cover 
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(23) Remove every cap from each tube, and connect the tubes to the print head. 

<IMPORTANT> 

 To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make the 

connection of the rest of the tubes. 

 Check the stamp on the print head and connect them taking care not to confuse their positions. Incorrectly connecting them 

may cause the ink to leak during the circulation. 

(24) Tighten the nut firmly until it stops so that each tube is fixed to the print head. 

<IMPORTANT> 

 Be sure not to tighten the nut for part (a) by mistake. 

 

M4 4
3
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1
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X0415
 

 

(25) Close the front cover, turn on the power. 

(26) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [White], and press . 

Perform the work operation by following the on-screen instructions. 

<TIPS> 

 When the white ink pouch runs low on its remaining volume of white ink, the Install Ink after Replacing Head function can 

no longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the 

installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow 

the instructions on the screen to replace the pouch, and activate the mode again. 

(27) Take out the capping cartridge from the printer. 

<CAUTION> 

 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis. 

W12 W34

X0333 

Tube

(a)

Print head 

Capping cartridge

Nut

*Remove the ink clot. 
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(28) Open the cartridge's lid. 

<IMPORTANT> 

 When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged. 

 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the 

lid. 

(a)

X0042 

(29) Take out the capping pouch from the cartridge, and put the white ink pouch in place. 

Push the tip end of the ink pouch into the cartridge until it clicks into place.  

Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of cartridge, and mount in position by 

pulling it with your hand. 

<NOTE> 

 If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand. 

X0049 

(30) Put the white ink pouch in its correct position and close the lid. 

<CAUTION> 

 Avoid touching portion (a) of the cartridge. Otherwise, you may cut your hand. 

X0041

(a)

 

White ink pouch 

Cartridge

Place the pouch in straight alignment with the cartridge

Align lines with 

each other 

LidCartridge

Latch Lid

Stretch
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(31) Shake the cartridge 100 times side to side to stir the ink. 

<IMPORTANT> 

 The white ink cartridge should be held horizontally when shaking it. 

 Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch. 

<NOTE> 

 Wear the provided gloves when performing this task. 

 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the 

edge of the ink pouch slightly winded, to make the ink easier to stir. 

X0194 

 

 

 

White Ink Cartridge 
Ink pouch

Edge of the rib

Remaining ink volume should 

be approx. 5.9 in. (15 cm) 
Shake 100 times (for approx. 50 seconds) 

(Swing distance should be approx. 2 in. (5 cm). 

Increase the swing distance when the remaining 

ink level becomes low.) 
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(32) Open the lid of the cartridge and place the ink pouch in its correct position. 

<IMPORTANT> 

 Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow 

into the wound section of the pouch when stirred, and cause improper winding of the pouch. 

 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge 

downward and open the lid. 

 When setting the ink pouch, avoid unevenness or wrinkles on the pouch. 

 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged. 

<NOTE> 

 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid. 

(a)

X0182 

X0078 

X0142 

Place the pouch in straight alignment with the cartridge

Latch Lid 

No wrinkles

Not sagged

Ink pouch

LidCartridge
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(33) Close the lid, and put the white ink cartridge in position inside the printer. 

<IMPORTANT> 

 W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause a 

printer malfunction. 

(34) Repeat the same process to replace the other capping cartridge with the white ink pouch. 

(35) On the operation panel, press . 

Then, the white ink will be installed after the head is replaced with a new one. 

<TIPS> 

 After the procedures are completed, the current screen will go back to the standby mode screen. 

(36) Adjust the carriage speed.☞ "7-4-1. CR (Carriage) speed adjustment >>P.216" 

(37) Print the nozzle check patterns. ☞ "7-2-1. Print out of the nozzle check pattern (checking on the print heads) 

>>P.199" 

(38) Perform the initial settings after head replacement configuration.☞ "7-4-2. Initial settings after head replacement 

>>P.217" 

(39) Adjust the ejection timing of the print head. ☞"7-4-3. Firing adjustment >>P.218". 

(40) Perform the platen feed adjustment.☞ "7-4-4. Platen-rolling adjustment >>P.219". 

(41) Make the position adjustment between the white head and the color head.☞ "7-4-5. White/color alignment 

>>P.220" 
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Replacement procedures for print head on the white side (if you do not use a capping pouch) 

<IMPORTANT> 

 When you replace a print head on the white side, you can minimize ink consumption by installing a capping pouch (optionally 

available) in addition to a print head. Instead of the capping pouch, a white ink pouch at its ink depletion level before its expiry 

date can also be used. 

(1) From the menu, select [Maintenance] > [Head Replacement] > [White], and press . 

(2) Select [No] in response to the instructions on screen. 

<TIPS> 

 Perform the work operation by following the on-screen instructions. 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

(4) Open the front cover. 

X0331 

(5) Remove the upper case of a new print head. 

(6) Remove four caps from the new print head. 

X0068 

 

Upper case 

Cap 

Print head 

Front cover
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(7) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are 

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled. 

<IMPORTANT> 

 Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink. 

 Be careful not to confuse it with the tube for the print head on the color side. 

 Be sure not to tighten the nut for part (a) by mistake. It could remove the tube and leak the contained ink. 

 When you replace the print head, be sure to move the carriage manually to the position of the platen at the center of the 

printer before starting the replacement. If you perform the mounting of the head when the carriage is directly above the 

maintenance unit, it may damage the maintenance unit or the heads. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0407 

(8) Remove the core claw using the supplied screwdriver. 

<TIPS> 

 Hold the core center by hand to make it easy to insert the screwdriver into the claw. 

X0408 

Tube Cap 

Tube 

(a)

Driver

Core

Latch
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(9) Remove the resin cover which is placed on the top of the carriage board and remove the flat cable. 

X0409 

(10) Unlock the print head, and remove the print head. 

<IMPORTANT> 

 When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping 

ink. 

②
①

X0410 

(11) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case. 

<IMPORTANT> 

 When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause 

poor printing. 

<TIPS> 

 Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both 

hands to remove it. 

X0069 

CasePrint head 

(a) part 

Lock

Print head

Resin cover 

Flat cable
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(12) By following the procedures mentioned below, mount a new print head on the carriage. 

a Insert the rearward end of print head into the carriage. 

s Push with force in direction s so that the illustrated part (a) makes contact with the side of the metal plate of the print head. 

d Lock the print head in place. 

<IMPORTANT> 

 Make sure the illustrated (a) part is in contact with the side of the metal plate. 

 When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught 

in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them. 

 When you mount d, push it down from the top. Otherwise, you may get your finger caught in it and get injured. 

<TIPS> 

 If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which 

in turn may result in poor printing. Please insert the print head as far as it can go. 

①

(b)①
X0411 

③
②

(a)
X0412 

Print head

Carriage 

Print head
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(13) Insert the flat cable into the core and connect it to the carriage board. 

(14) Fit the claw by pushing the core until it clicks into place. 

Leave a slack to avoid interference between the flat cable and the resin cover. 

X0413 

(15) Place the resin cover back onto the carriage board, and engage the two latches properly. 

Tuck the extra flat cable as shown in the illustration. 

X0414 

(16) Remove every cap from each tube, and connect the tubes to the print head. 

<IMPORTANT> 

 To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make the 

connection of the rest of the tubes. 

 Check the stamp on the print head and connect them taking care not to confuse their positions. Incorrectly connecting them 

may cause the ink to leak during the circulation. 

Flat cable

Resin cover 

Latch

Core
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(17) Tighten the nut firmly until it stops so that each tube is fixed to the print head. 

<IMPORTANT> 

 Be sure not to tighten the nut for part (a) by mistake. 
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(18) Close the front cover, turn on the power. 

(19) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [White], and press . 

Perform the work operation by following the on-screen instructions. 

<TIPS> 

 When the white ink pouch runs low on its remaining volume of white ink, the Install Ink after Replacing Head function can 

no longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the 

installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow 

the instructions on the screen to replace the pouch, and activate the mode again. 

(20) On the operation panel, press . 

Then, the white ink will be installed after the head is replaced with a new one. 

<TIPS> 

 After the procedures are completed, the current screen will go back to the standby mode screen. 

(21) Adjust the carriage speed.☞"7-4-1. CR (Carriage) speed adjustment >>P.216" 

(22) Print the nozzle check patterns. ☞ "7-2-1. Print out of the nozzle check pattern (checking on the print heads) 

>>P.199" 

(23) Perform the initial settings after head replacement configuration.☞ "7-4-2. Initial settings after head replacement 

>>P.217" 

(24) Adjust the ejection timing of the print head.☞ "7-4-3. Firing adjustment >>P.218" 

(25) Perform the platen feed adjustment.☞ "7-4-4. Platen-rolling adjustment >>P.219" 

(26) Make the position adjustment between the white head and the color head.☞ "7-4-5. White/color alignment 

>>P.220" 

 

Tube
(a)

Print head 

Nut

*Remove the ink clot. 
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9-2-7.  Replacing the Wiper 

Replace the wiper with a new one if it is damaged or deformed. 

(1) Have the supplied gloves and wiper ready. 

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press . 

<IMPORTANT> 

 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve 

the problem, then perform the cleaning. 

<TIPS> 

 Pressing  causes the platen to start moving. Do not put anything around the platen. 

(3) Follow the on-screen message and turn off the power. 

<IMPORTANT> 

 Please complete the task within 15 minutes, in order to prevent the print heads from drying up. 

 If the task takes more than 15 minutes to complete, after attaching the flushing receiver, wiper cleaner, and wiper, close the 

front cover and turn on the power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the 

head cleaning will be performed to prevent any ink from drying up. 

(4) Open the front cover. 

(5) Raise the wiper cleaner and move it to its upright position, and remove it by moving it upward. 

<IMPORTANT> 

 Removed wiper cleaner should be placed with the cleaner side facing up. 

<NOTE> 

 For a proper work operation, be sure to wear the printer-provided gloves. 

X0325 

Wiper cleaner Front cover
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(6) Remove the flushing receiver from the maintenance unit. 

<IMPORTANT> 

 Ink droplets will drop off from the hole on the bottom of flushing receiver. Press a waste cloth against the bottom surface, 

and lift the flushing receiver vertically to remove it. 

X0327 

(7) Remove the spring under the wiper from the maintenance unit latch. 

X0439 
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Wiper
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Latch 
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(8) Remove the wiper from the maintenance unit. 

<IMPORTANT> 

 There are two protruded parts underneath. Thoroughly remove the wiper not to damage these parts. 

X0440 

(9) Insert a new wiper into the printer from above. 

X0441 

Wiper 

Protrusion Protrusion

Wiper 

Wiper
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(10) Place the spring under the wiper on the maintenance unit latch. 

X0442 

(11) Insert a wiper cleaner into the printer from above, tip it leftward and put it in place. 

<TIPS> 

 During this process, it is recommended to also replace the wiper cleaner with a new one. 

 First, insert the shaft from above. Then fold it to the left, press the area with the PUSH indication until a clicking sound is 

heard, and get the latch into position. 

X0326 
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(12) Mount the flushing receiver back to its original place in the maintenance unit. 

<TIPS> 

 Direct its orientation with a hole on the bottom to the front. 

(13) Close the front cover. 

(14) Turn on the power. 

<NOTE> 

 Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances. 

<TIPS> 

 Then, the head cleaning will be performed to prevent any ink from drying up. 
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9-2-8.  Re-install the ink 

Ink should be re-installed when an entrance of air into the print head or tube prevents proper ink-jet operation and 

remedial measure cannot improve the condition. 

(1) While the printer is in standby mode, press  on the operation panel to bring the menu screen into view. 

(2) Press , select [Maintenance] > [Initial Ink Installation], and press . 

(3) Press  to select one of the options; [All Colors], [All Whites], or [All Print Heads], and press . 

 

 

(4) According to the message displayed on the operation panel, press . 

Initial ink installation will be operated. 

<TIPS> 

 Estimated time to finish is 30 minutes for [All Whites] and 15 minutes for [All Colors], which, however, may fluctuate 

depending on the temperature environment and printer status. After the procedures are completed, the current screen will 

go back to the standby mode screen. 
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9-3.  Acquisition of log file 

In cases where the printer malfunctions, you may be required by our service personnel to obtain your printer's log file.  

For this reason, please save your printer's log file to a file. 

<TIPS> 

 To the resultant file, such filename (.log) that automatically identifies your printer will be given. 

 

Fetch a log file from USB flash memory 

(1) Insert a USB flash memory into the insertion slot of the printer. 

(2) Press  on the operation panel located on the left side of printer to go to the menu. 

(3) Press , select [Maintenance] > [Log copy to USB], and press . 

 
 

(4) Then, the print button stops blinking, and the log file writing operation will be completed when you hear the sound of 

pong. 

<IMPORTANT> 

 Never remove the USB flash memory from the printer when the print button is blinking. Otherwise, the USB flash memory 

may be damaged, rendering its internal data to be unreadable. 

(5) Obtain the log file saved to the USB flash memory, and send such file to our service personnel. 
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Fetch a log file via USB/LAN connection 

(1) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools". 

(2) After the window shown below appears, select the [Log Data Retrieval] and click [Next]. 

 

(3) Perform the required operation by following the on-screen instructions in the dialog box. 
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Error message 

What is shown below is the error message list of the GTX pro printer. Any error message is displayed on the liquid 

crystal panel. 

Please try to solve any error according to the resolution strategy. 

 

Error code Error message Description Remedy Reference 

― 
[Temperature & 

Humidity Warning] 

The printer is currently 

under 

high-temperature and 

low-humidity 

environment, thereby 

prolonging the time 

required for automatic 

maintenance 

operation after 

completion of printing.

Adjust the surrounding 

temperature and humidity of the 

printer so that both of the 

temperature and humidity may be 

within the print warranty coverage 

with room left for the coverage. 

"11-1. Apparatus >>P.350"

0001 

[ERROR:  0001 

I failed in initialization.

Turn off and on] 

The panel board 

cannot communicate 

with the main board at 

all 

(Displayed in English 

regardless of the 

selected language.) 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

1000 
[Cleaning Solution 

Low - Add More] 

The remaining 

cleaning solution is 

running low. 

Refill cleaning solution. 

"6-2-2. Confirmation and 

refilling of cleaning 

solution >>P.117" 

1001 
[Cleaning Solution 

Out - Add More] 

The cleaning solution 

has been depleted. 
Refill cleaning solution. 

"6-2-2. Confirmation and 

refilling of cleaning 

solution >>P.117" 

1030 
[Color Head Getting 

Warm] 

It is the warning about 

temperature increase 

in the color heads. 

Please wait until the temperature 

decreases.  

If the problem still persists, please 

contact your dealer. 

- 

1031 
[W Head Temp 

Rising] 

It is the warning about 

temperature increase 

in the white heads. 

Please wait until the temperature 

decreases.  

If the problem still persists, please 

contact your dealer. 

- 

1060 [Temp Low] 

The ambient 

temperature 

decreases below the 

scope covered by its 

warranty for the best 

print result. 

Raise your room temperature. 

"11-1. Apparatus >>P.350"



 

312 

Error message

Error code Error message Description Remedy Reference 

1061 [Temp High] 

The ambient 

temperature rises 

above the scope 

covered by its 

warranty for the best 

print result. 

Lower your room temperature. 

"11-1. Apparatus >>P.350"

1064 [Humidity too Low] 

The humidity 

decreases below the 

scope covered by its 

warranty for the best 

print result. 

Raise your room humidity. 

"11-1. Apparatus >>P.350"

1065 [Humidity too High] 

The humidity level is 

higher than the scope 

covered by its 

warranty for the best 

print result. 

Lower your room humidity. 

"11-1. Apparatus >>P.350"

1070 
[Battery To Be 

Replaced] 

Battery needs to be 

replaced. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

1080 [RTC Not Adjusted] 
The built-in clock has 

not been set up. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

1085 [RTC Not Adjusted] 
The built-in clock has 

not been set up. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

1090 [Cap/Wiper Cleaning]
Cap and wiper need 

to be cleaned. 
Clean the cap and wiper. 

"7-1-3. Cleaning the 

nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174" 

1091 [Cap/Wiper Cleaning]
Cap and wiper need 

to be cleaned. 
Clean the cap and wiper. 

"7-1-3. Cleaning the 

nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174" 

1092 
[Wiper Cleaner 

Replacing White] 

The wiper cleaner on 

the white side needs 

to be replaced with a 

new one. 

Replace the wiper cleaner with a 

new one. 

"7-1-4. Replacing the 

wiper cleaner >>P.186" 

1093 
[Wiper Cleaner 

Replacing White] 

The wiper cleaner on 

the white side needs 

to be replaced with a 

new one. 

Replace the wiper cleaner with a 

new one. 

"7-1-4. Replacing the 

wiper cleaner >>P.186" 
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1095 
[Wiper Cleaner 

Replacing Color] 

The wiper cleaner on 

the color side needs 

to be replaced with a 

new one. 

Replace the wiper cleaner with a 

new one. 

"7-1-4. Replacing the 

wiper cleaner >>P.186" 

1096 
[Wiper Cleaner 

Replacing Color] 

The wiper cleaner on 

the color side needs 

to be replaced with a 

new one. 

Replace the wiper cleaner with a 

new one. 

"7-1-4. Replacing the 

wiper cleaner >>P.186" 

1100 
[Pump Tube To Be 

Replaced] 

Pump tube needs to 

be replaced. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

1202 

[Remove the White 

Ink Cartridge and 

shake it] 

The white ink needs 

to be stirred. 

Pressing  after the stirring 

causes the White Ink Refilling 

function to be put into execution. 

"6-2-3. Daily agitation of 

the white ink >>P.118" 

1210 [Exhaust Fan Stop] 
The exhaust fan is not 

working. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

1501 
[Fan Filter To Be 

Replaced] 

The fan filter needs to 

be replaced with a 

new one. 

Replace the fan filter with a new 

one. 

"7-1-7. Replacing the fan 

filter >>P.197" 

1601 
[Flushing Foam 

Replacing White] 

The flushing foam on 

the white side needs 

to be replaced with a 

new one. 

Replace the flushing foam with a 

new one. 

"7-1-5. Replacing the 

flushing foam >>P.189" 

1602 
[Flushing Foam 

Replacing White] 

The flushing foam on 

the white side needs 

to be replaced with a 

new one. 

Replace the flushing foam with a 

new one. 

"7-1-5. Replacing the 

flushing foam >>P.189" 

1605 
[Flushing Foam 

Replacing Color] 

The flushing foam on 

the color side needs 

to be replaced with a 

new one. 

Replace the flushing foam with a 

new one. 

"7-1-5. Replacing the 

flushing foam >>P.189" 

1606 
[Flushing Foam 

Replacing Color] 

The flushing foam on 

the color side needs 

to be replaced with a 

new one. 

Replace the flushing foam with a 

new one. 

"7-1-5. Replacing the 

flushing foam >>P.189" 

1700 
[Nozzle Guard 

Cleaning Timing] 

The nozzle guard 

needs to be cleaned.
Clean the nozzle guard. 

"7-1-3. Cleaning the 

nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174" 
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1701 
[Nozzle Guard 

Cleaning Timing] 

The nozzle guard 

needs to be cleaned.
Clean the nozzle guard. 

"7-1-3. Cleaning the 

nozzle guard, wiper, 

exhaust cap, and suction 

cap >>P.174" 

1801 
[None after head 

change (W)] 

Because the white 

head replacement is 

made, the Install Ink 

after Replacing Head 

function needs to be 

put into execution. 

Conduct the Install Ink after 

Replacing Head for the white 

head. 

"9-2-6. Replacement of 

print head >>P.277" 

1802 
[None after head 

change (KYCM)] 

Because the color 

head replacement is 

made, the Install Ink 

after Replacing Head 

function needs to be 

put into execution. 

Conduct the Install Ink after 

Replacing Head for the color 

head. 

"9-2-6. Replacement of 

print head >>P.277" 

1901 
[Perform Initial Ink 

Installation] 

The ink installation 

has not been 

performed yet. 

Perform initial ink installation. 

"9-2-8. Re-install the ink 

>>P.308" 

1905 
[Exit Disable White 

Ink] 

An operation to 

temporarily stop the 

use of white ink is 

stopped in the middle.

Completely perform one of the 

referenced procedures. 

"7-3-1. Disabling white ink 

>>P.209" 

"7-3-2. Reusing White Ink 

>>P.212" 

2000 
[Cartridge Not Set 

Black] 

No black ink cartridge 

exists. 

Place the black ink cartridge in 

position. 

- 

2001 
[Cartridge Not Set 

Magenta] 

No magenta ink 

cartridge exists. 

Place the magenta ink cartridge in 

position. 

- 

2002 
[Cartridge Not Set 

Cyan] 

No cyan ink cartridge 

exists. 

Place the cyan ink cartridge in 

position. 

- 

2003 
[Cartridge Not Set 

Yellow] 

No yellow ink 

cartridge exists. 

Place the yellow ink cartridge in 

position. 

- 

2004 
[Cartridge Not Set 

White-12] 

No white 12 ink 

cartridge exists. 

Place the white ink cartridge in 

position. 

- 

2005 
[Cartridge Not Set 

White-34] 

No white 34 ink 

cartridge exists. 

Place the white ink cartridge in 

position. 

- 

2020 [No Ink Black] 
The black ink pouch is 

empty. 

Replace the old black ink pouch 

with a new one. 

- 

2021 [No Ink Magenta] 
The magenta ink 

pouch is empty. 

Replace the old magenta ink 

pouch with a new one. 

- 

2022 [No Ink Cyan] 
The cyan ink pouch is 

empty. 

Replace the old cyan ink pouch 

with a new one. 

- 
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2023 [No Ink Yellow] 
The yellow ink pouch 

is empty. 

Replace the old yellow ink pouch 

with a new one. 

- 

2024 [No Ink White-12] 
The white 12 ink 

pouch is empty. 

Replace the old white ink pouch 

with a new one. 

- 

2025 [No Ink White-34] 
The white 34 ink 

pouch is empty. 

Replace the old white ink pouch 

with a new one. 

- 

2030 
[Ink Pouch Error 

Black] 

The black ink pouch 

cannot be identified 

properly. 

Put a proper ink pouch in its 

correct position.  

Put an identifiable ink pouch in 

position inside the printer.  

If the problem still persists, please 

contact your dealer. 

- 

2031 
[Ink Pouch Error 

Magenta] 

The magenta ink 

pouch cannot be 

identified properly. 

Put a proper ink pouch in its 

correct position.  

Put an identifiable ink pouch in 

position inside the printer.  

If the problem still persists, please 

contact your dealer. 

- 

2032 
[Ink Pouch Error 

Cyan] 

The cyan ink pouch 

cannot be identified 

properly. 

Put a proper ink pouch in its 

correct position.  

Put an identifiable ink pouch in 

position inside the printer.  

If the problem still persists, please 

contact your dealer. 

- 

2033 
[Ink Pouch Error 

Yellow] 

The yellow ink pouch 

cannot be identified 

properly. 

Put a proper ink pouch in its 

correct position.  

Put an identifiable ink pouch in 

position inside the printer.  

If the problem still persists, please 

contact your dealer. 

- 

2034 
[Ink Pouch Error 

White 12] 

The white 12 ink 

pouch cannot be 

identified properly. 

Put a proper ink pouch in its 

correct position.  

Put an identifiable ink pouch in 

position inside the printer.  

If the problem still persists, please 

contact your dealer. 

- 

2035 
[Ink Pouch Error 

White 34] 

The white 34 ink 

pouch cannot be 

identified properly. 

Put a proper ink pouch in its 

correct position.  

Put an identifiable ink pouch in 

position inside the printer.  

If the problem still persists, please 

contact your dealer. 

- 
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2036 [Machine Error] 

It is the read-out 

trouble of an ink 

pouch on the color 

side. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

2037 [Machine Error] 

It is the read-out 

trouble of an ink 

pouch on the white 

side. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

2041 
[No Wiper Cleaner 

(CMYK)] 

There is no wiper 

cleaner on the color 

side. 

Place a wiper cleaner in position 

on the color side. 

- 

2042 
[No Wiper Cleaner 

(White)] 

There is no wiper 

cleaner on the white 

side. 

Place a wiper cleaner in position 

on the white side. 

- 

2050 [Temp Low] 

The ambient 

temperature 

decreases below the 

operation assurance 

range for the best 

print result. 

Raise your room temperature. 

"11-1. Apparatus >>P.350"

2051 [Temp High] 

The ambient 

temperature rises 

above the operation 

assurance range for 

the best print result. 

Lower your room temperature. 

"11-1. Apparatus >>P.350"

2070 
[Obstacle on the 

Platen] 

The obstacle sensor 

has detected some 

obstacle on the platen 

or print medium. 

Remove such obstacle from the 

platen, flatten its surface, and 

press  to clear the error. 

- 

2071 
[Obstacle detected 

during printing] 

Obstacle detected on 

the Platen during 

printing 

Perform test printing and check 

the ejection from the head for any 

abnormalities. 

If the ejection is abnormal, 

immediately perform head 

cleaning to rectify the abnormality. 

- 

2072 
[Platen is too low. 

Adjust it] 

The platen was 

detected to be too low 

when attempting to 

start printing. 

The gap between the medium’s 

print surface and the print head is 

too large. Make adjustments by 

raising the platen. 

- 

2080 

[Black 

Check the remaining 

volume of the ink 

pouch and winding] 

(K) Pouch winding 

failure 

Check that the pouch is wound 

correctly. 

- 
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2081 

[Magenta 

Check the remaining 

volume of the ink 

pouch and winding] 

(M) Pouch winding 

failure 

Check that the pouch is wound 

correctly. 

- 

2082 

[Cyan 

Check the remaining 

volume of the ink 

pouch and winding] 

(C) Pouch winding 

failure 

Check that the pouch is wound 

correctly. 

- 

2083 

[Yellow 

Check the remaining 

volume of the ink 

pouch and winding] 

(Y) Pouch winding 

failure 

Check that the pouch is wound 

correctly. 

- 

2084 
[White 12 Check The 

Cartridge] 

The white 12 ink 

pouch may not be 

winded properly. 

Take out the white 12 cartridge, 

open the cover, and have the ink 

pouch winded properly. Close the 

cover, set the ink pouch back to 

the printer, and press  to 

clear the error. 

- 

2085 
[White 34 Check The 

Cartridge] 

The white 34 ink 

pouch may not be 

winded properly. 

Take out the white 34 cartridge, 

open the cover, and have the ink 

pouch winded properly. Close the 

cover, set the ink pouch back to 

the printer, and press  to 

clear the error. 

- 

2090 
[Ink Pouch Error 

Black] 

An error has been 

detected in the black 

ink pouch. 

In that case, replace with a new 

ink pouch set. 

- 

2091 
[Ink Pouch Error 

Magenta] 

An error has been 

detected in the 

magenta ink pouch. 

In that case, replace with a new 

ink pouch set. 

- 

2092 
[Ink Pouch Error 

Cyan] 

An error has been 

detected in the cyan 

ink pouch. 

In that case, replace with a new 

ink pouch set. 

- 

2093 
[Ink Pouch Error 

Yellow] 

An error has been 

detected in the yellow 

ink pouch. 

In that case, replace with a new 

ink pouch set. 

- 

2094 
[Ink Pouch Error 

White 12] 

An error has been 

detected in the white 

12 ink pouch. 

In that case, replace with a new 

ink pouch set. 

- 
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2095 
[Ink Pouch Error 

White 34] 

An error has been 

detected in the white 

34 ink pouch. 

In that case, replace with a new 

ink pouch set. 

- 

2100 
[USB flash drive Not 

Ready] 

No USB flash memory 

been inserted into its 

insertion slot. 

Insert a USB flash memory into 

the slot, wait for a couple of 

seconds, and perform the 

operation.  

Insert a USB flash memory into 

the slot again.  

If the problem still persists, check 

on the format and type of the USB 

flash memory.  

"9-1. Troubleshooting 

instructions >>P.248" 

2101 [Not Enough Area] 

At the writing stage to 

the USB flash 

memory there is not 

enough free space to 

store the data. 

Use your PC to check free space 

on the USB flash memory.  

Insert the USB flash memory that 

has enough free space into the 

insertion slot. 

- 

2105 [No Files] 
No valid file exists in a 

USB flash memory. 

Connect the USB flash memory to 

your PC for checking the 

information stored in it.  

If an ARXP or ARX4 file has been 

saved to it, check its content by 

means of the file viewer.  

"9-1. Troubleshooting 

instructions >>P.248" 

2110 
[Receiving History 

W/O Error1] 

After the power is 

turned on, it is found 

that there is no print 

data received. 

Press  to clear the error. 

- 

2120 
[Print Data Auto 

Delete Enable] 

Because the Print 

Data Auto Delete 

Enable function 

remains active, no 

receiving history is 

available. 

Press  to clear the error.  

When you use the receiving 

history, disable the Auto Job 

Delete option. 

- 

2130 

[White Ink Pause 

Mode… 

Non-performable] 

Because the White 

Ink Pause Mode 

remains active, no 

white ink can be 

installed. 

Press  to clear the error.  

When you use the white ink, do 

not make the White Ink Pause 

Mode active. 

- 

2200 
[Maintenance Pouch 

Set  Black] 

Although an ink pouch 

is needed, a 

maintenance solution 

pouch is set to the 

black cartridge. 

Set an ink pouch to the black 

cartridge. 

- 
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2201 
[Maintenance Pouch 

Set Magenta] 

Although an ink pouch 

is needed, a 

maintenance solution 

pouch is set to the 

magenta cartridge. 

Set an ink pouch to the magenta 

cartridge. 

- 

2202 
[Maintenance Pouch 

Set Cyan] 

Although an ink pouch 

is needed, a 

maintenance solution 

pouch is set to the 

cyan cartridge. 

Set an ink pouch to the cyan 

cartridge. 

- 

2203 
[Maintenance Pouch 

Set Yellow] 

Although an ink pouch 

is needed, a 

maintenance solution 

pouch is set to the 

yellow cartridge. 

Set an ink pouch to the yellow 

cartridge. 

- 

2204 
[Maintenance Pouch 

Set White12] 

Although an ink pouch 

is needed, a 

maintenance solution 

pouch is set to the 

white 12 cartridge. 

Set the ink pouch to the white 12 

cartridge. 

- 

2205 
[Maintenance Pouch 

Set White34] 

Although an ink pouch 

is needed, a 

maintenance solution 

pouch is set to the 

white 34 cartridge. 

Set the ink pouch to the white 34 

cartridge. 

- 

2214 
[Ink Pouch Set 

White12] 

Although a 

maintenance solution 

pouch is needed, an 

ink pouch is set to the 

white 12 cartridge. 

Set the maintenance solution 

pouch to the white 12 cartridge. 

- 

2215 
[Ink Pouch Set 

White34] 

Although a 

maintenance solution 

pouch is needed, an 

ink pouch is set to the 

white 34 cartridge. 

Set the maintenance solution 

pouch to the white 34 cartridge. 

- 

2300 
[Special operation 

mode] 

Under the operation 

by the service man 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

2310 

[Perform test printing 

and check the 

ejection from the 

head] 

Since the parts have 

been replaced, you 

have to perform test 

printing and check the 

ejection from the 

head. 

Perform test printing following the 

on-screen instructions. 

- 
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2320 

[Perform test printing 

and check the 

ejection from the 

head] 

Since 18 or more 

hours have passed, 

you have to perform 

test printing and 

check the ejection 

from the head. 

Perform test printing following the 

on-screen instructions. 

- 

3000 
[PC Communication 

Error] 

Data reception from 

PC has suspended. 

Make sure that your PC is 

connected to the printer, and 

resend the print data. If you have 

trouble in sending the data, restart 

your PC and the printer.  

This error will also occur "when 

the cable is removed during data 

reception" or "when the ongoing 

operation is canceled on the PC 

during data reception". 

- 

3001 
[PC Communication 

Error] 

Data transmission to 

PC has suspended. 

Make sure that your PC is 

connected to the printer, and start 

operating the PC tool over from 

the beginning. If you have trouble 

in sending the data, restart your 

PC and the printer.  

This error may also occur "when 

the cable is removed during data 

transmission" or "when the PC 

tool is caused to stop running on 

the PC during data transmission". 

- 

3002 [PC Data Error] 
The GT has received 

an unsupported data.

Make sure that your PC is 

connected to the printer, and 

resend the print data. If you have 

trouble in sending the data, restart 

your PC and the printer. 

- 

3003 [PC Data Error] 

The version of printer 

driver disagrees with 

the firmware's version.

Update the firmware of the PC's 

printer driver as well as firmware 

of the printer to the latest version. 

- 

3004 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Ascertain whether the updated 

data of firmware you try to send is 

correct or not.  

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again. If the 

problem is still not remedied, 

restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 
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3005 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again. If the 

problem is still not remedied, 

restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 

3010 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again. If the 

problem is still not remedied, 

restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 

3013 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again. If the 

problem is still not remedied, 

restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 

3014 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again. If the 

problem is still not remedied, 

restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 

3015 
[Can no longer 

receive data] 

Too many print data 

has been sent from 

the PC during the print 

operation. 

Number of the print data should 

be up to 99 during any print 

operation. 

- 

3100 
[PC Data Error (with 

White)] 

Such print data that 

uses the white ink 

was sent to the printer 

which is placed in the 

white ink pause 

mode. 

On the setting screen of printer 

driver, verify that the ink selection 

is set to [Color Ink Only].  

While the white ink pause mode 

remains active, any print data in 

which the white ink is included 

cannot be received. 

- 
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3400 [PC Data Error] 

In the print data, some 

command in incorrect 

command length is 

included. 

Check on the ARXP file by means 

of "GTX pro File Viewer"   

Create the print data once again.  

If the problem still persists, please 

contact your dealer. 

- 

3401 [PC Data Error] 

In the print data, some 

undefined command 

is included. 

Check on the ARXP file by means 

of "GTX pro File Viewer"   

Create the print data once again.  

If the problem still persists, please 

contact your dealer. 

- 

3402 [PC Data Error] 
It is the sequence 

error in the print data.

Check on the ARXP file by means 

of "GTX pro File Viewer"   

Create the print data once again.  

If the problem still persists, please 

contact your dealer. 

- 

3407 [Blank Data] 

- The print data for 

blank page is received 

from PC. 

- When performing 

the printing, you have 

selected a totally 

white image pattern 

portion as a printing 

range in your software 

application, and sent it 

to the printer. 

- You have created a 

larger image than the 

specified paper size, 

and tried to print out a 

part of it in the printer, 

among others. 

Check on the ARXP file by means 

of "GTX pro File Viewer"   

For example, please confirm the 

print range and paper size for your 

software application through the 

Print Preview function, etc. of 

Photoshop. 

- 

3408 
[PC Data Error (too 

large)] 

The print data 

capacity is too large. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

3410 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Check on the ARXP file by means 

of "GTX pro File Viewer"   

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again.  

Restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 
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3411 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Check on the ARXP file by means 

of "GTX pro File Viewer"   

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again.  

Restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 

3412 [PC Data Error] 

It is the 

communication error 

between your PC and 

the printer. 

Check on the ARXP file by means 

of "GTX pro File Viewer"   

Make sure that your PC is 

connected to the printer, and start 

communication between your PC 

and the printer once again.  

Restart your PC and the printer.  

If the problem still persists, please 

contact your dealer. 

- 

4100 
[USB flash drive 

Access Error] 

No file can be 

opened. 

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 

4101 
[USB flash drive 

Access Error] 
No file can be created.

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 

4103 
[USB flash drive 

Access Error] 

File search has ended 

up in failure. 

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 
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4104 
[USB flash drive 

Access Error] 

The system has failed 

to read the file. 

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 

4105 
[USB flash drive 

Access Error] 

The system has failed 

to write the file. 

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 

4106 [Illegal Format] 

There is something 

wrong with the file's 

data. 

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 

4108 
[USB flash drive 

Access Error] 

The system has failed 

to obtain the file size.

Check on the content of USB 

flash memory.   

Insert a USB flash memory into 

the slot again, and perform the 

required operation once more.  

If the problem is still not remedied, 

restart the printer and try to 

operate it once again.  

"9-1. Troubleshooting 

instructions >>P.248" 

4200 [Machine Error] 

Abnormal indication is 

found in the language 

data on the LCD 

screen. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 

4201 [Machine Error] 

Abnormal indication is 

found in the language 

data on the LCD 

screen. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 



 

325 

Error message

Error code Error message Description Remedy Reference 

4202 [Machine Error] 

Abnormal indication is 

found in the language 

data on the LCD 

screen. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 

4400 [Test print data Error]

An error is detected in 

the print data for test 

print menu. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 

4401 [Test print data Error]

An error is detected in 

the print data for test 

print menu. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 

4402 [Test print data Error]

An error is detected in 

the print data for test 

print menu. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 

4500 [Network error] 

The network interface 

was unable to be 

activated. 

Press  to clear the error.  

Contact your network setup 

manager and network 

administrator.  

If the problem still persists, please 

contact your dealer. 

- 

4501 [Network error] 

An error has been 

detected in the static 

IP address setting and 

subnet mask value. 

Press  to clear the error.  

Use the maintenance tool to set 

up a correct static IP address and 

subnet mask value once again. 

- 



 

326 

Error message

Error code Error message Description Remedy Reference 

4502 [Network error] 

The network interface 

setting has ended up 

in failure. 

Press  to clear the error.  

Contact your network setup 

manager and network 

administrator.  

If the problem still persists, please 

contact your dealer. 

- 

4503 [Network error] 

An error was found in 

the static IP address 

of the default gateway.

Press  to clear the error.  

Use the maintenance tool to set 

up a correct static IP address of 

default gateway once again. 

- 

4504 [Network error] 

It is the error of static 

IP address setup 

value. 

Press  to clear the error.  

Use the maintenance tool to set 

up a correct static IP address and 

subnet mask value once again. 

- 

4506 
[No Enable Restore 

Data] 

No data can be 

restored because its 

backup copy was not 

made. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

4510 [Network error] 

Error in configuring 

the network for the 

printer 

Press to clear the error. 

Check the network settings. 

Contact your network setup 

manager if you have a question. 

- 

5001 [Machine Error] 

A timeout has 

occurred at the time of 

initialization. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

5010 [PC Data Error] 

An error is detected in 

the current print data 

being run. 

Press  to clear the error. 

Create the print data again on the 

PC to load it to the printer, and try 

the print operation again. 

- 

5020 [Machine Error] 

The carriage 

movement was not 

completed. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5021 [Machine Error] 
Head operation is 

incomplete. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5022 [Machine Error] 
Head operation is 

incomplete. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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5080 [Machine Error] 

Maintenance unit 

operation is 

incomplete. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5081 [Machine Error] 

Maintenance unit 

operation is 

incomplete. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5094 [Machine Error] 

The platen cannot be 

moved toward the 

rear of the printer. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

5095 [Machine Error] 

The platen cannot be 

moved toward the 

front of the printer. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

5096 [Machine Error] 
The platen cannot be 

rolled. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

5200 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5201 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5230 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5231 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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5232 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5233 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5240 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5241 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5250 [Machine Error] 

The program data of 

the firmware of 

maintenance unit, 

which you try to 

update, has been 

found to be defective.

As it is likely that the firmware's file 

is corrupted, obtain a proper file of 

the firmware which is not 

corrupted.  

If the problem still persists even 

after restarting the printer and 

your PC, please contact your 

dealer. 

- 

5260 [Machine Error] 

A version of the 

firmware of 

maintenance unit is 

incompatible. 

In the event that this error is 

displayed after suspending the 

updating of firmware, please start 

the updating operation over from 

the beginning.  

If the problem still persists, please 

contact your dealer. 

- 

5261 [Machine Error] 

The printer is 

connected to a 

maintenance board 

for a different model. 

Restart the printer and update the 

firmware again. Check if the 

firmware update file is for the 

model of your printer. 

If the problem still persists, please 

contact your dealer. 

- 
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5301 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5302 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5303 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5304 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5305 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5306 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5307 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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5311 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5312 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5313 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5314 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5320 [Machine Error] 

The cam of the 

maintenance unit (on 

the color side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5321 [Machine Error] 

The cam of the 

maintenance unit (on 

the color side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5322 [Machine Error] 

The cam of the 

maintenance unit (on 

the color side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5323 [Machine Error] 

The cam of the 

maintenance unit (on 

the color side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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5330 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5331 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5332 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5333 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5340 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5341 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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5342 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5343 [Machine Error] 

The wiper of the 

maintenance unit (on 

the color side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5350 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the color side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5351 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the color side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5352 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the color side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5353 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the color side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 
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5354 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5355 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5356 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5357 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the color side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5358 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the color side), 

which is associated 

with updating of 

firmware. 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5359 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the color side), 

which is associated 

with updating of 

firmware. 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 
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5361 [Machine Error] 

When the solenoid is 

in operation, there is a 

mismatch between 

the main board and 

the maintenance unit 

(on the color side). 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5371 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5372 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5373 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5374 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5375 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5376 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 
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5377 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5378 [Machine Error] 

Communication error 

during the ink sensor 

reading of the 

maintenance unit 

(color) 

Check to see if there is any 

source that produces a loud noise 

near the printer.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

5391 [Machine Error] 

It is the internal error 

of the maintenance 

unit (on the color 

side). 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5401 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5402 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5403 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5404 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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5405 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5406 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5407 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5411 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5412 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5413 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5414 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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Error code Error message Description Remedy Reference 

5420 [Machine Error] 

The cam of the 

maintenance unit (on 

the white side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5421 [Machine Error] 

The cam of the 

maintenance unit (on 

the white side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5422 [Machine Error] 

The cam of the 

maintenance unit (on 

the white side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5423 [Machine Error] 

The cam of the 

maintenance unit (on 

the white side) 

malfunctions. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5430 [Machine Error] 

The wiper cleaner of 

the maintenance unit 

(on the white side) 

malfunctions. 

Check to see if the wiper cleaner 

is properly installed and there is 

no obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5431 [Machine Error] 

The wiper cleaner of 

the maintenance unit 

(on the white side) 

malfunctions. 

Check to see if the wiper cleaner 

is properly installed and there is 

no obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5432 [Machine Error] 

The wiper cleaner of 

the maintenance unit 

(on the white side) 

malfunctions. 

Check to see if the wiper cleaner 

is properly installed and there is 

no obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5433 [Machine Error] 

The wiper cleaner of 

the maintenance unit 

(on the white side) 

malfunctions. 

Check to see if the wiper cleaner 

is properly installed and there is 

no obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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Error message

Error code Error message Description Remedy Reference 

5440 [Machine Error] 

The wiper of the 

maintenance unit (on 

the white side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5441 [Machine Error] 

The wiper of the 

maintenance unit (on 

the white side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5442 [Machine Error] 

The wiper of the 

maintenance unit (on 

the white side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5443 [Machine Error] 

The wiper of the 

maintenance unit (on 

the white side) 

malfunctions. 

Check to see if the wiper is 

properly installed and there is no 

obstacle around the wiper or 

wiper cleaner.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5450 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the white side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5451 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the white side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 
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Error code Error message Description Remedy Reference 

5452 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the white side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5453 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the white side), 

which is associated 

with updating of 

firmware. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5454 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5455 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5456 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5457 [Machine Error] 

It is the 

communication error 

between the main 

board and the 

maintenance unit (on 

the white side), which 

is associated with the 

updating of firmware.

Check to see if there is any 

source near the printer that 

produces a loud noise.  

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 
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Error message

Error code Error message Description Remedy Reference 

5458 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the white side), 

which is associated 

with updating of 

firmware. 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5459 [Machine Error] 

It is an internal error of 

the maintenance unit 

(on the white side), 

which is associated 

with updating of 

firmware. 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5461 [Machine Error] 

When the solenoid is 

in operation, there is a 

mismatch between 

the state of the main 

board and that of the 

maintenance unit (on 

the white side). 

Restart the printer and update the 

firmware again.  

If the problem still persists, please 

contact your dealer. 

- 

5471 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5472 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5473 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5474 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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Error message

Error code Error message Description Remedy Reference 

5475 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5476 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5477 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5478 [Machine Error] 

It is the 

communication error 

between the 

maintenance unit (on 

the white side) and 

the cartridge sensor. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5491 [Machine Error] 

It is the internal error 

of the maintenance 

unit (on the white 

side). 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5501 [Machine Error] 

The sub tank of black 

ink is not filled with 

black ink. 

Check the ink pouch (black) for 

any abnormalities. 

- 

5502 [Machine Error] 

The sub tank of 

magenta ink is not 

filled with magenta 

ink. 

Check the ink pouch (magenta) 

for any abnormalities. 

- 

5503 [Machine Error] 

The sub tank of cyan 

ink is not filled with 

cyan ink. 

Check the ink pouch (cyan) for 

any abnormalities. 

- 

5504 [Machine Error] 

The sub tank of yellow 

ink is not filled with 

yellow ink. 

Check the ink pouch (yellow) for 

any abnormalities. 

- 
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Error message

Error code Error message Description Remedy Reference 

5520 [Machine Error] 
Failed to calibrate the 

winding sensor 

Remove the ink cartridge, check 

winding, and then install the 

cartridge correctly. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5600 [Machine Error] 

Ink pouch was 

identified with 

abnormal timing at the 

time of initialization. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5601 [Machine Error] 

An abnormality was 

detected when tried to 

check the ink pouch. 

Check if the ink pouch is seated 

on the ink cartridge correctly. 

Ensure that the ink cartridge is 

correctly placed on the printer. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5602 [Machine Error] 

An abnormality was 

detected when tried to 

check the ink pouch. 

Check if the ink pouch is seated 

on the ink cartridge correctly. 

Ensure that the ink cartridge is 

correctly placed on the printer. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5603 [Machine Error] 

An abnormality was 

detected when tried to 

check the ink pouch. 

Check if the ink pouch is seated 

on the ink cartridge correctly. 

Ensure that the ink cartridge is 

correctly placed on the printer. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5801 [Machine Error] 

It is the 

communication error 

between the main 

board and the panel 

board or the head 

board. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If a USB flash memory is inserted 

into the printer, remove the 

memory first, and then restart the 

printer.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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Error message

Error code Error message Description Remedy Reference 

5802 [Machine Error] 

It is the 

communication error 

between the main 

board and the panel 

board or the head 

board. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If a USB flash memory is inserted 

into the printer, remove the 

memory first, and then restart the 

printer.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5803 [Machine Error] 

It is the 

communication error 

between the main 

board and the panel 

board or the head 

board. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If a USB flash memory is inserted 

into the printer, remove the 

memory first, and then restart the 

printer.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

5804 [Machine Error] 

It is the 

communication error 

between the main 

board and the panel 

board or the head 

board. 

Check to see if there is any 

source near the printer that 

produces a loud noise.  

If a USB flash memory is inserted 

into the printer, remove the 

memory first, and then restart the 

printer.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6004 
[Obstacle on the 

Platen] 

It indicates some error 

in the obstacle sensor.

Check to see if the obstacle 

sensor is covered with something. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6010 [PC Data Error] 

The system failed to 

write the EEPROM of 

the main board. 

Make note of their error code and 

error message, and please notify 

it to your dealer. 

- 

6011 [Machine Error] 

The system failed to 

erase the FLASH 

ROM of the main 

board. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

6012 [Machine Error] 

The system failed to 

write the FLASH ROM 

of the main board. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 
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Error message

Error code Error message Description Remedy Reference 

6021 [No Battery] 

The battery of the 

real-time clock is fully 

exhausted. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

6031 [Machine Error] 
Platen button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6032 [Machine Error] 
Print button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6033 [Machine Error] 
Stop button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6034 [Machine Error] 
Back button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6035 [Machine Error] 
Right button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6036 [Machine Error] 
Down button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6037 [Machine Error] 
Up button is out of 

working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6038 [Machine Error] 

Head cleaning button 

is out of working 

order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 
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Error message

Error code Error message Description Remedy Reference 

6039 [Machine Error] 
MENU/OK button is 

out of working order. 

Ascertain whether or not 

something is placed on the 

operation panel.   

For help, please contact your 

dealer. 

- 

6045 [Machine Error] 

The printer is 

connected to a 

maintenance board 

for a different model. 

Restart the printer and update the 

firmware again. Check if the 

firmware update file is for the 

model of your printer. 

If the problem still persists, please 

contact your dealer. 

- 

6046 [Machine Error] 

The LCD panel 

firmware version is 

not compatible with 

the main firmware 

version. 

Restart the printer and update the 

firmware again. Check if the 

firmware update file is for the 

model of your printer. 

If the problem still persists, please 

contact your dealer. 

- 

6050 [Machine Error] 

The winding sensor 

was detected to be 

faulty 

Remove the ink cartridge, check 

winding, and then install the 

cartridge correctly. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6060 [Machine Error] 

An Ethernet related 

hardware error was 

detected during 

startup 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6090 [Machine Error] 

The main board was 

not initialized 

sufficiently 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6101 [Machine Error] 

It indicates the 

carriage's 

malfunction. 

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

6102 [Machine Error] 
The carriage stops at 

an incorrect position. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 
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Error message

Error code Error message Description Remedy Reference 

6103 [Machine Error] 
No cap can be locked 

in place. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6104 [Machine Error] 
Carriage does not 

move. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6105 [Machine Error] 

The carriage's home 

position return 

initialization has 

ended up in failure. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6106 [Machine Error] 

The carriage has 

bumped against the 

frame. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6107 [Machine Error] 

The carriage's reverse 

rotation has been 

detected. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6108 [Machine Error] 

Abnormal decrease in 

the speed of carriage 

has been detected. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6109 [Machine Error] 

The carriage has 

stopped abnormally 

within the print range.

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 
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Error message

Error code Error message Description Remedy Reference 

6110 [Machine Error] 

The carriage cannot 

move out of its locked 

position. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer.  

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6111 [Machine Error] 
Carriage cannot 

perform capping. 

Check to see if something gets 

caught in the carriage or any 

foreign object exists inside the 

printer. 

If the problem still persists, please 

contact your dealer. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6119 [Machine Error] 

The carriage 

movement does not 

come to a full stop. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6130 
[Machine Error Adjust 

CR] 

It indicates an 

abnormal decrease in 

the speed of carriage.

Clean the carriage. 

Then, adjust the carriage speed. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6131 
[Machine Error Adjust 

CR] 

It indicates an 

excessive increase in 

the speed of carriage.

Clean the carriage. 

Then, adjust the carriage speed. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

"7-4-1. CR (Carriage) 

speed adjustment 

>>P.216" 

6132 
[Machine Error Adjust 

CR] 

The carriage stops at 

an incorrect position. 

Clean the carriage. 

Then, adjust the carriage speed. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

"7-4-1. CR (Carriage) 

speed adjustment 

>>P.216" 

6133 [Machine Error] 

It indicates an error in 

the carriage speed 

adjustment (reverse 

motion). 

Clean the carriage. 

Then, adjust the carriage speed. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6134 [Machine Error] 

It indicates an error in 

the carriage speed 

adjustment (forward 

motion). 

Clean the carriage. 

Then, adjust the carriage speed. 

"7-1-6. Cleaning the 

internal area of printer 

>>P.192" 

6220 [Machine Error] 

The color heads' 

temperature level is 

abnormal. 

Ascertain whether or not the cable 

for the heads is disconnected.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 
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Error code Error message Description Remedy Reference 

6221 [Machine Error] 

The white heads' 

temperature level is 

abnormal. 

Ascertain whether or not the cable 

for the heads is disconnected.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6230 [Machine Error] 

It refers to abnormal 

voltage in the color 

heads. 

Ascertain whether or not the cable 

for the heads is disconnected.  

If the problem still persists, please 

contact your dealer. 

- 

6231 [Machine Error] 

It refers to abnormal 

voltage in the white 

heads. 

Ascertain whether or not the cable 

for the heads is disconnected.  

If the problem still persists, please 

contact your dealer. 

- 

6240 [Machine Error] 
It refers to FFC failure 

in the color heads. 

Ascertain whether or not the cable 

for the heads is disconnected.  

If the problem still persists even 

after restarting the printer, please 

contact your dealer. 

- 

6241 [Machine Error] 
It refers to FFC failure 

in the white heads. 

Ascertain whether or not the cable 

for the heads is disconnected.  

If the problem still persists even 

after reactivating the printer, 

please contact your dealer. 

- 

7000 [Machine Error]  
It is the system call 

error. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

7012 [Machine Error] 
Firmware internal 

error occurred. 

If the problem still persists even 

after restarting the printer, please 

contact your dealer after noting 

the error code and message 

displayed. 

- 

7013 [Machine Error] 
It is the general 

program error. 

Make note of the error code and 

error message, and please notify 

it to your dealer. 

- 

7015 [Machine Error] 

Because the ongoing 

print operation 

remains unfinished, 

the next print data 

cannot be printed out.

Send any print data to the printer 

while the printer is not performing 

the printing operation. 

- 

7020 [Machine Error] 
Internal error related 

to white ink circulation

If the problem still persists even 

after restarting the printer, please 

contact your dealer after noting 

the error code and message 

displayed. 

- 
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Error code Error message Description Remedy Reference 

7021 [Machine Error] 
Internal error related 

to white ink agitation 

If the problem still persists even 

after restarting the printer, please 

contact your dealer after noting 

the error code and message 

displayed. 

- 

 

In the event that other error codes than those that are mentioned above are displayed or that any of the 

above-mentioned errors cannot be remedied even by following the troubleshooting procedures, please contact your 

dealer for help. 
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11 Specifications 

11-1.  Apparatus 

Printing method Direct cloth printing by color ink jet printing 

Head Quantity 2-piece set 

Resolution Maximum 1200dpi×1200dpi 

Ink 
Type Water-based ink 

Number of colors 5 colors of CMYKW 

Material supply method Platen transportation method 

Supported 

media 

(size/thickness) 

Size 14 in. (355.6 mm) x 16 in. (406.4 mm) (standard platen) 

Thickness Up to 1.1 in. (30 mm) 

Printable area Maximum 16 in. (406.4 mm) x 21 in. (533.4 mm) 

Interface USB 2.0, LAN (10BASE-T, 100BASE-TX, 1000BASE-T), USB memory 

External dimensions 55.1 in. (width) x 51.1 in. (depth) x 21.6 in. (height) (1400 mm (width) x 1300 

mm (depth) x 550 mm (height)) 

Weight 128 kg (282 lb) (including platen) 

Installation 

conditions 

Working 

environment 

Power Single phase, 100 V-240 V, 50/60 Hz 

Power 

Consumptions 

When active: 80 W max. 

Tempe

rature 

and 

humidit

y 

Enviro

nment 

Recomm

ended 

Print 

environ

ment 

Temperature: 18 to 

30°C (64.4 to 86°F) 

Humidity: 35 to 85% 

(No condensation 

should occur.) 

 

Working 

environ

ment 

Temperature: 10 to 

35°C (50 to 95°F) 

Humidity: 20 to 85% 

(No condensation 

should occur.) 

Storage 

environ

ment 

Temperature:  0 to 

40°C (32 to 104°F) 

Humidity: 20 to 85% 

(No condensation 

should occur.) 

Print direction Bidirectional, unidirectional 

Fixation conditions 

Conveyor oven (recommended): 160°C (320°F) for 3.5 minutes, or heat press: 

180°C (356°F) for 35 seconds 

* The time taken for fixation differs depending on the fixation device. 

Pretreatment 

Pretreatment is required when you print using white ink. 

Apply pretreatment with a roller or pretreatment device and dry it up with a heat 

press. 

Printing-guaranteed range 
Operating your printer 
Keeping your printer 

Humidity (%) 

X0394

30

20

40

35

50

60

70

80
85

4035302520181510

37

29

Temperature 

(°C) 

(50     59    68    77       86    95    104 (°F)) 
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11-2.  Software 

OS 
macOS 10.14 Mojave、macOS 10.15 Catalina、 

Windows 8.1（64bit）、Windows 10（64bit） 

Min. operating environment 
CPU with 2 GHz or above 

RAM with 4 GB or above 

Display resolution XGA (1024 x 768) or higher 

Output Printer driver, GTX Graphics Lab 

Recommended application software 

for high-level image editing 

Adobe® Photoshop CC2020/CC2019、Adobe ® Illustrator CC2020/CC2019、 

CorelDRAW ® 2018/2019 (for Windows) 
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11-3.  Ink, maintenance solution, cleaning solution, pretreatment 

11-3-1.  Ink 

Name Black / Magenta / Cyan / Yellow ink pouch 
Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 
- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 

Content 350 ml, 500 ml, 700 ml 
External 
dimensions in 
transport 
condition 

1-piece set 
20.3 in. (width) x 5.2 in. (depth) x 1.8 in. (height) (518 mm (width) x 133 mm 
(depth) x 48 mm (height)) (common to 350 ml, 500 ml and 700 ml) 

12-piece set 
21.1 in. (width) x 11.4 in. (depth) x 14.8 in. (height) (538 mm (width) x 290 mm 
(depth) x 378 mm (height)) (common to 350 ml, 500 ml and 700 ml) 

 
Name White ink pouch 
Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 
- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 

Content 500 ml, 700 ml 
External 
dimensions in 
transport 
condition 

2-piece set 
20.3 in. (width) x 5.2 in. (depth) x 3.4 in. (height) (518 mm (width) x 133 mm 
(depth) x 87 mm (height)) 

12-piece set 
21.1 in. (width) x 11.4 in. (depth) x 11.6 in. (height) (538 mm (width) x 290 mm 
(depth) x295 mm (height)) 

 

11-3-2.  Maintenance solution 

Name Maintenance solution pouch 
Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 
- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 

Content 700 ml 
External 
dimensions in 
transport 
condition 

1-piece set 
20.3 in. (width) x 5.2 in. (depth) x 1.8 in. (height) (518 mm (width) x 133 mm 
(depth) x 48 mm (height)) 

12-piece set 
21.1 in. (width) x 11.4 in. (depth) x 14.8 in. (height) (538 mm (width) x 290 mm 
(depth) x 378 mm (height)) 
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11-3-3.  Cleaning solution 

Name Cleaning solution 
Use expiration date Expiration date on the container (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 

- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 
- Cap the container tightly, and keep it in a cool, dark place with good ventilation.

Content 1.9 kg (4.2 lb) 
External 
dimensions in 
transport 
condition 

6-piece set 
18.9 in. (width) x 13.3 in. (depth) x 13.5 in. (height) (480 mm (width) x 340 mm 
(depth) x 345 mm (height)) 

 

11-3-4.  Pretreatment 

Name Pretreatment 
Use expiration date Expiration date on the outer case (supposing storage at normal temperature) 
Storage temperature 0 to 40°C (32 to 104°F) 

Cautions for storage 

- Store them in a place where they are not exposed to direct sunlight. 
- Keep them out of the reach of children. 
- Store them away from fire, heat and oxidized substance. 
- Cap the container tightly, and keep it in a cool, dark place with good ventilation.

Content 20 kg (44 lb), 5 kg (11 lb) 
External 
dimensions in 
transport 
condition 

1-piece set 
10.4 in. (width) x 14.3 in. (depth) x 15.7 in. (height) (265 mm (width) x 365 mm 
(depth) x 400 mm (height)), (20 kg (44 lb)) 

4-piece set 
17.9 in. (width) x 12.6 in. (depth) x 12.5 in. (height) (456 mm (width) x 320 mm 
(depth) x 318 mm (height)), (5 kg (11 lb)) 
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11-4.  About consumable supplies, optional items and replacement parts 

About consumable supplies, optional items and replacement parts 

 Consumable supplies: Components required for the printing operation 

 Optional items: Available items through purchase order according to customers' usage status 

 Replacement parts: Components for which periodic maintenance needs to be performed for you to optimize the 

printer's operation 

 

Consumable supplies Code No Optional items Code No. 

Black ink pouch 350 ml GCX-4K35-1 Over size platen X 
SB6992 

 500 ml GCX-4K50-1 (16"x21" / 406 x 533mm) 

700 ml GCX-4K70-1 Platen sheet 16X21 SB7242 

Magenta ink pouch 350 ml GCX-4M35-1 Large platen X 
SB6994 

 500 ml GCX-4M50-1 (16"x18" / 406 x 457mm) 

700 ml GCX-4M70-1 Platen sheet 16X18 SB6995 

Cyan ink pouch 350 ml GCX-4C35-1 Adult platen X 
SB6996 

 500 ml GCX-4C50-1 (14"x16" / 356 x 406mm) 

700 ml GCX-4C70-1 Platen sheet 14X16 SB6667 

Yellow ink pouch 350 ml GCX-4Y35-1 Youth platen X 
SB6998 

 500 ml GCX-4Y50-1 (10"x12" / 254 x 305mm) 

700 ml GCX-4Y70-1 Platen sheet 10X12 SB6999 

White ink pouch 500 ml GCX-4W50 Baby platen X 
SB7001 

 700 ml GCX-4W70 (7"x8" / 178 x 203mm) 

Cleaning solution 1.9 kg GCX-4E02 Platen sheet 7X8 SB7002 

Pretreatment 5 kg(11 lb) GCX-4P05 Pretreatment roller SB1290 

 20 kg (44 lb) GCX-4P20 Bottle ASSY (waste ink tank) SB2582 

Maintenance solution pouch 700 ml GCX-4S70 Capping pouch SB5696 

Full maintenance kit 

SC0934 

Replacement parts Code No. 

 <Printer-supplied items> Print head (for color printing) SC0764 

 Clean stick R 16 pcs. Print head (for white) SB8571 

 Clean stick T 16 pcs. Driver SC1681 

 Flushing foam 2 pcs. Filter SB7093 

 Fan filter 4 pcs. Wiper SB7870 

Wiper cleaner 2-piece set SB6673 Grease SB3229 

Flushing foam 2-piece set SC0935 Cartridge (for white ink) SB5495 

Fan filter 2-piece set SB7007 Cartridge C (for colored ink) SB6875 

Clean stick R 50-piece set SB7008 Cleaning cup SB6925 

Clean stick T 50-piece set SC0032 Tweezers 117466100
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X0395 

 

Full maintenance kit 

Wiper cleaner 

Clean stick R 

Fan filterFlushing foam Pretreatment roller 
Bottle ASSY 

(Waste ink tank)

Print head 

(for color printing) 

Tweezers Cleaning cupGrease

WiperFilter

Clean stick T 

Print head

(for white) 

Driver



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
*Please note that the contents of this manual may differ slightly from the actual product purchased as a result of product 

improvements. 
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